
KINETICS FastPath™ 4 

Administrator's Guide 

Publication No. 4200094-00, Revision B 



This manual and any software associated with this product are 
copyrighted with all rights reserved. Under the copyright laws, this 
manual or the software may not be copied, in whole or in part, without 
the written consent of Kinetics, a division of Excelan, Inc., except in the 
normal use of the software to make a backup copy. The same 
proprietary and copyright notices must be affixed to any permitted 
copies as were affixed to the original. This exception does not allow 
copies to be made for others, whether or not sold, but all of the material 
purchased (with backup copies) may be sold, given, or loaned to 
another person. Under the law, copying includes translating into 
another language or format. 

Kinetics makes no representations or warranties with respect to the 
contents hereof and specifically disclaims any implied warranties of 
merchantability or fitness for any particular purpose. Furthermore, 
Kinetics reserves the right to revise this publication and to make 
changes from time to time in the content hereof without obligation of 
Kinetics to notify any person of such revisions or changes. 

Copyright © 1988,1989. Kinetics, a division of Excelan, Inc. 
1340 Treat Blvd., Suite 500 
Walnut Creek, CA 94596 
(415) 975-4547 

Kinetics, FastPath, EtherPort, and TCPort are trademarks of Kinetics, a 
division of Excelan, Inc. Macintosh and LaserWriter are registered 
trademarks and AppleTalk, EtherTalk, and LocalTalk are trademarks of 
Apple Computer, Inc. DEC net and VAX are trademarks of Digital 
Equipment Corporation. Sun is a registered trademark of Sun 
Microsystems, Inc. UNIX is a registered trademark of AT&T. 

Manual revision history: 
Revision A, released 7/21/88: 

Revision B, released 9/20/89: 

Initial release. 
FastPath 4 Installation Guide 
Publication No. 4200094-00, Rev A 

K-STAR changes documented. 
Name changed to 
FastPath 4 Administrator's Guide 
Publication No. 4200094-00, Rev B 



F A 5 T p A T H 4 

Contents 

FCC warning 

About This Guide 
Who should read this guide ..................................................... P-2 

How to use this guide ........................................................ P-2 
If you are new to FastPath gateways ....................... P-2 
If you are experienced with FastPath gateways ..... P-3 

Terminology used in this guide ....................................... P-4 
Additional reading .................................................................. P-5 

1 Installation and Configuration: 
An Overview 
Do you need to configure the FastPath? ................................. 1-2 
A note on network configuration ............................................ 1-3 
Before you begin ........................................................................ 1-4 
Using the FastPath Manager .................................................... 1-6 

Opening a gateway ............................................................ 1-7 
The main configuration dialog box .................................. 1-8 

Reset and Pause ........................................................... 1-8 
Entering configuration data .............................................. 1-9 
Using the K-STAR gateway program ............................ 1-10 

Remote Boot ............................................................... 1-10 
Downloading K-STAR .............................................. 1-11 

Sending the configuration data: Go ............................... 1-11 
Diagnostics and Log windows ....................................... 1-12 
Saving your configuration data ...................................... 1-12 
Quitting the FastPath Manager ...................................... 1-12 

Finishing the installation ........................................................ 1-13 
The Ethernet connection .................................................. 1-13 

Thick Ethernet ............................................................ 1-13 
Thin Ethernet ............................................................. 1-14 

Checking the configuration ............................ , ........................ 1-16 
Changing configuration data ................................................. 1-16 

iii 



2 K-STAR AppleTalk Configuration: 
Phase 2, Transition Bridge, and Phase 1 
AppleTalk configuration features ............................................ 2-2 
AppleTalk Phase 2 addressing ................................................. 2-3 

Network numbers .............................................................. 2-3 
Node addresses .................................................................. 2-3 
Zones ..................... : .............................................................. 2-4 
Required configuration data ............................................. 2-5 

An example Phase 2 internet .................................................... 2-6 
Explicit configuration: gateway 1.. ................................... 2-8 
Seeding on the Ethernet interface: gateway 2 .............. 2-12 
Seeding on the LocalTalk interface: gateway 3 ............ 2-14 

Transition bridge addressing ................................................. 2-17 
Network numbers ............................................................ 2-17 
Zones .................................................................................. 2-17 
Required configuration data ........................................... 2-18 

An example transition bridge internet ................................. 2-19 
Explicit configuration: bridge 1 ...................................... 2-21 
Seeding on the Ethernet interface: bridge 2 .................. 2-25 
Seeding on the LocalTalk interface: bridge 3 ................ 2-27 

AppleTalk Phase 1 addressing ............................................... 2-32 
Required configuration data ........................................... 2-33 

An example Phase 1 internet. ................................................. 2-34 
Explicit configuration: gateway 1.. ................................. 2-36 
Seeding on the Ethernet interface: gateway 2 .............. 2-39 
Seeding on the LocalTalk interface: gateway 3 ............ 2-41 

AppleTalk management issues .............................................. 2-45 
Network ranges and zone lists ....................................... 2-45 
New zone names ............................................................... 2-46 
AppleTalk encapsulated in UDP: IPTalk ....................... 2-46 
AppleTalk zone security .................................................. 2-47 

Zones in the Chooser ................................................ 2-47 
How zone security works ........................................ 2-47 

AppleTalk Phase 1, Option 13: ON ................................ 2-49 
AppleTalk Phase 2, Option 13: ON ................................ 2-50 
AppleTalk Phase 1, Option 14: ON ................................ 2-51 
AppleTalk Phase 2, Option 14: ON ................................ 2-52 
AppleTalk Phase 1, Option 15: ON ................................ 2-53 
AppleTalk Phase 2, Option 15: ON ................................ 2-54 

iv 



3 K-STAR IP Configuration 
If you are new to IP internets ................................................... 3-2 

IP addresses ......................................................................... 3-2 
IP subnets ............................................................................. 3-3 
IP broadcast addresses ....................................................... 3-6 

Required K-STAR IP data ......................................................... 3-7 
Configuring the gateway as an IP host ........................... 3-7 
Client Macintosh IP addresses .......................................... 3-8 

Example K-STAR IP configurations ........................................ 3-9 
The default K-STAR IP configuration ............................ 3-10 
Using a noncontiguous address range: 

"Split addressing" with Option 9 ................................. 3-14 
The gateway managing a separate IP network: 

"Split addressing" with Option 9 ................................. 3-20 
Distributing Macintosh clients: Option 7 ...................... 3-24 

An IPTalk configuration .......................................................... 3-28 
If you are using atalkad .......................................................... 3-33 
K-STAR IP management issues ............................................. 3-37 

Managing Macintosh clients ........................................... 3-37 
Dynamic IP addresses ............................................... 3-37 
Static IP addresses ..................................................... 3-37 
Macintoshes on Ethernet .......................................... 3-38 

How dynamic addressing works ................................... 3-38 
Split addressing management issues ............................. 3-39 
Using the new UDP port numbers ................................. 3-40 

4 K-STAR DECnet Configuration 
K-STAR DECnet addressing ..................................................... 4-2 
Required configuration data ................................................... .4-2 
An example internet .................................................................. 4-3 

Supplying the DECnet data ............................................. .4-4 

5 Troubleshooting 
Calling for help .......................................................................... 5-2 
FastPath installation problems ................................................ 5-2 
FastPath configuration problems ............................................ 5-4 

Can't locate a gateway to open ......................................... 5-4 
Problems downloading or configuring ........................... 5-7 

AppleTalk Phase 2 ....................................................... 5-8 
AppleTalk transition bridge ....................................... 5-9 
AppleTalk Phase 1 ..................................................... 5-10 
K-STAR IP ................................................................... 5-10 
DECnet ....................................................................... .5-11 

Network Connections ............................................................. 5-12 

v 



A FastPath Operations 
The FastPath power-on sequence ........................................... A-2 

The download sequence ................................................... A-4 
Hardware self-testing ....................................................... A-5 
AppleTalk autoconfiguration ........................................... A-7 

FastPath protocols and routing ............................................. A-9 
PROM-resident AppleTalk routing ................................. A-9 
K-STAR AppleTalk Phase 2 routing issues .................. A-13 
K-STAR routing and encapsulation .............................. A-13 
PROM-resident IP routing ............................................. A-17 

B FastPath Manager Reference 
About the FastPath Manager .......................................................... B-2 
Gateway selection window ............................................................. B-3 
Diagnostics window ......................................................................... B-4 
Main configuration dialog box ....................................................... B-6 
K-STAR IP dialog box .................................................................... B-18 
K-STAR IP "More" dialog box ...................................................... B-22 
DECnet dialog box ......................................................................... B-23 
Appletalk Phase 1 dialog box ....................................................... B-24 
IP Subsectioning dialog box .......................................................... B-25 
FastPath Manager menus .............................................................. B-26 

The File menu ................................................................... B-27 
The Gateways menu ........................................................ B-28 
The Configuration menu ................................................. B-29 
The Windows menu ......................................................... B-30 

C FastPath Diagnostic Messages 
Conventions and organization ................................................ C-2 
Alphabetic listing ...................................................................... C-3 
Gateway startup ........................................................................ C-6 

PROM startup .................................................................... C-6 
K-STAR startup .................................................................. C-9 
Ethernet initialization ...................................................... C-10 

AppleTalk ................................................................................. C-11 
Autoconfiguration ........................................................... C-12 
Node-finding .................................................................... C-13 
RTMP ................................................................................. C-16 
ZIP ...................................................................................... C-19 

vi 



IP ................................................................................................ C-22 
Address resolution: ARP ................................................ C-22 
Atalkad .............................................................................. C-23 

OECnet ..................................................................................... C-23 
IP Subsectioning ...................................................................... C-26 

D Kinetics FastPath Management Information 
Base for SNMP 
Related RFCs ............................................................................. 0-2 
Managed objects ....................................................................... 0-3 

Object type syntax ............................................................. 0-5 
Kinetics FastPath MIB definitions .......................................... 0-7 

Objects ................................................................................. 0-7 
Object Groups .................................................................... 0-7 
Format of Oefinitions ........................................................ 0-8 

Object Oefinitions ..................................................................... 0-9 

E PROM-Resident Configuration: AppleTalk 
Phase 1 
PROM-resident AppleTalk Phase 1 ........................................ E-2 

Supplying configuration data .......................................... E-2 
Addressing rules ................................................................ E-3 
ReqUired configuration data ............................................. E-3 
PROM-resident Phase 1 configuration ............................ E-4 

Using seed data ........................................................... E-6 

F Network Hardware Issues 
Network size restrictions .......................................................... F-2 
Ethernet topology ...................................................................... F-4 

Combining networks ......................................................... F-4 
Repeaters and connectors .................................................. F-5 
Adding a node to Ethernet ................................................ F-7 

G Technical Specifications 
Internal components ................................................................. G-2 
Power and environmental requirements ............................... G-3 
External components ................................................................ G-4 

LocalTalk connector ........................................................... G-4 
Ethernet connectors ........................................................... G-5 

vii 



viii 

Glossary 

Index 

Limited Warranty 

List of Figures 
1-1. Connecting to a Macintosh via LocalTalk ...................... I-4 
1-2. The LEOs on the FastPath front panel... ......................... 1-5 
1-3. Selecting thick Ethernet connection .............................. 1-13 
1-4. Connecting to thick Ethernet ......................................... 1-14 
1-5. Selecting thin Ethernet connection ............................... 1-14 
1-6. Connecting to thin Ethernet ........................................... 1-15 

2-1. Example AppleTalk Phase 2 internet .............................. 2-6 
2-2. AppleTalk Phase 2 Zones and Net Numbers ................ 2-7 
2-3. Example Phase l/Phase 2 internet ............................... 2-19 
2-4. Transition bridge configurations ................................... 2-20 
2-5. Example AppleTalk Phase 1 internet ............................ 2-34 
2-6. AppleTalk Phase 1 Zones and Net Numbers .............. 2-35 
2-7. Phase 1 "Stay in Zone" security .................................... 2-49 
2-8. Phase 2 "Stay in Zone" security .................................... 2-50 
2-9. Phase 1 "LaserWriter" security ...................................... 2-51 
2-10. Phase 2 "LaserWriter" security ..................................... 2-52 
2-11. Phase 1 ''Tilde'' security ................................................. 2-53 
2-12. Phase 2 "TIlde" security ................................................. 2-54 

3-1. IP network numbers as assigned by NIC ...................... 3-3 
3-2. IP Subnetting: Class A ...................................................... 3-4 
3-3. IP Subnetting: Class B ........... ; ........................................... 3-4 
3-4. IP Subnetting: Class C ...................................................... 3-5 
3-5. IP broadcast address with no subnet .............................. 3-6 
3-6. IP broadcast address with subnetting ............................ 3-6 
3-7. K-STAR IP configuration .................................................. 3-7 
3-8. A default K-STAR IP configuration .............................. 3-11 
3-9. Using a noncontiguous range of client addresses ...... 3-15 
3-10. A separate IP network managed in the gateway ....... 3-20 
3-11. Distributed Macintosh clients ....................................... 3-25 
3-12. UOP encapsulation: IPTalk ........................................... 3-30 
3-13. Using atalkad .................................................................. 3-34 



4-1. A DECnet network ............................................................ 4-3 
4-2. DECnet configuration data .............................................. 4-4 

5-1. Hardware installation check ............................................ 5-3 
5-2. Can't find and open the gateway .................................... 5-5 
5-3. Problems downloading or sending data ........................ 5-7 

A-I. FastPath State Diagram .................................................. A-3 
A-2. The FastPath LEDs .......................................................... A-6 
A-3. PROM-resident AppleTalk Phase 1 routing .............. A-I0 
A-4. EtherTalk packets: AppleTalk on Ethernet ................ A-lO 
A-5. K-STAR routing ............................................................. A-14 
A-6. Examples of K-STAR encapsulation ........................... A-15 
A-7. PROM-resident IP Routing .......................................... A-17 

D-1. Global object identifier tree ............................................ D-4 

E-1. A Phase 1 configuration ................................................... E-4 
E-2. Seeding on the Ethernet interface .................................. E-6 

F-1. Grounded and terminated Ethernet cable ..................... F-4 
F-2. Using a connector to combine Ethernet cables ............. F-5 
F-3. Using a repeater to combine Ethernet cables ................ F-6 

List of Tables 
A-I. AppleTalk Protocols ...................................................... A-ll 
A-2. Internet Protocols .......................................................... A-16 

C-l. Alphabetic Listing of Diagnostic Messages ................ C-3 

F-1. AppleTalk Network Size Restrictions ........................... F-2 
F-2. Ethernet Network Size Restrictions ............................... F-2 
F-3. Combined Ethernet Network Size Restrictions ............ F-3 

ix 



x 

Federal Communications Commission Warning 
The EtherPort cards generate, use, and can radiate radio-frequency 
energy and, if not installed and used in accordance with the instruction 
guide, may cause interference to radio communications. The EtherPort 
cards have been tested and found to comply with the limits prescribed 
for a Class A computing device, pursuant to Subpart J of Part 15 of the 
Federal Communications Commission (FCC) Rules, which are designed 
to provide reasonable protection against such interference when 
operated in a commercial environment. Operation of this equipment in 
a residential area is likely to cause interference, in which case the user, 
at his own expense, will be required to take whatever measures may be 
required to correct the interference. 

The FCC rules are designed to provide reasonable protection against 
such interference in a commercial installation. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause interference to radio or television reception, 
which can be determined by turning the equipment off and on, try to 
correct the interference by one or more of the following measures: 

• Reorient the receiving antenna. 

• Relocate the equipment with respect to the receiver. 

• Move the equipment away from the receiver. 

• Plug the equipment into a different outlet, so the eqUipment and 
the receiver are on different branch circuits. 

• If necessary, consult your Kinetics dealer or an experienced radio
television technician for additional suggestions. You might find the 
following FCC booklet helpful: 

How to Identify and Resolve Radio-TV Interference Problems, U.S. 
Government Printing Office, Washington, DC 20402, Stock No. 004-
000-0034504. 



p R E F A c E 

About This Guide 

TillS GUIDE CONTAINS INSTRUCTIONS FOR INSTALLING AND 

configuring the FastPath ™ 4 gateway. 

The FastPath hardware connects a LocalTalk® or compatible 

network to a thick or thin Ethernet or compatible network. 

The FastPath gateway program is called K-STARTM for 

"Kinetics-Style Addressing and Routing." K-STAR contains 

software modules that implement AppleTalk Phase 1 and Phase 

2 protocols, transition bridge software, TCP lIP protocols 

(including UDP, ICMP, and RIP), DECnet™, and SNMP. You 

provide configuration data to the gateway and download the 
K-STAR gateway program using the FastPath ManagerTM 

Macintosh application. 

The FastPath also contains a PROM-resident implementation of 

AppleTalk® Phase 1, which can be used for "install and go" 

autoconfiguration. The gateway's PROM-resident 

implementation of IP is provided for backward compatibility 

only and is not described in this guide. 
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If you are new to 
FastPath gateways 

Who should read this guide 
This guide is written for the network administrator who is 
responsible for setting up and maintaining the internet. The 
network administrator must be familiar with using the 
Macintosh and should have some technical knowledge of 
network addressing and operation. 

In general, the network administrator is involved in planning 
and implementing the physical internet (for example, laying the 
network cables, adding and removing nodes on individual 
networks, placing gateways, bridges, and routers), as well as 
installing and configuring network software and services. 

How to use this guide 
This guide has sample configurations organized in chapters for 
the different protocols supported on the FastPath gateway, and 
comprehensive reference material presented in Appendixes. 
General network management issues relating to a particular 
protocol are presented at the back of each chapter, and there is a 
separate chapter on troubleshooting. 

1. Read Appendix A for background information on how the 
FastPath works. This Appendix describes the basic 
architecture and operations of the FastPath gateway and 
explains the configuration and protocol alternatives. 

2. Read Chapter 1 to find out how to install the gateway and 
the recommended procedure for configuring it. You should 
read this Chapter step-by-step to get the complete sequence 
for installing and configuring the gateway. If you follow 
this procedure, you will not disrupt the rest of the network 
if you make a mistake. 

3. Determine which protocols the gateway needs to route 
between its two interfaces. This depends on the network 
software running on devices on the two networks connected 
to the gateway. Note that when you use the K-STAR 
gateway program, the gateway can support several types of 
protocols with the appropriate configuration data for each. 
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If you are 
experienced with 
FastPath gateways 

4. Read the configuration chapter for each type of protocol the 
gateway will support. The sections entitled "Required 
Configuration Data" describe the addressing information 
you need to know before configuring the gateway with the 
appropriate data for your site. 

• Chapter 2 describes how to configure the gateway for 
AppleTalk Phase 2 routing, a combination of AppleTalk 
Phase 2 and Phase 1, or AppleTalk Phase 1 using the 
protocols contained in the K-STAR program. 

• Chapter 3 describes how to configure the gateway for 
TCP lIP IUDP routing using the Kinetics Internet 
Protocol (KIP)-derived protocols contained in K-STAR. 

• Chapter 4 describes how to configure the gateway for 
DECnet routing. 

• If the gateway needs to support only AppleTalk Phase 1 
and you do not need to use the zone security features 
provided in K-STAR, you can use the PROM-resident 
AppleTalk protocols. See Appendix E. 

See Appendix C for an explanation of the diagnostic messages 
you might see when the configuration is complete. 

5. If you run into any trouble when installing the configured 
gateway on the internet, check the troubleshooting 
information in Chapter 5. 

1. Read Appendix A and Appendix B to see the new features 
and options in the gateway's routing capabilities and in the 
FastPath Manager configuration software. 

2. Read "Changing Configuration Data" in Chapter 1 if you 
are using the new version of the FastPath Manager to open 
and modify existing configuration files. 
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3. Check the "Required Configuration Data" sections and the 
overviews preceding examples for the configuration types 
you require. Overviews of the configuration procedure are 
presented as bulleted lists in bold type in Chapters 2 
through 4. 

4. You will notice new diagnostic messages in the Diagnostics 
window of the FastPath Manager. These are documented in 
AppendixC. 

5. If you are managing an internet that has already been 
configured using the gateway's PROM-resident IP 
protocols, please refer to your existing documentation on 
"IP Subnetting" in previous versions of the FastPath 
documentation. 

The gateway's PROM-resident IP implementation was 
previously referred to as the "IP Subnetting" configuration type. 
In this version of the FastPath Manager, it is called "IP 
Subsectioning" to avoid confusion with standard IP subnetting. 
Note, however, that the PROM-resident code itself has not 
changed. 

Gateways configured with PROM-resident IP Subsectioning can 
operate on internets that also support K-STAR IP gateways, and 
K-STAR IP is the recommended method of IP configuration. If 
you are using the PROM-resident IP protocols, please refer to 
your existing documentation. 

6. If the internet supports SNMP and network management 
utilities, see Appendix D for the Kinetics FastPath 
Management Information Base (MIB). 

1111" In this release, it is recommended that you supply all 
configuration information before downloading K-STAR. 

Terminology used in this guide 
In this guide, the term Ethernet refers to both thick and thin 
Ethernet cable, as well as any IEEE 802.3 standard network. The 
term LocalTalk refers to any system of cables and connectors 
that supports AppleTalk protocols and runs at 230.4 kilobits per 
second; for example, LocalTalk or PhoneNET. 
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This guide refers to an internet as a collection of LocalTalk and 
Ethernet networks connected by gateways. The term AppleTalk 
internet means all devices on the internet that use AppleTalk 
protocols; the devices may be connected to LocalTalk cable or 
Ethernet. Similarly, the IP internet refers to all systems that use 
TCP lIP IUDP, regardless of their physical location. For 
example, a Macintosh running TCP lIP software may be 
physically connected to Ethernet or to a LocalTalk network with 
a gateway to Ethernet. In either case, it is part of the IP internet. 

In this guide, the FastPath is typically referred to as a gateway. 
However, it can also be referred to as a bridge or router, 
depending on the context in which the FastPath is operating. A 
gateway routes information between two or more networks, 
which can use different types of cable and support different 
protocol software. Gateway functionality includes 
encapsulation between different protocols (see Appendix A for 
details). If the networks support the same protocols (for 
example, AppleTalk protocols only), a gateway can be called a 
"bridge." Bridge functionality simply routes the same type of 
protocols between two networks (for example, routing 
AppleTalk packets across Ethernet to another AppleTalk 
network). The FastPath is always acting as a router, in that it 
routes packets between two networks. 

Additional reading 
The following publications provide overviews of networking 
solutions and are useful as background material if your 
experience with networking is not extensive. 

• LocalTalk Cable System Owner's Guide, supplied with 
LocalTalk connector kits from Apple Computer, is the place 
to start for information on installing LocalTalk networks. 

• Networks and Communications Buyer's Guide, available from 
Digital Equipment Corporation. This guide provides 
information on installing cable and cable connections for 
DEC networks. 
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• Newton, Harry. The Teleconnect Dictionary. Chelsea, MI: 
Harry Newton and The Telecom Library Research Group, 
1987, provides useful networking definitions. 

• Network Primer (Kinetics), describes the language and 
components of Macintosh network operation. It discusses 
hardware, software, standards, and protocols. 

The following publications provide information about hardware 
and software products available for Ethernet and LocalTalk 
networks. 

• Counterpart, the Kinetics third-party vendor catalog, lists 
sources for equipment and software that can be used with 
Kinetics products. 

• Excelan Product Catalog, Excelan, Inc., lists all current Excelan 
and Kinetics products. 

The following publications provide detailed information about 
AppleTalk protocols, standards, and uses. 

• Inside AppleTalk, Addison-Wesley Publishing Company, Inc. 
This book is now available in book stores, from Apple 
Computer, and from the publisher. This provides the 
complete AppleTalk network specification. 

• Inside Macintosh, Addison-Wesley Publishing Company, Inc. 
All five volumes are available in book stores, from Apple 
Computer, and from the publisher. The AppleTalk Manager 
chapter provides detailed information about programming 
the Macintosh to work in AppleTalk networks. It also 
provides background information about the AppleTalk 
archi tecture. 

The following publications contain detailed information about 
Ethernet network standards and uses: 

• The Ethernet: A Local Area Network: Data Link Layer and 
Physical Layer Specifications. DEC, Intel, and Xerox 
Corporations, Version 2.0, November 1982. 
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• Carrier Sense Multiple Access with Collision Detection 
(CSMAICD) Access Method and Physical Layer Specifications 
(ANSI/IEEE Standard 802.3-1985), (ISO/IDS 8802/3), IEEE 
1984. Available from IEEE, 345 East 47th Street, New York, 
NY 10017. This provides the Ethernet standard. 

The KIP documentation required for configuring the atalkatab 
database file is available from Stanford University. You can 
obtain it by using FI'P with the login name "anonymous" on 
"sumex-aim.stanford.edu" in the <info-mac> directory, or by 
writing to Stanford University, Information Resources, 
Networking, Pine Hall, Stanford, CA 94305. 

The next set of references are RFCs (Requests for Comment) that 
define standard network practices. These RFCs are available 
from the DDN Network Information Center (NIC), SRI 
International, 333 Ravenswood Avenue, Room EJ291, Menlo 
Park, CA 94025 for $5.00 each ($10.00 for RFCs longer than 100 
pages). The NIC telephone number is (415) 859-3695. These 
RFCs are also available via e-mail or ftp if you have access to the 
DDN networks. The UNIX e-mail address is operators@sri
nic.arpa. 

• Mogul, J., and J. Postel, Internet Standard Subnetting 
Procedure, RFC 950, August 1985. This RFC describes a 
method for implementing subnets and is the basis for the 
4.3BSD subnetting scheme of the University of California at 
Berkeley. 

• Reynolds, J., and J. Postel, Internet Numbers, RFC 997, March 
1987. This RFC, or its successor, is the official status report 
on IP network numbers. 

• Braden, R., and J. Postel, Requirements for Internet Gateways, 
RFC 1009, June 1987. This lengthy RFC defines the formal 
requirements for gateways used on IP networks. 

• Rose, M., and McOoghrie, K., Structure and Identification of 
Management Information for TCP/IP-based Internets, RFC 1065, 
August 1988. This RFC provides the common definitions 
for the structure and identification of management 
information for TCP /IP-based internets. 
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• McCloghrie,K., and Rose, M., Management Information Base 
for Network Management of TCP/IP-based Internets, RFC 1066, 
August 1988. This RFC provides the initial version of the 
Management Information Base (MIB) for use with network 
management protocols in TCP lIP-based intemets in the 
short-term. 

• Case, J., Fedor, M., Schoffstall, M., and Davin, J., A Simple 
Network Management Protocol, RFC 1067, August 1988. This 
RFC defines a simple protocol by which management 
information for a network element may be inspected or 
altered by logically remote users. 
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c H A p T E R 1 

Installation and Configuration: 
An Overview 

THIS CHAPTER PROVIDES AN OVERVIEW OF HOW TO INSTALL AND 

configure the gateway. You should read this chapter step-by
step as a guide to FastPath installation and as an introduction to 
the recommended configuration procedure using the FastPath 
Manager program. 

This chapter does not explain specific configuration data that 

will be needed for the gateway to route correctly at your site. 

See Chapters 2 through 4 for information on supplying the 
network addresses and other information that the gateway 
requires to route one type or several types of network traffic 

using the K-STAR gateway program. 

See Appendix E for information on configuring the gateway's 
PROM-resident AppleTalk protocols. 

For information on configuring the PROM-resident IP protocols, 

see your existing documentation: PROM-resident IP is provided 

for backward compatibility only and is not described in this 

guide. See Chapter 3, "K-STAR IP Configuration," for the 

recommended way to configure the gateway for IP routing. 
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NO if: 

Do you need to configure the FastPath? 
The FastPath will function as an AppleTalk Phase 1 bridge, the 
network configuration is simple (for example, a single Ethernet 
backbone with bridges to LocalTalk networks), and you do not 
need to assign specific zone names or network numbers or 
implement AppleTalk zone security. In this case, you can use 
the gateway's PROM-resident AppleTalk Phase 1 protocols, and 
you do not need to supply any configuration data to the 
gateway. You can allow it to autoconfigure as follows: 

• Unpack the gateway and place it in its permanent position 
between a LocalTalk network and E themet. 

• Connect the gateway to LocalTalk (see "Before You Begin"). 
• Connect the gateway to Ethernet (see "The Ethernet 

Connection"). 
• Plug in the gateway and power it on (see "Before You Begin"). 

The gateway identifies itself to the AppleTalk Phase 1 network 
on LocalTalk and on Ethernet, acquires its own addresses, and 
begins operation. See Appendix E for more information. 

YES if: The FastPath will handle any other type of protocols or 
configuration methods: AppleTalk Phase 2, transition bridge 
software (where the internet supports both AppleTalk Phase 1 
and Phase 2), AppleTalk Phase 1 (if Phase 1 will be used 
together with any other type of configuration method, if you 
want to specify a particular zone name for one or both sides of 
the gateway, or if zone security is required), TCP lIP, IPTalk 
(UDP encapsulation), DECnet, andlor SNMP with network 
management utilities, or if you are using the atalkatab file for 
centralized configuration. In all of these cases, you need to 
configure the gateway using the FastPath Manager software. 
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A note on network configuration 

It is important to note that many protocol suites can co-exist on 
the same physical internetwork, and that a single gateway 
running the K-STAR gateway program can be configured to 
handle several different types of network traffic. When you 
configure the gateway, you are supplying it with addresses and 
other information it requires to route one type or several types 
of network traffic through its two hardware interfaces. 

Configuration data determines the type(s) of network traffic 
that will be handled by a given gateway. In general, a gateway 
should be configured to handle routing for the network 
software running on devices on both sides of the gateway. For 
example, AppleTalk devices (such as Macintoshes, AppleShare 
servers, or LaserWriters) on one side of the gateway can 
communicate with similar devices on the other side of the 
gateway after you have configured the gateway (or have 
allowed it to autoconfigure) on the AppleTalk network. 

If Macintoshes on the LocalTalk side of the gateway are running 
TCP lIP software, they can communicate with TCP lIP devices 
on Ethernet (and vice versa) only after you have configured the 
gateway on the IP network, and so on for all types of routing 
supported by the gateway. See Appendix A for a complete list 
of the protocols supported in the gateway. 

1111" It is very important that you check your data before you 
configure the gateway and bring it up on an internet. Duplicate 
addresses (such as AppleTalk network numbers, IP addresses, 
or DECnet node numbers within an area) can cause confusion 
on the entire internet. In larger organizations, where there is 
likely to be an internet administrator, be sure to obtain valid 
addresses from her. 
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Before you begin 
It is recommended that you configure the gateway on a small, 
isolated network where you can test a configuration without 
disrupting service on either network. This is recommended, but 
not required. 

To set up an isolated network with only two nodes, you can 
connect the gateway to a Macintosh using LocalTalk as follows: 

• Push the network selection switch on the gateway back 
panel toward the AU! interface (thick Ethernet). When the 
switch is in this position, you can operate the gateway for 
testing without bothering about terminating the Ethernet 
side. You will see several"Ethernet Transmission Error" 
messages in the Diagnostics window when you test the 
configuration, but you can simply ignore these messages. 

• Connect the gateway to a Macintosh via the LocalTalk 
interface (usually the printer port). 

Insert the 9-pin plug into the 
LocalTaIk connector on the 
FastPath back panel, and tighten 
its screws with finger pressure. 

Plug the LocaITaIk cable connectors 
into the connection box and into 
another connection box connected to 
the Macintosh. It doesn't matter 
which of the connection box's two 
sockets you use, but make sure the 
plugs are fully inserted. 

Figure 1-1. Connecting to a Macintosh via LocalTalk 
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If you are using LocalTalk cable, you should secure the cables 
with a cable tie to prevent the plugs from working loose and 
disrupting the network. If you are using another type of 
equivalent cable (for example, PhoneNET), make sure the 
terminating resistors are in place at both ends of the two-node 
network. See the vendor-supplied documentation for the cable 
you are using. 

• Plug in the gateway. Check that the electrical outlet is 
grounded and that it is compatible with the voltage rating 
on the gateway back panel, then plug the female end of the 
power cord into the AC power socket on the gateway's back 
panel and the other end of the power cord into a grounded, 
three-prong electrical outlet. 

• Power on the gateway by pressing the "1" on the ON/OFF 
switch located on the back panel. 

The three LEOs on the gateway front panel light up briefly 
while the gateway tests its hardware components. See Appendix 
A for a full description of the hardware self-tests. 

The LED below this symbol is the 
power light. It is normal for this to 
stay on continuously while the 
FastPath is in use. 

KINETICS 
o 'V l:;. 
o 0 0 

The LEOs below these 
symbols are the network 
traffic lights. These light up 
during hardware self
testing. and then blink on 
and off according to 
network traffic. 

Figure 1-2. The LEDs on the FastPath front panel 
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Using the FastPath Manager 

The FastPath Manager is a Macintosh application that 
communicates with the gateway. It is the mechanism for 
downloading code (K-STAR or customized code developed at 
your site) and sending configuration information to the gateway. 

The FastPath Manager is always launched on a Macintosh on 
the LocalTalk or Ethernet network connected to the gateway. 
When the Macintosh is connected to LocalTalk, the application 
continuously receives diagnostics from all FastPath gateways on 
the LocalTalk net and displays them in a Diagnostics window. 
When the Macintosh is connected to Ethernet, the Diagnostics 
window does not display messages from the gateways; 
however, you can still see these messages by clicking the Log ... 
button in the FastPath Manager. 

To use the FastPath Manager, 

• Check that the Macintosh has AppleTalk enabled in the 
Chooser. (If AppleTalk is not enabled, the Macintosh can 
not see the gateway.) 

• Double-click on the FastPath Manager icon to launch the 
application. You can launch it from the configuration 
diskette, or copy the FastPath Manager to the Macintosh 
hard disk and launch from there. 

The rest of this section introduces the FastPath Manager and 
describes the recommended configuration procedure: 

• Opening the gateway 
• The main configuration dialog box 
• Reset and Pause 
• Entering configuration data 
• Using the K-STAR gateway program 

Remote Boot 
Downloading K-STAR 

• Sending the configuration data: Go 
• Diagnostics and Log windows 
• Saving your configuration data 
• Quitting the FastPath Manager 
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Opening a gateway 
When you launch the FastPath Manager, the first dialog box 
asks you to select a gateway to configure. 

Select a FastPath to Conngure: 
INOdl' 220) 00 

[Cancel) 

When you have connected the gateway to a single Macintosh on 
LocalTalk, you should see only one gateway listed in this 
window. If you do not see a gateway listed here, select the Find 
All ... command from the Gateways menu. If the gateway still 
does not appear, see Chapter 5, "Troubleshooting." 

In the initial configuration process, before you have assigned a 
name to the gateway, a default name appears in this list. On the 
LocalTalk interface, this is likely to be "[Node 220]" which is a 
temporary name built by the FastPath Manager based on the 
AppleTalk node ID of the LocalTalk interface. You can "open" the 
gateway by double-clicking on its name or by clicking once and 
selecting Open. 

You can select Find All... from the Gateways menu to open a 
gateway at any time while the FastPath Manager is running. 
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When you click Reset, all 
gateway RAM is cleared. 
To prevent it from 
autoconfiguring. click 
Pause within 25 seconds 
of the initial Reset. 

Reset and Pause 

The main configuration dialog box 
When you open the gateway, the Diagnostics window comes up, 
immediately followed by the main configuration dialog box. 
The main configuration dialog box looks something like this: 

I I~"tl .. 2/01 iliet"'I" ~-C •• ft'Ultt.~ 
FestPlth"Seriel Number: PIIOMVersion: 4.1 II D" 
Curr.nIlv Do\tnlote1tc1 FIl.: I I 
Lest Connguretlon DItt: I 
Current Conn,untton fill: J ! " 

.• _~~htrnetAcldr~~:. ___ ._.~~.~~.~~.~_. __ •.•••. _. LJ. Edit •• ) .• _ r- a..c.lT.n ... ertle. -.---... --.--... -.--.-...... -~ ~-Svlll:""·--··l 

Ij;:::~:::;:;';:r _~_ ..... _ .. ___ ~ ~ 
r [therT.1t Ph_ Z ---.-•. ---.--.--------.-, [ Log... ) 

I Ringe Stert ~ Re,. End E=:J I [Option •••• J 
ET.lk Z.O Net Number 0 [] 
ETII k 2.0 Node Number 0 [ Zone Lilt ... ) 

'---...•. -----.. ,.......:~--r Hal, -----.,----,-=---

Restart is the equivalent of 
turning the gateway off and on 
again. See "Changing 
Configuration Data" at the end 
of this chapter for infonnation 
on using Restart. 

After you have entered 
configuration data and 
downloaded K·STAR, 
clicking Go sends the data 
to the gateway and tells it to 
start execution. 

When you click Pause within 
25 seconds after a Reset or 
Restart, the gateway is 
"paused" and will not 
attempt to begin operations. 

Because the gateway can autoconfigure for AppleTalk routing, 
and because it remembers its configuration even after it has 
been turned off, you need to clear its RAM before you send it 
new configuration data: 

• Click the Reset button before entering any configuration 
data. This clears the gateway's RAM and puts it in the reset 
state necessary for configuration. The gateway will wait for 
2S seconds before attempting to autoconfigure. 

When you reset the gateway, the main configuration dialog box 
disappears. Choose Find All ... from the Gateways menu, then 
select the same gateway and open it again. When the main 
configuration dialog box comes up on your screen again, 
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• Click the Pause button within 25 seconds of the initial Reset. 
This prevents the gateway from autoconfiguring before you 
supply the new configuration data. 

Entering configuration data 
You can now take your time and enter the configuration data 
required for your site. See Chapters 2 through 4 for details on 
supplying the K-STAR configuration data required for your network 
configuration, or Appendix E for PROM-resident configurations. 
Note that the configuration data you enter is not sent to the 
gateway until you click Co. 

If you are configuring the gateway for the first time, it's a good 
idea to name it and enter its serial number in the FastPath 
Manager. The name you assign is used when the gateway 
responds to DECnet or SNMP NBP lookups. The serial number 
is not used by the gateway, but it makes network administration 
easier. 

• Select Name ... from the Gateways menu and type a name 
that is no longer than 20 characters; for example: gateway 1 

Enter New Getewey Neme: 

Igeteweg 1 

I OK I [ Cente' ) 

• Select Serial Number ... from the Gateway menu and type 
the box's serial number (from the label on the gateway's 
back panel); for example, 100766 

Enter New Sertel Number: 

IIDD766 

I OK I [ Centel ) 
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Using the K-STAR gateway program 
K-STAR is the FastPath gateway program that contains the 
following configuration types: 

t.-Conffguntlo"---:1 
i ATaik Phil .. 2 ~I ! K-STAR IP 
! DECnet i 
! ATaik Phil .. 1 ~I i 
I [ Edit ] I 1 ............... __ ....... ... 

The menu items that have been checked 
are all supported in K-STAR These can be 
used in any combination together. 

When you select a configuration method, its name 
appears in the Configuration area of the main 
dialog box. Double-clicking on this listing opens 
the appropriate dialog box to supply 
configuration data. (Note that ATalk Phase 1 alone is also 

supported in PROM.) 

Remote Boot 

When you configure any of the K-STAR modules (or any 
combination of them), you need to download the K-STAR 
program to the gateway. 

When you download K-STAR, it is loaded into protected 
memory in the gateway. You should not have to download 
K-STAR again, even if there is a power failure, unless one of the 
following occurs: 

• The gateway's memory becomes corrupted for some reason 
(see "Remote Boot"). 

• You click Reset in the FastPath Manager (see "Changing 
Configuration Data"). 

• You change the zones in an AppleTalk Phase 2 configuration 
(see "Changing Configuration Data"). 

To protect against the unlikely event that the gateway's memory 
becomes corrupted, it is recommended that you tum on the 
Remote Boot software switch before downloading K-STAR. 
Turning on the Remote Boot switch prevents the gateway from 
executing the PROM-resident protocols, should K-STAR become 
corrupted. (See Appendix A for more information on how this 
mechanism works.) 
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• Before downloading K-STAR, select the Remote Boot switch 
in the Switches area of the main configuration dialog box. 
This is recommended in the K-STAR configuration 
examples in this guide. 

r;~~~~~~;;;'-+- The gateway will autoconfigure if this 
i ! switch is on and you have not 

Oick in the selection box next to the Remote ----ij 181 Remote Boot! configured any zone names or 
Boot switch. This prevents the gateway from • ___________________ ... _ . .! network numbers. 
operating without a valid gateway program if 
its memory becomes corrupted. 

Downloading 
K-STAR 

After selecting Reset and Pause (as described earlier), supplying 
your configuration data, and turning on Remote Boot, you 
download K-STAR to the gateway as follows: 

• Select Download a File from the File menu, and open the 
K-STAR file. A window like this displays while K-STAR is 
downloading to the gateway: 

Downloading the flle "K-STRR version B.D' 
Destination: Node 220 -- gateway 1 
Size of file Un bytes): 285465 

I '.' ... Ift'~.IiJIJ''''' .... '.liif I 
011 Z5II 501 79 lao. • 

Prell. ': to Cancel. 

Sending the configuration data: Go 
After the K-STAR gateway program has been downloaded, you 
can send the configuration data to the gateway: 

• Click the Go button. 

This sends the configuration information that is currently in the 
FastPath manager and tells the gateway to start executing the 
K-STAR code that you downloaded (or to start executing the 
gateway code in PROM if there is no download code). 
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Diagnostics and Log windows 
After you click Go, the Diagnostics window displays in the 
foreground. If you are on LocalTalk (as recommended), you will 
see messages describing the gateway's activity. If there is more 
than one gateway on the LocalTalk network, the messages you 
see will be from all gateways on LocalTalk. These messages are 
documented in in Appendix C of this guide. 

If you are running the FastPath Manager on a Macintosh 
connected to Ethernet, or if there is more than one gateway on 
the LocalTalk network, click the Log ... button to see the 
diagnostic messages from the open gateway. The Log ... button 
reads a buffer directly from the open gateway and displays the 
most recent gateway messages. 

Saving your configuration data 
After checking the messages in the Diagnostics window, it's a 
good idea to save your working configuration in a file. This is 
recommended, but not required. 

• Save the configuration in a file (using the File menu) for 
future use. 

Quitting the FastPath Manager 

• You can now close the FastPath Manager by selecting Quit 
from the File menu. 
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Thick Ethernet 

Finishing the installation 

When you have configured the gateway, 

• Turn off the gateway and unplug it. 
• Move the gateway to its permanent location and plug it in. 
• Connect the gateway to LocalTalk and Ethernet. 
• Power on the gateway. 

The procedures for connecting the gateway to LocalTalk, and for 
powering on the gateway after it is fully installed, are described 
in "Before You Begin" in this chapter. 

The Ethernet connection 
Before connecting the gateway to the Ethernet, the network 
cables should be fully installed and terminated, and the 
appropriate connection devices should be in place. If you need 
to install connection devices on Ethernet, see Appendix For 
contact the internet administrator. 

If you are connecting to a thick Ethernet cable or any type of 
network cable that uses the Medium Attachment Unit AUI 
interface, you need a transceiver and transceiver cable. 

To connect the gateway to thick Ethernet, 

• Make sure that the switch at the top of the gateway's back 
panel is positioned toward the transceiver connector. 

Elhemall802.3 
aMQ-----------&4--

® 
Push right for ----------' 
thick Ethernet 

Figure 1-3. Selecting thick Ethernet connection 
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• Plug the transceiver into the AUI interface on the gateway 
back panel and slide the lock mechanism to the right to 
secure the connection. 

Push left to open Push right to close 

Thin Ethernet 

Figure 1-4. Connecting to thick Ethernet 

If you are connecting to thin Ethernet cable or equivalent coaxial 
cable, use a T -connector such as the one provided with the 
gateway. If the connector is not already installed on thin 
Ethernet, see Appendix F or contact the internet administrator. 

• Push the switch at the top of the gateway's back panel 
toward the 10BASE2 BNC connector. 

Elhernetll102.3 
1 .. -----------~L-

@ 

Push left for -----------' 
thin Ethernet 

Figure 1-5. Selecting thin Ethernet connection 

• Pick up the T -connector on your thin Ethernet cable and 
plug it into the BNC connector on the gateway back panel. 
When it is firmly plugged in to the gateway BNC connector, 
twist the sleeve on the T-connector clockwise to lock the 
connection in place. 
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BNC connectorl'--_________ ~ 

~-Thin Ethernet cable ------.." ~ 

~~i~ "i-~~~==II~i == 
T~nn~ror-------------~~ 

Figure 1-6. Connecting to thin Ethernet 

1111" Do not attach thin Ethernet cable directly to the gateway 
without using a T-connector. In a direct connection, the 
Ethernet cable cannot be terminated and the network will not 
function properly. 

Make sure that both sides of the T -connector are connected to 
thin Ethernet cable, or, if the gateway is the last device on the 
thin Ethernet cable, that one side of the T-connector is connected 
to the cable and the other side is connected to a network 
terminator. It's important that neither side of the T-connector is 
left open. It is also important to protect the T-connector (using 
the protector provided with the gateway) from contacting other 
exposed metal, including parts of the FastPath. Otherwise, the 
connection may be affected by ground currents that upset 
network traffic. 

• When you have finished connecting the gateway to 
LocalTalk and Ethernet (either standard or thin Ethernet), 
plug it in and power it on by pressing the 1/1" on the 
ON/OFF switch located on the back panel. 
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Checking the configuration 

After installing the gateway on the working internet, launch the 
FastPath Manager on a Macintosh on either one of the networks. 
In the gateway selection window, you will see a list of all 
gateways on that network. 

• Select and open the gateway you have just configured and 
installed. 

When the main configuration dialog box comes up on your 
screen, it should contain the same configuration data you 
entered. This data is stored in the gateway, and is displayed on 
your screen when communication is established between the 
gateway and the FastPath Manager. 

• Check the data on your screen against the data you entered. 
If all the data is present and correct, then the gateway is 
using the proper configuration data. 

• Click the Log ... button in the main configuration dialog box 
to see the startup and diagnostic messages produced by the 
gateway. These messages are documented in Appendix C of 
this guide. 

Beyond this simple check, you can use the Macintosh Chooser to 
see that zones and their devices are accessible through the 
gateway, access an IP host on Ethernet from an IP host on 
LocalTalk, and so forth, to ensure that everything is working. 

Changing configuration data 
When you have configured the gateway, downloaded 
K-STAR, and clicked the Go button, the gateway begins 
executing code and will not accept any further data. To send 
new configuration data, even a minor change, you first need to 
return the gateway to its initial state where it is not executing 
code. 
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To avoid resetting the gateway, which clears the K-STAR 
program from its protected memory locations, you can use the 
Restart button as described here. 

1111" Note, however, that when you are changing zone names in an 
AppleTalk Phase 2 configuration (including Phase 2 in the 
transition bridge software), you must download K-STAR again 
after entering the new zone configuration data. 

• Click the Restart button before entering any configuration 
data. This is the equivalent of turning the gateway off and 
on again. Unless you click Pause within 25 seconds, the 
gateway will begin executing K-STAR again with the 
current configuration data. 

When you restart the gateway, the main configuration dialog 
box disappears. Choose Find All... from the Gateways menu, 
then select the same gateway and open it again. When the main 
configuration dialog box comes up on your screen again, 

• Click the Pause button within 25 seconds of clicking Restart. 
This prevents the gateway from restarting itself before you 
supply the new configuration data. 

• Enter the required configuration changes. 

• If you changed the zone list for the EtherTalk Phase 2 
interface, download K-STAR again before you click Go. 
Otherwise, simply click Go. 

1111" If you are changing a configuration file that was created using a 
previous release of the Fastpath Manager and that contains data 
for any configuration type(s) which are not configured in the 
main dialog box, you must follow these steps; otherwise, the 
gateway will not recognize the data in the file. 

• Open the existing configuration file. 

• In the Configuration menu, select all configuration types 
that have associated data, even those that will not be 
affected by your changes. 
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• Enter your configuration changes, download the current 
version of K-STAR (if you have not done so already) and 
send the data to the gateway by clicking Go. 

• Save the configuration file again. 

If you are simply using an existing configuration file that was 
created with a previous release of the FastPath Manager 
(without changing any of the data) you must still follow these 
steps. Open the existing file, select all configuration types used 
in the file, send the data to the gateway, and save the 
configuration file again. 
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C H A p T E R 2 

K-STAR AppleTalk Configuration: 
Phase 2, Transition Bridge, and 
Phase 1 

Tills CHAPTER TELLS YOU HOW TO CONFIGURE GATEWAYS FOR 

AppleTalk Phase 2, transition bridge, and AppleTalk Phase 1 

routing using the protocols contained in the K-STAR gateway 

program. 

If you are updating an internet from AppleTalk Phase 1 to 

AppleTalk Phase 2, you need to install new AppleTalk software 

on individual Macintoshes and configure the gateway for Phase 

2 routing. If there is a Phase 1 router on your local Ethernet, at 

least one of the Phase 2 routers on that Ethernet must be 
configured as a transition bridge. If there is a Phase 1 router on 

your local LocalTalk net, all of the Phase 2 routers on that 
LocalTalk net must be configured as a transition bridge. See the 

section on "Transition Bridge Addressing" later in this chapter. 

Any of the AppleTalk configurations described in this chapter 

can be used together with the K-STAR IP or K-STAR DECnet 

configurations described in Chapters 3 and 4. For information 

on AppleTalk routing to an AppleTalk service on an IP host, see 

"IPTalk Configuration" in Chapter 3. For information on 

AppleTalk Phase 1 configuration without using K-STAR, see 

AppendixE. 
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AppleTalk configuration features 

1. Autoconfiguration. You can allow the FastPath to 
automatically identify itself to its network interfaces and 
begin AppleTalk routing. By default, the gateway will 
acquire AppleTalk Phase 1 information and use the Phase 1 
protocols that are built in to its PROM. 

• See Chapter 1 and Appendix E if you are only using 
AppleTalk Phase 1 protocols, and do not require any of 
the K-STAR security options or other K-STAR protocols. 
In this case, you do not need to configure the gateway. 

• You can allow the gateway to autoconfigure for 
AppleTalk Phase 2 protocols by installing the FastPath 
as described in Chapter 1, launching the FastPath 
Manager, then following these steps: 
1. click Reset, then open the gateway again 
2. turn on the Remote Boot switch 
3. download K-STAR 

2. Explicit configuration. You can use the FastPath Manager to 
supply explicit configuration data that are meaningful for 
your site and network records. You can do this by opening a 
gateway and starting from scratch, or by opening an 
existing configuration file and modifying its data. 

• See the example "explicit" configurations in this 
chapter. 

3. Seeding a gateway. If there is already a fully configured 
FastPath on one (or both) of the gateway's networks, you 
can allow the new gateway to acquire its configuration data 
from the existing one. This is called "seeding," and is useful 
for ensuring that all gateways connected to a given network 
agree about that network's zone(s) and net number(s). 

• See the example "seeding" configurations in this 
chapter. 

2-2 FastPath Administrator's Guide 



AppleTalk Phase 2 addressing 

AppleTalk Phase 2 introduces the concept of extended networks 
and non-extended networks. LocalTalk is a non-extended 
network. Ethernet and Token Ring are examples of extended 
networks. 

Network numbers 
On non-extended networks (LocalTalk) a network number is a 
single decimal number between 1 and 65,279; for example, 30. 
The network number must be unique on the internet. 

On extended networks (the Ethernet side of the FastPath), a 
range of network numbers (a "network range") is a contiguous 
range of decimal numbers between 1 and 65,279; for example, 
1-10. The network range must be unique in the internet: no two 
networks can use the same number, and no two network ranges 
can overlap or have any network numbers in common. 

Each number in a network range can be associated with up to 
253 nodes. The size of the network range determines the 
maximum number of AppleTalk devices on the physical 
network. For example, a network having the range 1-10 could 
contain up to 10 x 253, or 2,530 nodes. 

1111" The gateway uses some memory to store each network number 
in a range, so it is advisable to use the smallest range required 
for your network. 

Node addresses 
On non-extended networks, an AppleTalk node automatically 
acquires its node number when it is turned on, and does not 
necessarily retain the same node number from one session to 
another. The node number cannot be assigned explicitly. 

On extended networks, an AppleTalk node is identified by a 
node address that consists of a network number within that 
network's range and a node number. The entire node address is 
acquired dynamically when the node boots up. 
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Zones 
An AppleTalk zone is a logical grouping of devices that makes it 
easier for users to locate and access network services. On non
extended networks, a network can be associated with one zone 
name, and all of the nodes on that network belong to that zone. 
Zone names can be 1 to 32 characters, including embedded 
spaces. The FastPath considers a character in a zone name to be 
invalid if its ASCII value is less than hex 20 or equal to hex 7F. 

On extended networks, a list of one or more zone names (a 
"zone list") can be associated with the network. The zone list 
becomes available to nodes on that network through the 
Macintosh Control Panel. All gateways on the internet must 
agree about the zone name assigned to the Local Talk side, and 
about the list of zone names assigned to the Ethernet side of 
each gateway. 

If a node does not select a zone from this list, it is automatically 
assigned to the default zone. The default zone is the first name 
you enter in the zone list, or the name you select from the list as 
the default zone. The same zone name must be the default 
zone on all gateways on that network. 

The zone name chosen by a node is the zone it belongs to and in 
which its services will be listed. A node can belong to only one 
zone. If a user on an EtherTalk Phase 2 network chooses a zone 
from the list displayed in the Macintosh Control Panel, that 
system's services will appear in the chosen zone. This does not 
restrict the user's ability to view and access network services in 
other AppleTalk zones using the Macintosh Chooser. 

1111., The gateway uses some memory to store each zone name in a 
list, so it is advisable to use the smallest list required for your 
network. 
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Required configuration data 

To route AppleTalk Phase 2 packets to devices on both network 
interfaces, the FastPath requires the following data: 

• One AppleTalk zone name for the gateway's LocalTalk 
interface. 

• One AppleTalk network number for the gateway's 
LocalTalk interface. 

• A list of AppleTalk zone names (one or more) for the 
gateway's EtherTalk Phase 2 interface. 

• A range of AppleTalk network numbers (one or more) for 
the gateway's EtherTalk Phase 2 interface. 

1111'" In this AppleTalk Phase 2 implementation, it is important that 
you enter all Phase 2 configuration information before you 
download K-STAR. This is the recommended procedure for all 
configurations, but it is currently required for AppleTalk Phase 2. 
It should also be noted that if you change the Phase 2 zone list, 
you must download K-STAR again after completing the changes. This 
is not required for any type of configuration other than 
AppleTalk Phase 2, and should be especially noted. 
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An example Phase 2 internet 

Figure 2-1 shows an example internet configuration using only 
AppleTalk Phase 2 routing on two Ethernets and two LocalTalk 
networks. 

The gateway's LocalTalk interface is 
always configured as a non-extended 
network. This is similar to AppleTalk 
Phase 1 configuration, using one net 
number and one zone name. 

The Ethernet side of a 
gateway is configured as an 
extended network, using a 
network range and a zone list. 

gateway 1 will be 
installed first. 
Configuration data 
will be supplied 
explicitly. 

gateway 2 will be 
installed second, and 
will acquire seed 
configuration data on its 
EtherTalk Phase 2 
interface. 

Figure 2-1. Example AppleTalk Phase 2 internet 

acquire seed data on 
its Loca1Talk 
interface. 

The three gateways in this example will be configured for 
AppleTalk Phase 2 routing. The first gateway (gateway 1) will 
be explicitly configured with the proper network numbers and 
zones. Gateway 2 will acquire seed configuration data on its 
EtherTalk Phase 2 interface, and gateway 3 will acquire seed 
configuration data on its LocalTalk interface. 
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LocalTalk data: 
Zone name: karen 
Network number: 30 
EtherTalk Phase 2 data: 
Network range: 1-10 
Zone list: karen 

russ 
terry 

When the sample gateways are fully configured, they will have 
the configuration shown in Figure 2-2. Seeded data is shown in 
italic type. 

Nodes on Ethernet will be in the 
default zone until the Macintosh 
user chooses a zone from the 
names included in the zone list. 

LocalTalk dala: 
Zone name: russ 
Network number: 40 
EthflrTa/k Phase 2 data: 
NelWOrk range: 1-10 
Zone list: karen 

russ 
terry 

-- LoealTalk data: 
Zone name: russ 
Network number: 40 
ElherTalk Phase 2 data: 
Network range: 11-20 
Zone list: bill 

esther 

Figure 2-2. AppleTalk Phase 2 Zones and Net Numbers 

For each of the three gateways to be configured, you should 
follow the general procedure described in Chapter 1; that is, 
connect one FastPath to one Macintosh via LocalTalk, configure 
it as described below, turn it off, unplug it, and move it to its 
permanent location. 
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Explicit configuration: gateway 1 
After connecting the FastPath to a Macintosh via LocalTalk, 
launch the FastPath Manager, and select and open the gateway. 
In the main configuration dialog box, 

• 
• 
• 

• 
• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click the Pause button. 
Enter the AppleTalk configuration data for the network on 
the gateway's LocalTalk interface. 
Enter the EtherTalk Phase 2 configuration data. 
Turn on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-2. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

LocalTalk Interface Zone Name: karen 
LocalTalk Interface Net Number: 30 
EtherTalk Phase 2 Network Range: 1-10 
EtherTalk Phase 2 Zone List: karen 

russ 
terry 

Note that zones are primarily intended for user convenience and 
for managing AppleTalk services (such as LaserWriters or 
AppleShare servers). You should choose zone names that will 
be meaningful to users to indicate where the services are 
located. 

After selecting Reset and then Pause, 

1. Click in the AppleTalk Zone name field for the LocalTalk 
side and type karen, then press tab. 

2. Type the net number for the LocalTalk interface: 30, then 
press tab. 

3. Type the lower number of the EtherTalk Phase 2 network 
range in the Range Start field: 1, then press tab. 
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4. Type the high end of the network range in the Range End 
field: 10, then press tab. 

l-~:=: .. Serlel Nu~~r: 100766 PROM Venlon: 4·'l r'~"~ 
Currentl y DDvnlDldtd nI" ,.", I 
Lest Conliguretion Dlte: Tue Aug I, 1989 15:08:08 
Current Conflguretton me: ,.", II 
_~~~~.~resl: o8oo89A0001.8 .• ___ 1 LJ .Edlt 1 ! 

r· Lacen.n I.terr.c. ---··--·-------1 r:svib:"·-·_··l 
AppleTl1 k Zone Neme ME III ~ Ruto coong i 

_ :::~:;!: ~;~;~_ .. ~ _ .... _ .19. .. ~~~.~~1 r ::!:~ P"'~ Z -... I .-.. Rln;:·;~- 110 _. I -] 
i ET,' k 2.0 Net Number 0 I 
L! ETa' k Z.O Node Number 0 [zone LI ..... ] I ----... -.. _-_ ... _---_._--_ .... -r· lie!,. _·--_·-·-··_·_--····_·--···_···-1 

L __ .. _._._ .. __ .. _ .... ___ ............ __ ._._.J 

( Log... ) 

( Option .... ) 

( Relet) 

( Restart ) 

( 60 ) 

( Peuse ) 

5. Click the Zone List. .. button to open the zone list dialog box. 

6. Type the first zone name for this network in the Zone Name 
field at the bottom of this box: karen and click Add (or press 
return) to enter it in the zone list. Because it is the first zone 
name in the list, this will be the default zone for EtherTalk 
Phase 2 Macintoshes on this Ethernet until the Macintosh 
user explicitly chooses a different zone. 

Note that a single asterisk is not allowed as a zone name in 
AppleTalk Phase 2. 

7. Type the additional zone names: 

russ (click Add or press return) 
terry (click Add or press return) 
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Unless you explicitly select 
another zone name and click 
the Default button, the first 
name you enter is the default 
zone. All gateways on this 
Ethernet must agree about the 
default zone. 

---+Oe'ault Zone: karen 

karen 
rUII 
terry 

Q 
( O",'oult ) 

[RI'I)IOce) 

o (Delete) 
~----------------------~= 
Zone Name: 
II I Add I 

OK ( Cancel ) 

8.· Click OK to return to the main configuration dialog box. 

9. Tum on the Remote Boot switch by clicking in the selection 
box. . 

10. Select Download a File ... from the File menu and open 
K-STAR. 

11. When K-STAR has been downloaded, click the Go button. 
In AppleTalk Phase 2, the gateway immediately begins 
Phase 2 node finding when you click Go. This can cause a 
delay of up to 5 seconds before the Diagnostics box 
appears. 

010 nostlt Potkets 

(0) _ 133 

48 2D :53 :M 41 :12 20 411 III 73 74 :10 III 74 III 20 
41 :M 2D IE !iF &4 1i5 20 31 33 33 2C 2D 45 :M 20 
liE !iF &4 115 20 31 35 32 2C 2D 45 54 32 2E 30 20 
liE 115 74 20 31 2C 20 ~ :M 32 2E 30 20 11£ OF 114 
lIS 20 31 35 32 2t 20 32 34 311 20 112 7S l1li l1li lIS 
nn2OD3330201II0Fn201IS~MIISn 
IE 1i5 74 29 2C 20 n es 7a 119 n 119 OF liE 20 511 
30 31 30 30 III 32 2C 20 4F 70 74 19 OF IE 20 411 
lie iii 1i7 73 3A 20 20 liE OF IE 115 2E 

K-5TAR Fastpath 
AT nocItI 133, ET 
"" ... 152, ET2.0 
... t I, ET2.0 nod 
• 1:12, 2411 buffa 
... (30 fer av..r 
... \) • ....,1. Ion I. 
0, Optian FIlip: 
_: 
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The Diagnostics window is continually being updated with new 
messages from all gateways on the LocalTalk network (in this 
case, only one). See Appendix C for an explanation of the 
gateway startup message in the rightmost column. 

12. Select Save Configuration File ... from the File menu and 
type a name for the configuration; for example, 

GWl.ETALK2.config 

Click the Save button to save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
turn off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to access the diagnostic messages from the gateway. 
The Log window contains a static version of the most recent 
messages from the gateway that is currently open. 

Log Messages: 

• KFPS fIT" 133 ETW 152 PIIOI'I lEU 4. I (11"0/07) STIITE=OOI4ILOAO URLID 10 
III STRTUS-O i= 
• K-sTAII FastPath AT no"," 133. ET no ... 152, ET2.0 nat I, ET2.0 no'" 
IS2, BS .... " ... (30 for at_t>, ...... 1.lon B.O, Option Flags: 
none. 

(Continue) Print 

You should also check that the zone names you have assigned 
appear in the Macintosh Chooser. Select the Chooser from the 
Apple (ti) menu: 
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ChooseI'" 

IIL---_ 
ApplaTalk Zonas: I .. __ ... _. __ .. _. __ ... _ .. ___ .. Duss UsarNllma: 

terry 
8 Actiye 

AppleTlIlk 0 InactiYe 
3.3.1 

Seeding on the Ethernet interface: gateway 2 
This example uses seeding to acquire data from the Ethernet 
interface of gateway 1. After connecting the FastPath to a 
Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration window, 

• Click. the Reset button, then open the gateway again. 
• Click. Pause. 
• Enter the AppleTalk configuration data for the network on 

the gateway's LocalTalk interface. 
• Tum on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click. the Go button. 
• Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-2. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure 
it. 

LocalTalk Interface Zone Name: russ 
LocalTalk Interface Net Number: 40 
EtherTalk Phase 2 configuration: seeded from gateway 1 

After selecting Reset and then Pause, 

1. Click in the AppleTalk Zone name field for the LocalTalk 
interface and type russ, then press tab. 
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2. Type the net number for the LocalTalk side: 40, then press tab. 

3. Turn on the Remote Boot switch. 

[ htev1I. -- ,_--' Cp.ft"I~.'d"i.!..-ti.~1 F.tPlth'" Serl'l Number: 100167 PROM Y,,,lon: 4.1 
Currentl V DolO'nloedld FIlt: IIbfII 
leIt Conft,uretfon Dlte: IIbfIIIf_lMt Ii'D'E1" 
Current Confl,uretfon file: IIbfII 
Ethernet Mdr_: D80D89ADDDD9 

r L_IT,lIIll1terfece"- -- I r~Rtcut"O ·c·"o-n-n"u"·l 
IIpp'eT.,kZone 111l1li f:lr~'.!!-Ul.;..' --,,-_____ ---'. """ 

AppleTelt Net Number ~ 1181 Remote Boot I 
! IIppl.Telt NDde Number 1 n '--. 

4. Download K-STAR using the Download a File ... command 
in the File menu. 

5. When K-STAR has been downloaded, click the Go button. 
A few seconds after you select Go, the Diagnostics window 
displays in the foreground. You may see a message such as 
''WARNING: ETALI<2 has not acquired a net number." 
Because you are configuring on an isolated network, no 
configuration data has been supplied to the EtherTalk Phase 
2 interface. This message should no longer appear when the 
gateway is in its permanent location. 

6. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 
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Click Log ... to open the Log window: 

Log Messages: 

~ ~T~~ 220 ET" 130 PRDII REV 4.1 ( .. ,10107> STRTE=DCULOIID URLID IQ 
• K-STAA FastJ>ath AT ""do! 220, ET """"' 136, ET2.0 NIt 65280, ET2.0 
"" ... 136, IS buff ... (3D f .... therrlet>, ...... i.ion •. 0, Cpti .... 
Flags: ..... • ETII..K2 __ as range I - 10, ___ net I 

ficontlnuel Print 

These messages indicate that the gateway has acquired its 
EtherTalk Phase 2 data from gateway 1 on Ethernet, and has 
selected a net number for itself from the network range. 

Seeding on the LocalTalk interface: gateway 3 
This example uses seeding to acquire data from the other 
gateway on the LocalTalk interface of the FastPath. After 
connecting the FastPath to a Macintosh via LocalTalk, launch the 
FastPath Manager, and select and open the gateway. 

• Click the Reset button, then open the gateway again. 
• Click Pause. 
• Enter the EtherTalk Phase 2 configuration data. 
• Turn on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 2-2. 
For your site, you should determine the proper network numbers 
and zone names for the gateway before you configure it. 

The configuration data for this box is 

Loca/Talk Interface configuration: seeded from gateway 2 
EtherTalk Phase 2 Network Number Range: 11-20 
EtherTalk Phase 2 Zone List: bill 

esther 
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After selecting Reset and then Pause, 

1. Press tab twice to position the cursor in the Range Start 
field, type the lower number of the range: 11, then press tab. 

2. Type the high end of the network range in the Range End 
field: 20, then press tab. 

['~-E~~=~=~~: =:~~=.mo __ n_: _4'_1 ~ C[IIfi~.·E·.dr·jfti··l..J1 
Curnnt Contl,untton fill: II/IfW ~ 
Ethlrnet Adclre .. : OIOOIMOOOO' .. -. -_ .. _-_ ..... 

,-~~!:~~t~~-:: 1~~iiifiiiiii'i"ii'-i"-i"i"'i-iiTI' r;~~~~~onfig-l 
AppleTelk Net Number l!::J L 0 I 

.. ~_pp_le~!~_~_N_um_~~ •. 190 • _~~~~.~~~j r (therlllll PMn Z - .. :==-.:::::=--=--=; ( Log... ) 
i RIII9I Stlrt rrr:=l Ringe End ~ I (OPllons ... 1 
i ETlik Z.O Ntt Number 0 
1·_._E_TI.I •. k_Z.O Node Number 0 [ Zone List ... I [RBIBI] 

_. _._.. . __ J [Restart] r Help _. _ .. __ .---- ··_·· __ .. · .. ··_ .. ·--·1 ~ P::.8 J 

3. Click the Zone List... button to open the zone list dialog 
box. 

4. Type the first zone name for this network:bill, and click 
Add (or press return). This will be the default zone name 
assigned to AppleTalk Phase 2 nodes on this Ethernet until 
the Macintosh user explicitly chooses a different zone. 

5. Type the next zone name: esther and click Add (or press 
return), then click OK to return to the main configuration 

dialog box. 

6. Tum on the Remote Boot switch, then download K-STAR 
using the Download a File ... command in the File menu. 

7. When K-STAR has been downloaded, click the Go button. 
In AppleTalk Phase 2, the gateway immediately begins 
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Phase 2 node finding when you click Go. This can cause a 
delay of up to 5 seconds before the Diagnostics box 
appears. Because you are configuring on an isolated 
network, you may see diagnostic messages warning that the 
LocalTalk interface has not acquired its seed data. These 
messages should no longer appear when the gateway is in 
its permanent location. 

8. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 

Log Menagel: 

• KFPS AT- 220 ET- 1311 PROII REV 4.1 (88/10107) STATE-DDIft.DAD UfLIO 10 
HI.! STRTUS=O F 
• K-5TAR Fastpath AT node 220, ET nod. 1311, ET2.D n.t II, ET2.0 nod. 
137, 85 bu" .... (3D for .\hrneU, r.vi.ion 8.0, Option FI_: 
nona. 
• IITIILK •• _ .. net 4D 

(continue) Print 

These messages indicate that there are no Option flags on, and 
that the gateway has acquired its AppleTalk data from gateway 
2 on its LocalTalk interface. 
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Transition bridge addressing 
If there is a Phase 1 gateway or router on your local Ethernet, 
at least one of the Phase 2 gateways on that Ethernet must be 
configured as a transition bridge. If there is a Phase 1 router 
on your local LocalTalk net (even a LocalTalk-to-LocalTalk 
bridge), all of the Phase 2 gateways on that LocalTalk net must 
be configured as transition bridges. 

Option 17 must be enabled to activate the transition bridge 
software. 

The transition bridge software requires a full LocalTalk 
configuration, as well as full EtherTalk Phase 1 and EtherTalk 
Phase 2 configurations. 

The EtherTalk Phase 2 interface observes the AppleTalk Phase 2 
addressing rules with the following exceptions: 

Network numbers 
On the EtherTalk Phase 2 interface of the FastPath, the transition 
bridge uses a network range with only one element; for 
example, 10-10. The range start and the range end must be 
equal, and must be unique in the internet. This allows the 
transition bridge software to maintain routing information that 
is comprehended by Phase 1 nodes. Because the size of the 
network range determines the maximum number of AppleTalk 
devices on the physical network, a network running the 
transition bridge software can support no more than 253 
EtherTalk Phase 2 nodes. However, because the transition 
bridge is also configured for an EtherTalk Phase 1 interface, the 
network can also support up to 254 EtherTalk Phase 1 nodes, 
with a total limit of AppleTalk nodes on Ethernet equal to 507. 

Zones 
On extended networks (the EtherTalk Phase 2 interface of the 
FastPath), the transition bridge uses a zone list with only one 
element. This allows the transition bridge software to maintain 
routing information that is comprehended by Phase 1 nodes. 
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Required configuration data 

To operate as a transition bridge, the FastPath requires the 
following data: 

• One AppleTalk zone name for the gateway's LocalTalk 
interface. 

• One AppleTalk network number for the gateway's LocalTalk 
interface. 

• One AppleTalk zone name for the gateway's EtherTalk 
Phase 1 interface. 

• One AppleTalk network number for the gateway's EtherTalk 
Phase 1 interface. 

• A "list" of one AppleTalk zone name for the gateway's 
EtherTalk Phase 2 interface. 

• A "range" of one AppleTalk network number for the 
gateway's EtherTalk Phase 2 interface. 

1111..- Option 17 must be enabled. 
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An example transition bridge internet 

Figure 2-3 shows an example internet configuration that 
supports both Phase 1 and Phase 2 nodes on Ethernet. 

The network on the LocalTalk interface 
of a transition bridge is always 
configured as a non-extended network. 
using one net number and one zone 
name. 

The EtherTalk interface of a 
transition bridge is configured 
with both Phase 1 and Phase 2 
data, and Option 17 enabled. 

transition bridge 1 
will be installed first 
Configuration data 
will be supplied 
explicitly. 

transition bridge 2 will 
be installed second, and 
will acquire seed 
configuration data on 
both its EtherTalk Phase 
1 and EtherTalk Phase 2 
interfaces. 

Figure 2-3. Example Phase lIPhase 2 internet 

transition bridge 3 
will be installed last. 
It will acquire seed 
data on its LocalTalk 
interface. 

The three gateways in this example will be configured as 
transition bridges. The first transition bridge (bridge 1) will be 
explicitly configured with the proper network numbers and 
zones. Bridge 2 will acquire seed configuration data on its 
EtherTalk Phase 1 and EtherTalk Phase 2 interfaces, and bridge 
3 will acquire seed configuration data on its LocalTalk interface. 
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Option 17:0N 
LocalTalk data: 
Zone name: karen 
Network number: 30 
EtharTalk Phasa 2 data: 
Network range: 10-10 
Zone list: russ 
EtharTalk Phasa 1 data: 
Zone name: terry 
Network number: 1 

When the sample transition bridges are fully configured, they 
will have the configuration shown in Figure 2-4. Seeded data is 
shown in italic type. 

The EtherTaik Phase 2 network 
range and zone list on Ethernet 
are limited to one element. 

Option 17: ON 
LocalTalk data: 
Zone name: russ 
Network number: 40 
EtherTalk Phase 2 data: 
Network range: 10-10 
Zone list: russ 
EtherTalk Phase 1 data: 
Zone name: ter~ 
Network number: 1 

Option 17: ON 
LoealTalk data: 
Zone name: russ 
Network number: 40 
EtharTalk Phase 2 data: 
Network range: 20-20 
Zone list: esther 
EtharTalk Phase 1 data: 
Zone name: bill 
Network number: 11 

Figure 2-4 .. Transition bridge configurations 

For each of the three gateways to be configured, you should 
follow the general procedure described in Chapter 1. 
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Explicit configuration: bridge 1 
After connecting the FastPath to a Macintosh via LocalTalk, 
launch the FastPath Manager, and select and open the gateway. 

• 
• 
• 
• 

• 
• 

• 
• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click the Pause button. 
Thm on Option 17. 
Enter the AppleTalk configuration data for the network on 
the gateway's LocalTalk interface. 
Enter the EtherTalk Phase 2 configuration data. 
Select ATalk Phase 1 from the Configuration menu and 
double-click on the ATalk Phase 1 listing in the 
Configuration area. 
Enter the EtherTalk Phase 1 configuration data. 
Turn on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-4. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

Option 17: ON 
LocalTalk Interface Zone Name: karen 
LocalTalk Interface Net Number: 30 

EtherTalk Phase 2 Network Range: 10-10 
EtherTalk Phase 2 Zone List: russ 

EtherTalk Phase 1 Zone Name: terry 
EtherTalk Phase 1 Net Number: 1 

After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 17 by clicking in the selection box next 
to the number 17 (an X appears in the selection box when 
the option flag has been turned on), then click OK to close 
the Options window. 
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3. Click in the AppleTalk Zone name field for the LocalTalk 
interface and type karen, then press tab. 

4. Type the net number for the LocalTalk interface: 30, then 
press tab. 

5. Type the lower number of the EtherTalk Phase 2 network 
range in the Range Start field: 10, then press tab. 

6. Type the high end of the network range in the Range End 
field: 10, then press tab. Note that the Range Start and Range 
End must be equal on a transition bridge. 

7. Click the Zone List ... button to open the zone list dialog box. 

8. Type the zone name for this network in the Zone Name field 
at the bottom of this box: russ and click Add (or press 
return) to enter it in the zone list. Note that there must be only 
one EtherTalk Phase 2 zone name on a transition bridge, and a 
single asterisk is not allowed as a zone name. 
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9. Click OK to return to the main configuration dialog box. 

10. Select ATalk Phase 1 from the Configuration menu, and 
double-click on AppleTalk Phase 1 in the Configuration 
listing to bring up the EtherTalk Phase 1 dialog box. 

11. Type the EtherTalk Phase 1 zone name: terry, then press tab. 

12. Type the EtherTalk Phase 1 net number: 1, then press tab. 

r-ElberT.1t P .... , -::::::=:;') 

"Ppl,Tllk Zone Nlme t5 II 
' "ppl.Tllk Net Numlltr , 
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i rlltPtth', [therTllk PhIM I .... J 
L ___ . 

I OK I 

13. Click OK to return to the main configuration dialog box. 
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14. Turn on the Remote Boot switch by clicking in the selection 
box. 

15. Download K-STAR using the Download a File ... command 
in the File menu. 

16. When K-STAR has been downloaded, click the Go button. 
In AppleTalk Phase 2, the gateway immediately begins 
Phase 2 node finding when you click Go. This can cause a 
delay of up to 5 seconds before the Diagnostics box 
appears. 

17. Select Save Configuration File ... from the File menu and 
type a name for the configuration; for example, 

BRIDGEl.config 

Click the Save button to save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 
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Log Mellages: 

~ ~r::o 220 Ef'O 136 PAOlI NEU 4. I (."0107) STATEoIlOIft.OflO UAl..ID ~ 

• K-STAR F_\P"U. AT node 220, ET noel. 131, En.o ... t 10, ET2.D ..... 
152,115 .... ".,.,. (30 'er .u.rn.U, ..... 1 .... '" '.D, Optlan FI_: 17. 

(contlnuel Print 

This message shows that Option 17 is turned on (the gateway is 
running the transition bridge software). 

Seeding on the Ethernet interface: bridge 2 
This example uses seeding to acquire data from the Ethernet 
interface of the gateway configured as bridge 1. After 
connecting the FastPath to a Macintosh via LocalTalk, launch 
the FastPath Manager, and select and open the gateway. In the 
main configuration window, 

• 
• 
• 
• 

• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click Pause. 
Turn on Option 17. 
Enter the AppleTalk configuration data for the network on 
the gateway's LocalTalk interface. 
Tum on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 24. 
For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

Option 17: ON 
LocalTalk Interface Zone Name: russ 
LocalTalk Interface Net Number: 40 
EtherTalk Phase 1 and Phase 2 configuration: seeded from 
transition bridge 1 
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After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 17 by clicking in the selection box next 
to the number 17 (an X appears in the selection box when 
the option flag has been turned on), then click OK to close 
the Options window. 

3. Type russ in the AppleTalk Zone name field for the 
LocalTalk interface, then press tab. 

4. Type the net number for the LocalTalk interface: 40, then press 
tab. 

5. Turn on the Remote Boot switch. 

I I tldmltlUll blltlQl' 2 

r- Selev •• --- PI onff,.,..li .. -·:\ 

I flltPlth"Seril' Number: 100767 PROMV,rston: 4.1 0 1 
Currentlv Dwnloeded file: '*'" I I 

. lIetConfiauretion Dlle: '*"'M_1Nil?lSEr I 
L_~~~~~~~;~::'::~::~~~~~~._ .. _ ...... _ ...... _. L C Edit ) .J 
l- loc•n •1t Inlort_ .-_. ..... =rI ~SVtIc'" 

I App.eTllk Zone Nlme lrIIIC 1'1 181 Ruto Coong I 
AppllTllk Net Number ~ 181 Remote 800t I 

'-_~~~,~~,~ NodI Number 220 J ._ .. ;=:====:::::;:-' 

-::.'::~ Pj;' - I -;. .. E.~ 1 ( Log_. ) 
( Option .... ) 

ETII k 2.0 Ntl Number 0 
ETllk 2.0 Node Number 0 [ Zooe List ... ) Re.et J 

1
':';'1, --.------.. -------.------. -'l Restart) 

Go ) 

L .. __ ._. __ ... __ . ___ .... __ ... ____ . _____ j Pausa j 

6. Download K-STAR using the Download a File ... command 
in the File menu. 

7. When K-STAR has been downloaded, click the Go button. 
Because you are configuring on an isolated network, you 
may see diagnostic messages warning that the EtherTalk 
interfaces have not acquired their seed data. These 
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messages should no longer appear when the gateway is in 
its permanent location. 

8. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 

Log Mellagel: 

~K~~220 ET. 13& PA01'I REV 4.1 (88"0107) STATE-DOIK.OPD IR.ID :!:! 

• K-STAA FClStp"th AT .- 220. ET ...... ,3&. ET2.D nat. 10. ET2.0 node 
13&. 249 bwff.rs (3D for .the .... U. r ... ision B.D. Option F1"9S: 17. 
• ETALlC1 ....tad as nat I 
• ETALKZ _dtod _ r_ 10 - 10. __ •• ""t 10 

i'i 

ncontinueD Print 

These messages indicate that Option 17 is turned on (the 
gateway is running the transition bridge software), and that 
both the EtherTalk Phase 1 and EtherTalk Phase 2 net numbers 
have been acquired from bridge 1 on Ethernet. 

Seeding on the LocalTalk interface: bridge 3 
This example uses seeding to acquire data from the other 
gateway on the LocalTalk interface of the FastPath. After 
connecting the FastPath to a Macintosh via LocalTalk,launch 
the FastPath Manager, and select and open the gateway. 

• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click Pause. 
Tum on Option 17. 
Enter the EtherTalk Phase 2 configuration data. 
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• 

• 
• 
• 
• 
• 

Select ATalk Phase 1 from the Configuration menu and 
double-click on the ATalk Phase I listing in the 
Configuration area. 
Enter the EtherTalk Phase 1 configuration data. 
Tum on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-4. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 
The configuration data for this box is: 

Option 17: ON 
Loca/Talk interface configuration: seeded from gateway 2 

EtherTalk Phase 2 Network Range: 20-20 
EtherTalk Phase 2 Zone List:: esther 

EtherTalk Phase 1 Zone Name: bill 
EtherTalk Phase 1 Network Number: 11 

After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box to bring up the Options window. 

2. Turn on Option flag 17 by clicking in the selection box next 
to the number 17 (an X appears in the selection box when 
the option flag has been turned on), then click OK to close 
the Options window. 

3. Tab twice to position the cursor in the Range Start field, type 
the lower number of the EtherTalk Phase 2 network range: 
20, then press tab. 

4. Type the high end of the network range in the Range End 
field: 20, then press tab. Note that the Range Start and Range 
End must be equal on a transition bridge. 
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5. Click the Zone List. .. button to open the zone list dialog box. 

6. Type the zone name for this network in the Zone Name field 
at the bottom of this box: esther and click Add (or press 
return) to enter it in the zone list. Note that there must be only 
one EtherTalk Phase 2 zone name on a transition bridge, and that a 
single asterisk is not allowed as a zone name in AppleTalk Phase 2. 

7. Click OK to return to the main configuration dialog box. 

8. Select ATaik Phase 1 from the Configuration menu and 
double-dick on its listing in the Configuration area to bring 
up the EtherTalk Phase 1 dialog box. 

9. Type the EtherTalk Phase 1 zone name: bill, then press tab. 

10. Type the EtherTalk Phase 1 net number: 11, then press tab. 

C-(therT.lIt , .... 1 ----- --
IIppleTllklo",Nlme b II 
IIppleTllk Net Number 11 
IIppleTllk Node Number 227 ____________ ..1 

[.... ___ I 
Cancel 

, OK I 

11. Click OK to return to the main configuration dialog box. 

12. Turn on the Remote Boot switch by clicking in the selection 
box. 
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U II Ml\ltlOfI hll,lqf' ~ 

[

G.tevl' :]-wc..n'.'ltll!!;;;;! 
FutPlth" Senal Number: 100768 PROM Vlrslon: 4.1 I Arllk Phull Cl 
Currenll 9 Dwnloeded File: MIl", ~ 
Lut Conflguntion DetI: MII",II"",,.,, Ii'tStr I 
Current Conft,uretlon Fill: MIl", [ 
~_~~~____ 080089A00009 _...... ( Edit) 

UCln11l: , ... ,,- _ •• - --.--~ r-Svitc"':-:--J 
Appltrllk Zone Nome b±& I ~ Ruto Conflg I 
Applertlk Net Number ~ I ~ Remote Boot 
AppllTtlk Node Number 133 r (t;~TIII: , .... Z --.--.==.:... ~-:J ... ' (Log...) 
RInge st.rt ~ Ringe End ~ ( Options ... ) 
£Ttl k Z.O Not Number 0 [ 

4i;~'0 Node Number 0 ---... ~~:::=~:::-l [R::::~~ 
[ ___ .. _ ........ _ .. _ .. ___ . . ___ --.J f ,::.. ~ 

13. Download K-STAR using the Download a File ... command 
in the File menu. 

14. When K-STAR has been downloaded, click the Go button. 
In AppleTalk Phase 2, the gateway immediately begins 
Phase 2 node finding when you click Go. This can cause a 
delay of up to 5 seconds before the Diagnostics box 
appears. Because you are configuring on an isolated 
network, you may see diagnostic messages warning that the 
LocalTalk interface has not acquired its seed data. These 
messages should no longer appear when the gateway is in 
its permanent location. 

15. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 
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Click Log ... to open the Log window: 

Log Ma •• Bga.: 

_ KFPS lire 220 ET- 1311 Plllll'l1IBI 4.1 (11'1011)7) STIITE-DCIIILDIID Ull.10 
III ITllTUloCI 
- K-STIIII Fastl'ath AT ...... 220, ET ...... 1311, ETZ.O .. t zoo ETZ.O_ 
1311, 8lI1Nff ..... (3D for _"*"-\), ,...,1.1 .... '.D, Option FI_: 17. 
- IITIIJ( _ as .. t 40 

Icontlnuel Print 

These messages indicate that Option 17 is turned on (the 
gateway is running the transition bridge software), and the 
LocalTalk net number has been acquired from bridge 2 on the 
gateway's LocalTalk interface. 
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AppleTalk Phase 1 addressing 

When you are explicitly supplying AppleTalk Phase 1 network 
numbers and zone names, the basic rules to remember are: 

• AppleTalk zone names can be 1 to 32 characters, including 
embedded spaces. The characters must be legal printing 
characters (that is, greater than hex 20 and not equal to hex 
7F). In AppleTalk Phase 1, zones are a superset of networks: 
a zone can include multiple networks, but a network cannot 
have multiple zones. All gateways on the internet must 
agree about the zone name assigned to a particular network. 

• AppleTalk network numbers can be any decimal number 
between 1 and 65,279. An AppleTalk network number must 
be unique to a cable (you can not repeat the number on 
more than one network), and all gateways must agree about 
what number is assigned to a particular cable. The 
maximum number of AppleTalk devices on a Phase 1 
network is 254. 

• AppleTalk automatically assigns a node number when a 
device boots up. AppleTalk node numbers cannot be . 
assigned explicitly. 
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Required configuration data 

To route AppleTalk Phase 1 packets to devices on both network 
interfaces using K-STAR, the gateway requires the following 
data: 

• One AppleTalk zone name for the gateway's LocalTalk 
interface. 

• One AppleTalk network number for the gateway's 
LocalTalk interface. 

• One AppleTalk zone name for the gateway's EtherTalk 
Phase 1 interface. 

• One AppleTalk network number for the gateway's 
EtherTalk Phase 1 interface. 

1111" Options 17 and 18 must be enabled when you are using the 
AppleTalk Phase 1 software in K-STAR 
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gateway 1 will be 
installed first. 
Configuration data 
will be supplied 
explicitly. 

An example Phase 1 internet 

Figure 2-5 shows an example internet configuration using only 
AppleTalk Phase 1 routing on two Ethernets and two LocalTalk 
networks. 

gateway 2 will be 
installed second, and 
will acquire seed 
configuration data on its 
EtherTalk Phase 1 
interlace. 

Figure 2-5. Example AppleTalk Phase 1 internet 

gateway 3 will be 
installed last. It will 
acquire seed data on 
its LocalTalk 
interface. 

The three gateways in this example will be configured for 
AppleTalk Phase 1 routing. The first gateway (gateway 1) will 
be explicitly configured with the proper network numbers and 
zones. Gateway 2 will acquire seed configuration data on its 
EtherTalk Phase 1 interface, and gateway 3 will acquire seed 
configuration data on its LocalTalk interface. 
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Option 17: 
Option 18: 
LocalTalk data: 

When the sample gateways are fully configured, they will have 
the configuration shown in Figure 2-6. Seeded data is shown in 
italic type. 

Option 17: ON Option 17: ON 
Option 18: ON Option 18: ON 
LocalTalk data: LocalTalk data: 

Zone name: meredith Zone name: tim Zone name: tim 
Network number: 30 
EtherTalk Phase 1 data: 
Zone name: harvey 
Network number: 10 

Network number: 40 Network number: 40 
EtlHlrTalk Pha .. 1 data: EtherTalk Ph ... 1 data: 
Zone name: harvey Zone name: anat 
Network number: 10 Network number: 11 

Figure 2-6. AppleTalk Phase 1 Zones and Net Numbers 

For each of the three gateways to be configured, you should 
follow the general procedure described in Chapter 1; that is, 
connect one FastPath to one Macintosh via LocalTalk, configure 
it as described below, tum it off, unplug it, and move it to its 
permanent location. 
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Explicit configuration: gateway 1 
After connecting the FastPath to a Macintosh via LocalTalk, 
launch the FastPath Manager, and select and open the gateway. 
In the main configuration dialog box, 

• 
• 
• 
• 

• 

• 
• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click the Pause button. 
Turn on Options 17 and 18. 
Enter the AppleTalk configuration data for the network on 
the gateway's LocalTalk interface. 
Select ATalk Phase 1 from the Configuration menu and 
double-click on the ATalk Phase 1 listing in the 
Configuration area. 
Enter the EtherTalk Phase 1 configuration data. 
Tum on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-6. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

Option 17: ON 
Option 18: ON 

LocalTalk Interface Zone Name: meredith 
LocalTalk Interface Net Number: 30 

, EtherTalk Phase 1 Zone Name: harvey 
EtherTalk Phase 1 Net Number: 10 

Note that zones are primarily intended for user convenience and 
for managing AppleTalk services (such as LaserWriters or 
AppleShare servers). You should choose zone names that will 
be meaningful to users to indicate where the services are 
located. 

After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 
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2. Turn on Option flag 17 and Option flag 18 by clicking in the 
selection box next to the numbers 17 and 18 (an X appears in 
the selection box when the option flag has been turned on), 
then click OK to close the Options window. 

-0,11 •• n ... ·---- --

~~ ~. r ~~ 10 II 

" " 12 20 
II 21 
14 22 
1& ZI 
16 Z4 

L....... _____ ----------

[

'ti •• Pu ..... r. 
DO DO DO DO DO DO DO DO 
DO DO DO DO DO 00 00 00 
DO DO DO DO DO 00 00 00 
00 DO DO DO DO 00 00 00 

[ 

( Cancel ) 

I OK 

1 
o RSCII I 
(!) HeHlldetimlllj 

J 

3. Click in the AppleTalk Zone name field for the LocalTalk 
interface and type meredith, then press tab. 

4. Type the net number for the LocalTalk interface: 30, then 
press tab. 

5. Select ATaik Phase 1 from the Configuration menu, and 
double-dick on the ATaik Phase 1 listing in the 
Configuration area of the screen. This brings up the 
EtherTalk Phase 1 dialog box. 

6. Click in the AppleTalk Zone Name field in the EtherTalk 
Phase 1 dialog box, type harvey, then press tab. 

7. Type the net number for the EtherTalk Phase 1 interface: 10, 
then press tab. 
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,
- t:t .. rT.n: PIIII. I -----•• -.~ 

IIppleTalkZone Name ~ I 
IIppleTalk Net Numller To 
IIppleTalk Node Number ZZ7 ______ .. - .. __ 00_ .. ___ - tllncel 

[ --_·_·_-1 
.J 

I OK J 

8. Click OK to return to the main configuration dialog box. 

[ [ lId!t'Wdll 1 

r ~':~~:';~·~;~~o;;;---;~;;;;;:;;:-;-;··-l ~I ~:=.~ Cur"ntl~ Ownlo"" File: NttM 11 I lAstConflguntion Dltt: NttM.If_IMtll€S£r i I 
i Current Confi9uretion me: NttM J I 'I 

~~.~~.Addr.u: ___ . ___ ~~~~~ .. _. _____ .. _. L ( ~dll L .. 
j-l_nan I.tarr.:. ----·-·------··-··-·-1 ~SVftC---.-.l 

IIppleTl1 k Zone Name t.tt::I 'I 181 Ruto conng i 
IIppleTllk Net Number 30, i o Remote Boot l 
IIppl,Tllk Node Number ZZO ! ____ ~ ______ ._. __ . __ • ___ ._ •. _J 

1
- t:.herT.n PIIea. 2 .-... -------.•. -, ( Log... ) 

R1I .. stlrt h I R ... End~ I (Options ... ) 

I ETII k Z.O Net Number 0 I I l Reset J 
ETII k Z.O NoW Number 0 [ Zone List... . . 

~ He.p ===-..:::= ... -..... -.-. _. ________ 1 ! Re::art ~ 

L .. __ ._ ... ____ .. _._._ .. _ ... ___ . __ .... _..J [ Plluse ) 

9. Turn on the Remote Boot switch by clicking in the selection 
box. ' 

10. Download K-STAR using the Download a File ... command 
in the File menu. 

11. When K-STAR has been downloaded, click the Go button. 

12. Select Save Configuration File ... from the File menu and 
type a name for the configuration; for example, 

GW1.ETALK1.config 

Click the Save button to save the configuration file to disk. 
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At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 

Log Melillgel: 

~ ~.,::a 220 [Ttl 136 PAOlI 1£\1 4.1 (11110107) STIITE-cowtLDAD UIIlIO I!:! 
• K-STIIR FastPath lIT ....... 220. ET IIDde 1311. ET2.0 NIl 0, ET2.0 _ 
O. 249 buff.,.s (3D f ..... t ........ u. rwlslon 1.0, Option Flags: 17 _18. 

(continue) Print 

These messages indicate that both Option 17 and Option 18 are 
enabled. This means that the gateway is routing AppleTalk 
Phase 1 packets (no AppleTalk Phase 2 packets will be 
processed.) 

Seeding on the Ethernet interface: gateway 2 
This example uses seeding to acquire data from the Ethernet 
interface of gateway 1. After connecting the FastPath to a 
Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration 
window, 

• 
• 
• 
• 

• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click Pause. 
Turn on Options 17 and 18. 
Enter the AppleTalk configuration data for the network on 
the gateway's LocalTalk interface. 
Turn on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 
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This example uses the internet configuration shown in Figure 2-6. 
For your site, you should determine the proper network numbers 
and zone names for the gateway before you configure it. 

Option 17: ON 
Option 18: ON 

LocalTalk Interface Zone Name: tim 
LocalTalk Interface Net Number: 40 

EtherTalk Phase 1 configuration: seeded from gateway 1 

After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 17 and Option flag 18, then click OK to 
close the Options window. 

3. Type tim in the AppleTalk Zone Name field for the 
LocalTalk interface, then press tab. 

4. Type the net number for the LocalTalk interface: 40, then 
press tab. 

5. Turn on the Remote Boot switch. 

1=:..-;:;;" ..... r. "".. ''''' ,;;;;;;;.. 1 r· ..... ~I 
Currently Do",nloeded FIle: bter vlraion 8.0 I i 
Lilt Configuntton DIlle: Tue Aug I. 1989 16:09: I 0 i ,. l Curnnt Configuration Fill: IItIrnw II 
.~ther~~:_. __ 0_8.~089A00008 _._ •• _._ L ( Edit) J 

r-L_ITan '''erfKe ._. ~ r·svttc ... ·-l 
tlppltTelt Zone MIme b I 181 Ruto Conng 
tlppltTllt Nit Number 40 181 Remote Boot 

j AppltT,lt Node Number ZZO L ______ ! 

"Eti;;T;'t PII ... Z "---=l- (Log...) 
Rt"" start II' I Rt .. End ~ ( Option.... ) 
[T.1t 2.0 Net Number 0 [ ] [ Re.et ) 
fTllt 2.0 Node Number 0 Zone Lilt... • 

I (Restllrt) 

[
H.l.-···-······----·-------·--··l ( 60 j 

.. _. ___ .... _._ ....... ___ ... ___ . ___ .. _._ .. ..-l ( Peu.e ) 
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6. Download K-STAR using the Download a File ... command 
in the File menu. 

7. When K-STAR has been downloaded, click the Go button. 
Because you are configuring on an isolated network, you 
may see diagnostic messages warning that the EtherTalk 
Phase 1 interface has not acquired its seed data. These 
messages should no longer appear when the gateway is in 
its permanent location. 

8. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 

Log Massllgas: 

• ICFPS AT" 220 ET8 1311 PIIOI1 REV 4. I <88,10107) STATEooOOIIILOfI) l1li..10 10 
HU STIIT\JSoCI r=-
• K-sTAR F!lStPath AT NIda 220, ET NIda 136, ET2.0 ~t O. ET2.0 node 
0, 249 buffers (30 for .thooMIIIU. MIIIision '.0. OptIon Flags: 17 
- II. • ETII..K1 _. __ nel 10 

(tontinuel Print 

These messages indicate that Options 17 and 18 are turned on 
<the gateway is routing AppleTalk Phase 1 packets), and the 
EtherTalk interface has acquired the Phase 1 net number 10. 

Seeding on the LocalTalk interface: gateway 3 
This example uses seeding to acquire data from the other 
gateway on the LocalTalk interface of the FastPath. After 
connecting the FastPath to a Macintosh via LocalTalk, launch 
the FastPath Manager, and select and open the gateway. 
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• Click the Reset buHon, then open the gateway again. 
• Click Pause. 
• 'I\trn on Options 17 and 18. 
• Select ATalk Phase 1 from the Configuration menu and 

double-click on the ATalk Phase 1 listing in the 
Configuration area. 

• Enter the EtherTalk Phase 1 configuration data. 
• Tum on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
2-6. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

The configuration data for this box is: 

Option 17: 
Option 18: 

ON 
ON 

LoealTalk Interface configuration: seeded from gateway 2 

EtherTalk Phase 1 Zone Name: anat 
EtherTalk Phase 1 Network Number: 11 

After selecting Reset and then Pause, 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 17 and Option flag 18, then click OK to 
close the Options window. 

3. Select ATalk Phase 1 from the Configuration menu and 
double-click on its listing in the Configuration area to bring 
up the EtherTalk Phase 1 dialog box. 

4. Type the zone name in the AppleTalk Zone Name field in 
this dialog box, anat, then press tab. 
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5. Type the net number for the EtherTalk Phase 1 interface: 11, 
then press tab. 

[ 

E1l1erT.U: P .... I ---"----·-------1 
IIppleTllt Zone .me 1ft; I 
IIppleTllt Nd Number I I I 

• IIppl,T,lt Node Number 227 •• "_" •• " •• 
Cllncel rllel ' - •• _]-atwrT,It P ... 1 dI,I" bel(" UN tht. vlndov to lpeclf\l ttw 

f .. tPlth', EttwrTllk P ... I 11m" 

---- '---'--' 

I OK I 

6. Click OK to return to the main configuration dialog box. 

7. Turn on the Remote Boot switch, then download K-STAR 
using the Download a File ... command in the File menu. 

9. When K-STAR has been downloaded, click the Go button. 
Because you are configuring on an isolated network, you 
may see diagnostic messages warning that the LocalTalk 
interface has not acquired its seed data. These messages 
should no longer appear when the gateway is in its 
permanent location. 

10. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to open the Log window: 
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Log Mallagal: 

• ICFPS lIT- 220 ET- 1311 P1IOI'I lIEU 4.1 (88/10/07) STIITE-oC>IIII..OfID UII..1D 
HI! STATUS-o 
• K-STAA F .. tr.th lIT ..... 220, ET ..... 1311, ET2.0 net 0, ETZ.O ..... 
0, 15 buff_ (31) for .thorNoU, ..... 1.1 ... 1.0, Option FI_: 17 
Clftd 18. 
• IITALIC sftdad .. ".t 40 

(contlnuel Print 

These messages indicate that Options 17 and 18 are turned on 
(the gateway is routing AppleTalk Phase 1 packets), and the 
LocalTalk interface has acquired the Phase 1 net number 40. 

You can also check that all of the zones you have entered are 
visible on the internet by opening the Macintosh Chooser: 

Chooler 

~ ~ 
Q I 

II I 
"",10100. L.. ......1I'rtttr 

=t 
(; l_1I'rtttr 

App18TIIlk Zonas: i I U.rNo~ ---
IInlll 
hllrvay I I meredllh 

101 
Ii> Actlva ApplaTlIlk I o Inllcllva 

3.3.1 
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K-STAR AppleTalk management issues 

A gateway should be configured for AppleTalk Phase 2 routing 
to support communication between EtherTalk Phase 2 devices 
and AppleTalk devices on LocalTalk. To update Macintoshes on 
Ethernet, install the EtherTalk Phase 2 software, select the 
EtherTalk icon with double arrows (the double arrows signify 
Phase 2) in the Macintosh Control Panel, and reboot the 
Macintosh. 

If there is a Phase 1 gateway or router on your local Ethernet, 
at least one of the Phase 2 gateways on that Ethernet must be 
configured as a transition bridge. If there is a Phase 1 router 
on your local LocalTalk net (even a LocalTalk-to-LocalTalk 
bridge), all of the Phase 2 gateways on that LocalTalk net must 
be configured as a transition bridge. 

If none of the AppleTalk devices on Ethernet have been 
upgraded to AppleTalk Phase 2 protocol software, you can 
configure the gateway for AppleTalk Phase 1. If you wish to use 
the zone security options, or to add any K-STAR IP or DECnet 
configuration data, you must use the K-STAR implementation 
of AppleTalk Phase 1 (as documented in this chapter) rather 
than the PROM-resident protocols (as described in Appendix E). 

Network ranges and zone lists 
When you are configuring a network range or a zone list on the 
gateway's EtherTalk Phase 2 interface, it is advisable to use the 
smallest range and smallest number of zone names required for 
your network. The gateway uses some memory to store each 
network number and zone name, so if the network range or 
zone list is very large, a lot of the gateway's RAM will be used 
for storage, rather than being used to help route packets. 
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New zone names 
When you are reconfiguring gateways with new zone names, 
the gateway must be off the internet for a full 10 minutes before 
you reboot it with a new zone name. This is required because it 
takes a full 10 minutes (and possibly more, if the internet is very 
large) for the other bridges and gateways on the internet to time 
out the old zone name or names for that network. 

AppleTalk encapsulated in UDP: IPTalk 
When a Macintosh uses an AppleTalk service that exists on an IP 
host ), the gateway encapsulates the AppleTalk packet in IP and 
forwards it to the IP host. The IP host must know how to which 
strips off the IP header and reads the AppleTalk packet; for 
example, it must be running Columbia AppleTalk Protocol 
(CAP) or Apple UNIX File System (AUFS). See "IPTalk 
Configuration" in Chapter 3 for more information. 

For the Macintoshes on Loca1Talk to use the 
CAP or AUFS system, you need to configure 
an "lPTalk interface." See Chapter 3. 
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Zones in 
the Chooser 

How zone 
security works 

K-STAR AppleTalk zone security 
The FastPath running K-STAR supports zone security for 
AppleTalk Phase 1 and Phase 2 intemets. To understand how 
K-STAR zone security works, you need to know how users 
access AppleTalk services in other zones. 

When a Macintosh user selects a zone and an AppleTalk service 
in the Macintosh Chooser, the following events occur: 

• The Macintosh sends a Broadcast Request, which is received 
by the gateway. If there is more than one gateway on the 
local network, the request packet is sent to the gateway 
from which the most recent RTMP packet was received. 

• The gateway sends out an NBP lookup to all devices in the 
selected zone. If the zone is on a remote network, it directs 
the broadcast to the relevant networks. 

• AppleTalk services in the selected zone send NBP reply 
packets back to the Macintosh that originated the request, 
which displays the services' names in the Chooser. If the 
services are on a remote network, the replies are routed 
through one or more gateways to reach the requesting 
Macintosh. 

K-STAR zone security options operate in two ways. 

1. Option 13 is used to hide network services in other zones 
from users on the LocalTalk side of the gateway. This is 
called "Stay in Zone" security. 

When you select Option 13, the gateway drops NBP request 
packets from Macintoshes if the destination zone name (the 
zone name in which the user wishes to see an AppleTalk 
service) and the source zone name (the LocalTalk zone 
name) are different. 

1111" In this case, the LocalTalk zone name of the Macintosh user is 
the source zone (the source of the request packets). The gateway 
connecting that LocalTalk network to the internet needs to have 
Option 13 set. 
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2. Options 14 and 15 are used to protect network services on 
the LocalTalk side of the gateway from other network users. 
Option 14 hides LaserWriters ("LaserWriter security") and 
Option 15 hides any service whose name ends in a tilde 
("TIlde security"). 

When you select Option 14 or 15, the gateway processes all 
NBP reply packets; if the LocalTalk zone name of the gateway 
is one of the zones for the source network, and if the LocalTalk 
zone of the gateway is not one of the zones for the destination 
network, it removes the appropriate entries: devices of type 
"LaserWriter" if Option 14 is set, or entries whose names end 
in a tilde ( - ) if Option 15 is set. IT there are no entries left 
after processing, the gateway drops the packet. 

Note that Options 14 and 15 are recommended only for 
gateways with low network traffic, because it causes 
significant processing overhead. 

1111" In these cases, the LocalTalk zone in which the services reside is 
the source zone name (the source of the reply packets). The 
gateway connecting that LocalTalk network to the internet needs 
to have Option 14 set (ILaserWriter" security) and/or Option 15 
set ("TIlde" security). 
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AppleTalk Phase 1, Option 13: ON 
In this Phase 1 internet, all gateways have Option 13 turned on. 
Macintosh users on LocalTalk nets will be restricted to services 
in their own zone: if that zone name includes another network, 
they will see all services on that network. 

13: ON 
Hides all services outside the "new york" 
zone from users on this LocalTalk net. 
Note that all gateways on the LocalTalk net 
must have Option 13 ON, because 
Broadcast Requests are sent to the gateway 
from which the most recent RfMP packet 
was received. 

13:0N---------/ 

Hides all services outside the "alaska" 
zone from users on this LocalTalk net. 
Because Ethernet is in zone "alaska," all 
services on Ethernet will be visible. 

13: ON 
Hides all services outside the 
"colorado" zone from users on this 
LocalTalk net. 

the "new york" zone from 
users on this Loca1Talk 
net. 

Zone name: new york 

Zone name: alaska 

Figure 2-7. Phase 1 "Stay in Zone" security 
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AppleTalk Phase 2, Option 13: ON 
In this Phase 2 internet, all gateways have Option 13 turned on. 
Macintosh users on LocalTalk nets will be restricted to services 
in their own zone: if that zone name is included in the EtherTalk 
Phase 2 zone list on another network, they will see only the 
services registered in their zone. 

Zone name: colorado 
Hides all services outside the 

l~ON -=::~::::~~==~--~~~~::~L-~iJ~~~ __ ~~~-----l~ON 
Hides all services outside the "new Hides all services 
york" zone from users on this outside the "new york" 
LocalTalk net. Note that all zone from users on this 
gateways on the LocalTalk net must LocalTalk net. 
have Option 13 ON, because 
Broadcast Requests are sent to the 
gateway from which the most recent 
R1MP packet was received. 

I 
I 

Zone list: hawaii 
florida 
new york 

l~ON --------------------------------------------~ Zone name: texas 
Each of these gateways hides services outside the zone on 
the LocalTalk net. Because servers are registered in only 
one zone, a server on the EtherTalk Phase 2 zone will be 
visible if it is registered in the same zone as the LocalTalk 
zone. 

I 
I 
I 

Zone list: alaska 
texas 
califomia 

Figure 2-8. Phase 2 "Stay in Zone" security 
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AppleTalk Phase 1, Option 14: ON 
In this Phase 1 internet, all gateways have Option 14 turned on. 
LaserWriters on LocaITalk nets will be hidden from users in 
other zones; if the zone name includes another network, all 
users on that network will be able to access those LaserWriters. 

14: ON 
LaserWriters on this Loca1Talk net are 
protected from users outside the "new 
york" zone. 

Zone name: alaska 

14: ON ________ -J 

LaserWriters on this net are protected 
from users outside the "alaskaN zone. 
Because Ethernet is in zone "alaska, N all 
users on Ethernet will be able to access 
LaserWriters on this net. 

14: ON 
LaserWriters on this LocalTalk net 
are protected from users in other 

Zone name: new york / 

U:ON ~ 
No effect in this particular 
network configuration. If 
Loca1Talk nets in other 
zones were connected to this 
Ethernet, this gateway 
would protect the 
LaserWriter from those 
users. 

Zone name: new york 

Zone name: alaska 

Figure 2-9. Phase l"LaserWriter" security 
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AppleTalk Phase 2, Option 14: ON 
In this Phase 2 internet, all gateways have Option 14 turned on. 
LaserWriters on LocalTalk nets will be hidden from users in 
other zones; if that zone name is included in the EtherTalk Phase 
2 zone list on another network, users on that Ethernet will be 
able to access those LaserWriters. 

Zone name: colorado 

14:0N 

14: ON 
LaserWriters on this LocalTalk net 
are protected from users in other 

-1---- 14: ON 

Hides the LaserWriters on this net from 
users in "colorado." Because the 
EtherTalk Phase 2 zone list includes 
"new york," all users on this Ethernet 
will be able to access the LaserWriter in 
IInewyork." 

~~J:=:3-.l:=U;;;;;;;;;;;;;;;~-;~-j Protects the LaserWriters 

I 
Zone list: hawaii 

florida 
new york 

14: ON ----------------------~ 
LaserWriters on these 3 LocalTalk nets are hidden from 
users on the left side of the internet (in the "new york," 
''hawaii,'' "florida," or "colorado" zones). Because the zone 
names of these LocalTalk nets are all elements in the 
EtherTalk Phase 2 zone list, all users on this Ethernet will 
have access to the LaserWriters. 

I 
I 
I 

on this LocalTalk net 
from users on the right 
side of the internet (in 
the "california," 
"alaska," or "texas" 
zones). 

Zone name: texas 

Zone list: alaska 
texas 
california 

Figure 2-10. Phase 2 IJLaserWriter" security 
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AppleTalk Phase 1, Option 15: ON 
In this Phase 1 internet, all gateways have Option 15 turned on. 
AppleTalk services whose names end in tilde (-) on LocalTalk 
nets will be hidden from users in other zones; if the zone name 
includes another network, all users on that network will be able 
to access those services. 

15: ON 
AppleTalk services whose names end in 
tilde on this LocalTalk net are protected 
from users outside the "new york" zone. 

15: ON ---------./ 

AppleTalk services whose names end in 
tilde on this net are protected from users 
outside the "alaska" zone. Because 
Ethernet is in zone "alaska," all users on 
Ethernet will be able to access a service 

15: ON 
AppleTalk services whose names 
end in tilde on this LocalTalk net are 

Zone name: new YO)! 
15: ON ' 
No effect in this particular 
network configuration. H 
LocalTalk nets in other 
zones were connected to this 
Ethernet, this gateway 
would protect the AppleTalk 
services from those users. 

Zone name: new york 

on this net, regardless of the service's Zone name: alaska 
name. 

Figure 2-11. Phase 1 "Tilde" security 
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AppleTalk Phase 2, Option 15: ON 
In this Phase 2 internet, all gateways have Option 15 turned on. 
AppleTalk services whose names end in tilde (-) on LocalTalk 
nets will be hidden from users in other zones; if that zone name 
is included in the EtherTalk Phase 2 zone list on another 
network, users on that Ethernet will be able to access those 
services. 

Zone name: colorado 

15: ON 
AppleTalk services whose names 
end in tilde on this LocalTalk net are 
protected from users in other zones. 

15:0N ~==~~~~~~~=-~~~~::~L-~iJ~~~ __ ~fj:------1S:0N 
AppleTalk services whose names end in Protects AppleTalk 
tilde on this net are protected from users services whose names 
in "colorado." Because the EtherTalk end in tilde on this 
Phase 2 zone list includes "new york," LocalTalk net from users 
all users on this Ethernet will be able to on the right side of the 
access the services in "new york," internet (in the 
regardless of the services' names. "califomia," "alaska," or 

I 
Zone list: hawaii 

florida 
new york 

"texas" zones). 

15:0N ------------------------------------------~ Zone name: texas 
AppleTalk services whose names end in tilde on these 3 
LocalTalk nets are hidden from users on the left side of the 
internet (in the "new york," "hawaii," "florida," or 
"colorado" zones). Because the zone names of these 
LocalTalk nets are all elements in the EtherTalk Phase 2 
zone list, all users on this Ethernet will have access to those 
services. 

I 

Zone list: alaska 
texas 
california 

Figure 2-12. Phase 2 "Tilde" security 
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c H A p T E R 3 

K-STAR IP Configuration 

THIS CHAPTER EXPLAINS HOW TO CONFIGURE THE FASTPATH ON IP 

networks or subnets using the IP protocols contained in the 

K-STAR gateway program. K-STAR IP is derived from the 

Kinetics Internet Protocol (KIP> implementation developed at 

Stanford University, which provides a number of convenient IP 

addressing and routing features for the FastPath gateway. 

• Automatically calculates the appropriate IP subnet mask 
and broadcast address 

• Uses RIP packets and ICMP redirects in routing 
• Manages a range of IP addresses for Macintoshes 

• Supports IPTalk (UDP encapsulation of AppleTalk packets, as 
used by Columbia AppleTalk Protocols (CAP) and Apple 

UNIX File System (AUFS) systems> 

• Can acquire configuration data from the UNIX atalkad 
daemon. 
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If you are new to IP intemets 
This section reviews basic IP addressing conventions for the 
network administrator who has not usd IP addressing before. 
K-STAR automatically determines the correct IP subnet mask (if 
one is in use on Ethernet) and the correct IP broadcast address. 

IP addresses 
An IP address is a 4-byte number that uniquely identifies a host 
on the IP network. It is composed of a network number (which 
is always the same for every host on a network) and a host 
number (which must be unique for each host on a network). IP 
addresses are assigned to each computer by appending a unique 
host number to the network number. 

IP network numbers are managed and assigned by the DDN 
Network Information Center (NIC), SRI International, 333 
Ravenswood Avenue, Menlo Park, CA 94025. If the IP internet at 
your site needs to communicate with any other IP network that is not 
directly under your administration, you must acquire an official IP 
network number from the above address. 

The 4-byte IP address can be written in "decimal dot" or 
hexadecimal notation, depending on which you are more 
comfortable with. The following is an IP address expressed in 
both notations: 

Decimal dot notation 
130.57.64.1 

Hexadecimal notation 
8239401 

IP network numbers are divided into class A, class B, and class 
C numbers as shown in Figure 3-1. The network class 
determines how many bytes of the address represents the 
network number, and what the value of the first byte will be. 
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Network Host 
, ~ ... 

Class A 1 1-127 1 0-255 0-255 0-255 

Network Host 
.. 

Class B 1128-1911 0-255 0-255 0-255 

Network Host 
, 

ClassC 1192 - 254 1 0-255 0-255 1 0-255 1 

Figure 3-1. IP network numbers as assigned by NIC 

For example, "130.57" is a class B Internet number, because the 
network number is 2 bytes with the value of the first byte 
between 128 and 191. 

When you assign an IP address to a device, you can append any 
host number that is not already used by another device. The 
host number part of the IP address must be unique on the IP network. 
At most sites, IP addresses are maintained and assigned by one 
network administrator, and they must be acquired from her. 

IP subnets 
An IP subnet is a logical sub-section of an IP network. Subnets 
are only seen internally at a site; external IP networks see the IP 
network as one entity. A subnet has the same IP network 
number as the rest of the network, but applies a "subnet mask" 
that defines a fixed-length portion of the host portion of the 
address as a "subnet number." The "default subnet mask" 
defines the actual network portion of the address (as shown in 
Figure 3-1) as the network number; that is, it does not add any bits. 

An IP subnet mask is a 4-byte number that contains only I-bits 
and O-bits: the I-bits always represent the network portion of 
the address and O-bits represent the host portion of the address. 
Net masks can also be specified in hexadecimal or decimal dot 
notation. 

For example, for the class A IP address 18.192.127.51 with a 
subnet mask of FFFFOOOO (255.255.0.0 in decimal), the second 
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byte of the address will be interpreted as a subnet number. All 
hosts residing on the same subnet as host 18.192.127.51 will use 
"18.192" as the network portion of their IP address. 

Network Host 
; , #' 

Class A I 18 192 127 I 54 

subnetmask I: 2SS·:: .... :·,:.<· 25s·:·;::·:1 0 I 0 I 
(in binary) 111111111111111111111111111111111<¥~<E#I9opP~ 

Results in: 

Network Subnet Host 

--"--..... ----., -p ~----

192 127 54 Class A subnet I 18 
~----~----~----~----~ 

Figure 3-2. IP Subnetting: Class A 

For a class B IP address 137.57.64.163, with a subnet mask of 
FFFFFFOO (255.255.255.0 in decimal), the third byte of the 
address will be interpreted as the subnet number. All hosts 
residing on the same subnet as host 137.57.64.163 will use 
"137.57.64" as the network portion of their IP address. 

Network Host 

Class B 137 57 64 163 I 
subnet mask 1::::::::::::::*=I:::::::::::J:::::::::::::::~jj::::::)d::::::::t~~~:::::::::):] 0 I 
(in binary) 1111111111111111111111111111111111111111111111111901OIOI9~~ 

Results in: 

Network Subnet Host 
, ; 

Class B subnet 137 57 64 I 163 

Figure 3-3. IP Subnetting: Class B 
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For a class C IP address 210.167.3.250, with a subnet mask of 
FFFFFFCO (255.255.255.192 in dedmal), 2 bits of the fourth byte 
of the address will be interpreted as a subnet number. All hosts 
residing on the same subnet as host 210.167.3.250 will use 
"210.167.3.3" as the network portion of their IP address. Only the 
last 6 bits will be interpreted as the host number; in this 
example, the host number is 58. 

Network Host 

ClassC 210 167 3 250 

subnet mask li:::i:i:~::ii:lji:i~::::i::iJ:::::::i:ii:::i:g!i::iiii:i:i::[::::i:i:::iIM::ii:i:::::::::E::iii::1192 
(in binary) 111111111111111111111111111111111111111111111111111119¥Iqo§ 

Results in: 

Network 

Figure 3-4. IP Subnetting: Class C 

Subnet number = 3 

Host number = 58 

1111" K-STAR automatically acquires the correct subnet mask by 
sending out request packets on the IP network. If the 
Ethernet/IP network has been subnetted, it assumes the same 
subnet mask in use on Ethernet; otherwise it assigns the 
"default" subnet mask for the network class of the IP network 
the gateway is on, which effectively defines no subnet at all. 
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IP broadcast addresses 
The Internet broadcast address is an address understood by all 
hosts on a local network as a special address for broadcast 
packets (i.e., packets that should be received and processed by 
all IP hosts on the local network.) By default, the gateway uses 
the industry standard broadcast address with all 1 bits in the 
host number. 

Class B net number 137 57 64 163 L-____ -L ______ ~ ____ ~ ____ ~ 

IP broadcast address 1-1 __ 1_3_7 __ .L..-__ 57 __ ~ ___ 25_5 __ -,--__ 2_55-.l 

Figure 3-5. IP broadcast address with no subnet 

If you have partitioned the network into subnets, the broadcast 
address uses the subnet mask to limit broadcasts to the local 
subnet. It is not possible to extend broadcasts to another 
network. 

Class B net number 137 57 64 163 

subnetmask o 

IP broadcast address 1-1 __ 1_3_7 __ ~ __ 5_7 __ -'--__ 6_4 __ -'--__ 2_55 __ --' 

Figure 3-6. IP broadcast address with sub netting 

1111" K-STAR automatically assigns the correct IP broadcast address 
based on the IP address of the gateway, the subnet mask it has 
acquired, and the state of Option 4. If the gateway is connected 
to a subnet that supports 4.2BSD-compatible devices, you need 
to turn on Option 4. This tells K-STAR to use a broadcast 
address with all as in the host portion of the address. 
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Required K-STAR IP data 

When you are supplying IP addresses using K-STAR, there are 
two goals: 

1. Configuring the gateway so it can communicate with other 
entities on the IP network on Ethernet. 

2. Assigning an IP address range that the gateway will 
administer for client Macintoshes. 

The client Macintoshes running 
TO> lIP software can be on a 
connected LocalTalk network, or 
can be distributed across LocalTalk 
and Ethernet. 

The gateway is a host on the 
existing Ethemet/IP network, and=--_________ -r~ 
administers IP addresses for all 
client Macintoshes. 

Figure 3-7. K-STAR IF configuration 

Configuring the gateway as an IP host 
To communicate with other entities on the Ethernet/IP network, 
the gateway needs the following data: 

• A unique IP address on the existing IP network. You supply 
this address in the K-STAR IP dialog box using the FastPath 
Manager. 

• An IP network number. The gateway derives this from the 
IP address you supply and the subnet mask. 

• An IP subnet mask. The gateway acquires the correct 
subnet mask as follows: 

Using the ICMP protocol, it acquires the subnet mask in 
use on the Ethernet/IP network. 

K-STAR IP Configuration 3-7 



If ICMP does not provide a subnet mask, it checks for a 
configured subnet mask (that is, one that you entered). 

If the gateway still does not find a subnet mask, it 
calculates a default subnet mask. The default subnet 
mask does not define any subnet portion; it masks out 
the actual network portion of the IP address based on 
the class of the IP network number (the value of the first 
byte). For example, if the IP network number is class B, 
the default subnet mask is FFFFOOOO (255.255.0.0). 

• An IP broadcast address. By default, the gateway derives 
the broadcast address from the IP address you supply and 
the subnet mask, and uses the standard broadcasting 
method (all Is in the host number). If you need to use 4.2 
BSD-compatible IP broadcasting (all Os in the host number), 
tum on Option 4 in the FastPath Manager. 

Client Macintosh IP addresses 
To administer a range of IP addresses for client Macintoshes, the 
gateway needs the following data: 

• A decimal number indicating the number of client 
Macintoshes that will be statically assigned an IP address. 
You supply this data in the K-STAR IP dialog box using the 
FastPath Manager. 

• A decimal number indicating the number of client 
Macintoshes that will dynamically acquire an IP address as 
they boot up on the IP network. You supply this data in the 
K-STAR IP dialog box using the FastPath Manager. 

• An IP address indicating where the range of client IP 
addresses should start. By default, the gateway uses its own 
address + 1. If Option 9 is set, you can supply this address in 
the K-STAR IP "More" dialog box. 

In all cases, the Macintosh IP addresses are a contiguous range 
starting at a specified address. The number of addresses in the 
range must be less than or equal to 60, which is the number of 
clients you specify as "static addresses" plus the number you 
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specify as "dynamic addresses," with the low end of the range 
used as static IP addresses. 

The client Macintosh IP addresses can be configured as follows: 

1. The client IP addresses can be on the existing Ethernet/IP 
net. The range of Macintosh IP addresses then starts at the 
gateway address + 1. (This is the default IP configuration 
method.) 

2. The client IP addresses can be on the existing Ethernet/IP 
net, but the starting point is an IP address that you supply 
separately from the gateway IP address. Option 9 must be 
ON. 

3. The client IP addresses can be on a different IP network from 
the existing Ethernet/IP net. In this case, you supply a 
second IP address for the gateway as a host on the new IP 
network. The range of Macintosh IP addresses starts at the 
second gateway address +1. The gateway then sends out 
RIP packets to inform other routers about the existence of 
the new network. Option 9 must be ON. 

1111. The K-STAR IP software supports up to 60 IP addresses in the 
range managed by the gateway for client Macintoshes. 
Provided that you have an unused block of addresses, you can 
assign a greater number of IP addresses than you need in the 
Number of Oients" area. This will allow you to add client 
Macintoshes without reconfiguring the gateway at a future date. 

Example K-STAR IP configurations 

The example K-STAR IP configurations in the sections that 
follow all use variations on the same data. The gateway is 
configured as a host on an Ethernet/IP net 130.57.64.0, which is 
subnetted with the netmask 255.255.255.0 (FFFFFFOO) so the 
third byte of the address is the subnet number. In this case, the 
subnet mask in use on the Ethernet interface will automatically 
be applied; there is no need to supply it in the K-STAR IP 
configuration. 
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The example configurations show four different ways to manage 
client IP addresses: 

1. As a range of IP addresses contiguous with the gateway's IP 
address on the existing IP net 130.57.64.0 (the "default 
configuration"). 

2. As a range of IP addresses that are noncontiguous with the 
gateway's IP address (a "noncontiguous address range"). 

3. As a separate IP network, with the gateway configured .as a 
host on that network, as well as on the existing IP net (lithe 
gateway managing a separate network"). 

4. As a range of IP addresses contiguous with the gateway's IP 
address on the existing IP net 130.57.64.0, but where the 
Macintosh clients are distributed on the gateway's LocalTalk 
interface, Ethernet interface, and on a separate LocalTalk 
network connected to the gateway across Ethernet 
("distributing Macintosh clients"). 

See "Changing Configuration Data" in Chapter 1 if you are 
modifying an existing K-STAR IP configuration. 

See "K-STAR IP Management Issues" at the end of this chapter 
for information on assigning these IP addresses to Macintoshes. 

The default K-STAR IP configuration 
Figure 3-8 shows an example IP internet configuration using 
K-STAR IP. The gateway is configured as a host on the 
Ethernet/IP subnet 130.57.64.0. The client Macintoshes are seen 
as IP hosts on the existing network, and a block of free addresses 
on that net must be allocated for them. The range of nine 
Macintosh IP addresses will start at the gateway address + 1. 
(This is the default IP configuration method.) 
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LocalTalk network supporting 9 Macintoshes 
running TCP lIP software. 

IPdata: 
IP Address of FastPath Box: 
(Clients) Dynamic: 

130.57.64.5 
5 

(Clients) Static: 

4---~~~~I~;-~E~ 

Ethernet/IP network: 130.57.64.0, subnet 
mask 255.255.255.0 (FFFFFFOO). 

Figure 3-8. A default K-STAR IP configuration 

The following IP addresses will be available for static 
assignment to client Macintoshes: 

130.57.64.6 
130.57.64.7 
130.57.64.8 
130.57.64.9 

Note that the static addresses begin at the gateway address +1. 
The following IP addresses will be available for client 
Macintoshes to acquire dynamically as they boot up on the IP 
network: 

130.57.64.10 
130.57.64.11 
130.57.64.12 
130.57.64.13 
130.57.64.14 

1111. The entire range of client IP addresses cannot be duplicated 
anywhere on the IP internet. 
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In configuring the gateway, you should follow the general 
procedure described in Chapter 1. After connecting the gateway 
to a Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration dialog 
box, 

• Click the Reset button, then open the gateway again. 
• Click the Pause button. 
• Enter the AppleTalk configuration data; see Chapter 2. 
• Select K-STAR IP from the Configuration menu and 

double-click on the K-STAR IP listing in the 
Configuration area. 

• Enter the IP address of the FastPath Box. 
• Enter the number of client Macintoshes controlled by the 

gateway. 
• Turn on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
3-8. For your site, you should determine the proper IP address 
and number of Macintosh clients before you configure the 
gateway. 

IP Address of FastPath Box: 
(Clients) Dynamic: 
(Clients) Static: 

130.57.64.5 
5 
4 

After selecting Reset and then Pause, enter the AppleTalk 
configuration you require, as described in Chapter 2. Then 
proceed with the IP configuration: 

1. Select K-STAR IP from the Configuration menu and double
click on K-STAR IP in the Configuration area to open the IP 
dialog box. 

2. Type the gateway's IP address in the IP Address of the 
FastPath Box field: 130.57.64.5, then press tab. 
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3. Double-click in the Dynamic field in the "Number of IP 
Clients" area, and type the number of client Macintoshes 
that will dynamically acquire IP addresses from the 
gateway: 5, then press tab. 

4. Type the number of client Macintoshes that will be assigned 
static IP addresses administered by the gateway: 4, then 
press tab. The total number of clients supported by a 
gateway must be less than or equal to 60. 

5. Click OK to return to the main dialog box. 

6. Turn on the Remote Boot switch by clicking in the selection 
box. 

7. Select Download a File ... from the File menu and open 
K-STAR. 

8. Click Go to send the configuration data to the gateway. 

9. Select Save Configuration File ... from the File menu and 
type a name for the configuration; for example, 

KSTAR-IP.config 

Click the Save button to save the configuration file to disk. 
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At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to access the diagnostic messages from the gateway. 
The Log window contains a static version of the most recent 
messages from the gateway that is currently open. 

Log Messagel: 

• KFPS Are 220 Ere 136 PIIOIt AEV 4. I (88/10/0?) STATE-IlOImLOllD VALID 
III STATUS-O 
• K-5TM Fastpath RT node 220, ET node 136, ET2.D net 65280, ET2.D 
node 136, 85 burr .... (3D for athemaU, ..... I.ion UDBDDa2, Option 
Flags: ... "". 
• ETRU<Z sa._ as 1"01"9' I - 10, ...... c:ho5. ..t I 

ncontinue]1 Print 

This message indicates that the gateway has come up on the 
internet with no option flags set. The "ETALK2" message is 
described in Chapter 2 (and Appendix C). No IP error messages 
are showing in this window, so you can check the configuration 
as described in Chapter 1. See Appendix C for a description of 
IP error messages that could appear here. 

Using a noncontiguous IP address range: 
Jlsplit addressing" with Option 9 
In the example configuration shown in Figure 3-9, the gateway 
is configured on the Ethernet/IP subnet 130.57.64. The client 
Macintosh IP addresses will be allocated as a range that is 
noncontiguous with the gateway's IP address. Option 9 must be 
ON. 
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LocalTalk network supporting 9 Madntoshes 
running TCP lIP software. The IP adares ........ ~ 
for these Macs will begin at at a separate 
(noncontiguous) address on the same IP 
network. 

IP data: 
Option 9: 
IP Address of FastPath Box: 
local Parameter #1 : 
(Clients) Dynamic: 
(Clients) Static: 

Ethemet/IP network: 130.57.64.0, subnet 
mask 255.255.255.0 (FFFFFFOO). 

Figure 3-9. Using a noncontiguous range of client addresses 

Note that the client addresses begin with the Local Parameter #1 
address, not the Local Parameter address + 1. The following IP 
addresses will be available for static assignment to client 
Macintoshes: 

130.57.64.50 
130.57.64.51 
130.57.64.52 
130.57.64.53 

The following IP addresses will be available for client 
Macintoshes to acquire dynamically as they boot up on the IP 
network: 

130.57.64.54 
130.57.64.55 
130.57.64.56 
130.57.64.57 
130.57.64.58 

1111'" This entire range of addresses cannot be duplicated anywhere 
on the IP internet. 
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In configuring the gateway, you should follow the general 
procedure described in Chapter 1. After connecting the gateway 
to a Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration dialog 
box, 

• Click the Reset button, then open the gateway again. 
• Click the Pause button. 
• Enter the AppleTalk configuration data; see Chapter 2 • 
• , Turn on Option 9 in the Options window. 
• Select K-STAR IP from the Configuration menu and 

double-click on the K-STAR IP listing in the 
Configuration area. 

• Enter the IP address of the FastPath Box. 
• Click More. 
• In the Local Parameters field #1, type the IP address that 

will be the starting point of the client IP address range. 
• Enter the number of client Macintoshes controlled by the 

gateway. 
• Turn on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 3-9. 
For your site, you should determine the proper IP addresses for 
the gateway before you configure it. 

Option 9: 
IP Address of FastPath Box: 
Local Parameter #1 : 
(Clients) Dynamic: 
(Clients) Static: 

ON 
130.57.64.5 
130.57.64.50 
5 
4 

After selecting Reset and then Pause, enter the AppleTalk 
configuration you require, as described in Chapter 2. Then 
proceed with the IP configuration: 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 
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2. Turn on Option flag 9 by clicking in the selection box next to 
the number 9 (an X appears in the selection box when the 
option flag has been turned on), then click OK to close the 
Options window. 

rl'PU •• FI ... ·-· 

1 ~~ r rr 
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18 2' 
II It 27 
12 20 28 
II 21 29 

j 14 22 10 I 1& 2J II 
1& 24 12 

rl'pti •• Puemetu;· 
po 00 00 DO DO DO 00 DO o Rstll 00 DO 00 DO DO DO 00 DO 
00 DO 00 00 00 DO 00 00 
00 DO DO DO DO DO 00 DO (i) HeHIl 

.... - -_._-

tll",:.I) 

OK I 

···--·l 
~~~~1D1l11 r"-·---···-------J 

3. Select K-STAR IP from the Configuration menu and double
click on K-STAR IP in the Configuration area to open the IP 
dialog box. 

4. Type 130.57.64.5 in the IP Address of the FastPath Box field, 
then press tab. This will be the gateway's IP address on the 
existing Ethernet/IP network. 

5. Click More to open up another dialog box. 

6. Tab twice to position the cursor in the Parameter #1 field 
and type the IP address that will be the starting point for the 
client IP addresses: 130.57.64.50, then press tab. 
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Cancel 

OK I 

7. Click OK to return to the previous dialog box. 

8. Double-click in the Dynamic field in the "Number of IP 
Clients" area, and type the number of client Macintoshes 
that will dynamically acquire IP addresses from the 
gateway: 5, then press tab. 

9. Type the number of client Macintoshes that will be assigned 
static IP addresses administered by the gateway: 4, then 
press tab. 

[ 

IP l.f.r_U.. -- -., c .... r., IP Clint. -.--, 

IPllddr .... fF .. tP.thBox 130'57'64'5~ Dynamic ILJ I 
IP Subnl"".rk MIlk 0.0.0.0 ! 
IP Bnldc." Adclr... 0.0.0.0 Stltle ~ i 
IP IIddren of Deflult R.uter 0.0.0.0 __________ -.J _ ..... __ .. ---_ .. _._-------

[ More ... ) 
r-AII.tnt.tAtor ------ --I 

I P IIddrlllOr IIdmt nt"rotor Host 10.0.0.0 ! l ........ ___ .......... ____ . ___ ... ____________ . _____ . __ j 
r IPT.n: I.terf.co 1 
I AppllTal k lor. Name '* I I AppllTalk Nltvork Numbir 0 I 

AppleTllk ~~~~~!. ____ O ________ . ________ .J CeRcel r Hel, ·-·-·-·-·---·--·-----·---·----------·--·1 
L. _____ ._._ _ __________ J CEJ 

10. Click OK to return to the main dialog box. 

3-18 FastPath Administrator's Guide 



11. Turn on the Remote Boot switch by clicking in the selection 
box. 

12. Select Download a File ... from the File menu and open 
K-STAR. 

13. Click the Go button. 

14. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to access the diagnostic messages from the gateway. 

Log Meuages: 

• KFPS RT- 220 ET- 130 PROM REV 4.1 <11,,0107) STR~ORO Ufl..10 
HI! STRTUS-o 
• K-STM FlIStI'1Ith AT nocIto 220, ET no.... 136, ET2. 0 Nt 115280, ET2. 0 
...... 136, 15 bwffrs (30 for .!Mr.-t>, ..... 1.lon U08OOCI2, Option 
FI_: !I. 
• ETRLIC2 ....... d _ Nln!l1I I - 10, and c:hase .. t , 

(continue) Print 

This message indicates that the gateway has come up on the 
internet with Option 9 set, so the split addressing feature is in 
effect. No IP error messages are showing in this window, so you 
can check the configuration as described in Chapter 1. See 
Appendix C for a description of IP error messages that could 
appear here. 
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The gateway managing a separate IP network: 
"Split addressing" with Option 9 
In the example configuration shown in Figure 3-10, the gateway 
is configured as a host on the Ethernet/IP subnet 130.57.64.0, 
and as a host on a separate class C IP network 192.85.6.0. The 
client Macintoshes are seen as IP hosts on the separate IP 
network. 

As a side effect of this configuration method, other IP routers 
need to be informed about the existence of the new network. If 
routers on the internet support the Routing Information Protocol 
(RIP), they will automatically be informed by the RIP packets 
sent out by the gateway. If RIP is not supported on the 
internet, you need to update the routing tables on other hosts. 

The client Macintosh IP addresses are contiguous with the 
gateway's IP address on the new IP network; the block of free 
addresses begins at the IP address specified in the Local 
Parameter #1 field + 1. Option 9 must be ON. 

LocalTalk network supporting 9 Madntoshes 
runrting TO' /IP software. These Madntoshes 
wi! be hosts on a class C IP network 
192.85.6.0, which is entirely administered 
within the gateway. 

IP data: 
Option 9: 
IP Address of FastPath Box: 
Local Parameter #1 : 
(Clients) Dynamic: 
(Clients) Static: 

ON 
130.57.64.5 ==7----is;~ 
192.85.6.1 
5 
4 

Ethernet/IP network: 130.57.64.0, subnet 
mask 255.255.255.0 (FFFFFFOO). 

Figure 3-10. A separate IP network managed in the gateway 

3-20 FastPath Administrator's Guide 



The following IP addresses will be available for static 
assignment to client Macintoshes: 

192.85.6.2 
192.85.6.3 
192.85.6.4 
192.85.6.5 

Note that these begin at the Local Parameter #1 address +1. 
Because you are using a separate IP network number, the 
address specified in the Local Parameter #1 field is used as the 
gateway's address on the new network. 

The following IP addresses will be available for client 
Macintoshes to acquire dynamically as they boot up on the IP 
network: 

192.85.6.6 
192.85.6.7 
192.85.6.8 
192.85.6.9 
192.85.6.10 

1111" This entire range of addresses cannot be duplicated anywhere 
on the IP internet. In addition, there can be no IP hosts on this 
IP network other than the gateway and its clients. 

In configuring the gateway, you should follow the general 
procedure described in Chapter 1. After connecting the 
gateway to a Macintosh via LocalTalk, launch the FastPath 
Manager, and select and open the gateway. In the main 
configuration dialog box, 

• 
• 
• 
• 
• 

• 
• 

Click the Reset buHon, then open the gateway again. 
Click the Pause buHon. 
Enter the AppleTalk configuration data; see Chapter 2. 
Turn on Option 9 in the Options window. 
Select K-STAR IP from the Configuration menu and 
double-click on the K-STAR IP listing in the 
Configuration area. 
Enter the IP address of the FastPath Box. 
Click More. 
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• 

• 

• 
• 
• 
• 

In the Local Parameters #1 field, type the IP address that 
will be the gateway's address on the new IP network. 
Enter the number of client Madntoshes controlled by the 
gateway. 
Turn on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
3-10. For your site, you should determine the proper addresses for 
the gateway before you configure it. 

Option 9: 
IP Address of FastPath Box: 
Local Parameter #1 : 
(Clients) Dynamic: 
(Clients) Static: 

ON 
130.57.64.5 
192.85.6.1 
5 
4 

After selecting Reset and then Pause, enter the AppleTalk 
configuration you require, as described in Chapter 2. Then 
proceed with the IP configuration: 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 9 by clicking in the selection box next to 
the number 9 (an X appears in the selection box when the 
option flag has been turned on), then click OK to close the 
Options window. 

,..Dpti •• n.,.--------------_·-

~ I ~' ~ 17 ~2& 2 10 I. 26 
I II 19 27 
.. 12 20 28 
& II 21 29 
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3. Select K-STAR IP from the Configuration menu and double
click on K-STAR IP in the Configuration area to open the IP 
dialog box. 

4. Type 130.57.64.5 in the IP Address of the FastPath Box field, 
then press tab. This will be the gateway's IP address on the 
existing Ethernet/IP network. 

5. Click More to open another dialog box. 

6. Tab twice to position the cursor in the Parameter #1 field, 
and enter an IP address using a separate IP network 
number: 192.85.6.1, then press tab. 

-Serv.rII Bl 
IP AdcIrua of Mime Serwr 10.0.0.0 I 
IP AdcIren ofFile Serwr 0.0.0.0 == ( CaRtel 

:- L_I Pu.lMtlrll 

Perimeter -I 
Peremeter -2 
Poremeter ., 

Perameter - 4 

I-:-"~_~. - I OK I 
192.85.6.1 
p •• 
0.0.0.0 
0.0.0.0 

7. Click OK to return to the previous dialog box. 

8. Double-click in the Dynamic field in the ''Number of IP 
Clients" area, and type the number of client Macintoshes 
that will dynamically acquire IP addresses from the 
gateway: 5, then press tab. 

9. Type the number of client Macintoshes that will be assigned 
static IP addresses administered by the gateway: 4, then 
press tab. The total number of clients supported by a 
gateway must be less than or equal to 60. 
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10. Click OK to return to the main dialog box. 

11. Tum on the Remote Boot switch by clicking in the selection 
box. 

12. Select Download a File ... from the File menu and open 
K-STAR. 

13. Click the Go button. 

14. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, select and open the gateway, and check the 
log messages. 

Distributing Macintosh clients: Option 7 
In the example configuration shown in Figure 3-11, the gateway 
at the top of the Figure will administer IP addresses for 
Macintoshes on both LocalTalk networks and for the Macintosh 
on Ethernet. Turning on Option 7 in the FastPath Manager 
allows the gateway to administer IP addresses for Macintoshes 
connected directly to Ethernet or to a different LocalTalk 
network connected to the gateway over Ethernet, provided all 
the Macintoshes are in the same AppleTalk zone. 

1111., All of the Macintoshes administered by one gateway must be in 
the same AppleTalk zone, which must be the zone name 
configured on that gateway's LocalTalk interface. If a Macintosh 
is on the gateway's EtherTalk Phase 2 interface, the LocalTalk 
zone must be included in the EtherTalk Phase 2 zone list and 
must be selected in the Macintosh Control Panel. This method 
of managing client addresses cannot be used if there is more 
than one gateway configured for K-STAR IP in the same 
AppleTalk zone. 
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1111" When you use the gateway to administer IP addresses for 
Macintoshes on Ethernet, the Macintosh's performance on the 
network will be reduced, since all traffic from that Macintosh 
must go through the FastPath. If the internet supports a BOOTP 
or RARP server, you should use that to acquire the Macintosh IP 
address instead. See "Macintoshes on EtherneY' at the end of 
this chapter for more information. Any of the three addressing 
methods shown in the previous examples in this (:hapter (see 
Figures 3-8, 3-9, and 3-10) can be used in conjunction with 
Option 7 to allow the gateway to administer addresses for 
clients on more than one physical network. In this example, we 
use the default K-STAR IP addressing method shown in Figure 
3-8. 

1111" Option 7 cannot be used together with Option 8. 

These Madntoshes will be managed by the 
K-STAR IP gateway. 

This gateway will administer all IP addresses for 
TCP lIP Macs shown in this picture. 

IPdata: 
Option 7: 
IP Address of FastPath Box: 
(Clients) Dynamic: 
(Clients) Static: 

ON 
130.57.64.5 
5 
4 

This Macintosh must be in the same 
AppleTaik zone as the Macs on the gateway's 
Loca1Talk interface. 

These Madntoshes must be in the same ---------' 
AppleTaik zone as the Macs on the K-STAR 
IP gateway's LocalTaik interface. 

name must be the same as the 
LocaITalk zone name on the K-STAR 
IPgateway. 

Figure 3-11. Distributed Macintosh clients 
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Note that in this example, the client addresses begin with the 
gateway address +1. The following IP addresses will be 
available for static assignment to client Macintoshes: 

130.57.64.6 
130.57.64.7 
130.57.64.8 
130.57.64.9 

The following IP addresses will be available for client 
Macintoshes to acquire dynamically as they boot up on the IP 
network: 

130.57.64.10 
130.57.64.11 
130.57.64.12 
130.57.64.13 
130.57.64.14 

In configuring the gateway, you should follow the general 
procedure described in Chapter 1. After connecting the gateway 
to a Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration dialog 
box, 

• Click the Reset button, then open the gateway again. 
• Click the Pause button. 
• Enter the AppleTalk configuration data; see Chapter 2. 

Note that the LocalTalk zone name must be included in the 
EtherTalk Phase 2 zone list if client Macintoshes will be 
supported in Ethernet. 

• Turn on Option 7. 
• Select K-STAR IP from the Configuration menu and 

double-click on the K-STAR IP listing in the 
Configuration area. 

• Enter the IP address of the FastPath Box. 
• Enter the number of client Macintoshes controlled by the 

gateway. 
• Click OK. 
• Turn on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 
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This example uses the internet configuration shown in Figure 
3-8. For your site, you should determine the proper addresses 
for the gateway before you configure it. 

Option 7: 
IP Address of FastPath Box: 
(Clients) Dynamic: 

ON 
130.57.64.5 
5 

(Clients) Static: 4 

After selecting Reset and then Pause, enter the AppleTalk 
configuration you require, as described in Chapter 2. Then 
proceed with the IP configuration: 

1. Click the Options ... button in the main configuration dialog 
box. This brings up the Options window. 

2. Turn on Option flag 7, then click OK to return to the main 
dialog box. 

rO,ti .. n Il98--------'--------l 

liL~ ~~o ~:~ ~~: 
[ Cuncel ) 

I \I 19 27 
4 12 20 28 
& 11 21 29 
, 14 22 30 I 
7 1& 21 31 
• 16 24 32 

I OK I 

[

'OPtl .. PlnMten - 'J 
~D DO DO DO DO DO DO DO 
DO DO DO DO DO DO DO DO 0 RSCII 
DO 00 00 00 00 00 00 DO 
DO DO 00 DO DO DO DO DO@ __ H __ e_HUdecl_mUI 

::jj;jp=~--=--=:='--== 
L_~-~ 

3. Select K-STAR IP from the Configuration menu and double
click on K-STAR IP in the Configuration area to open the IP 
dialog box. 

4. Type the gateway's address in the IP Address of the 
FastPath Box field: 130.57.64.5, then press tab. 
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5. Double-click in the Dynamic field in the "Number of IP 
Clients" area, and type the number of client Macintoshes 
that will dynamically acquire IP addresses from the 
gateway: 5, then press tab. 

6. Type the number of client Macintoshes that will be assigned 
static IP addresses administered by the gateway: 4, then 
press tab. The total number of clients supported by a 
gateway must be less than or equal to 60. 

7. Click OK to return to the main dialog box. 

8. Turn on the Remote Boot switch by clicking in the selection 
box. 

9. Select Download a File ... from the File menu and open 
K-STAR. 

10. Click Go to send the configuration data to the gateway. 

11. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
turn off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and check the diagnostic messages in the 
Log window. 

An IPTalk configuration 

The IPTalk software in K-STAR encapsulates outgoing 
AppleTalk packets in UDP for transmission to CAP or AUFS 
hosts. When it receives encapsulated packets back from these 
hosts, it strips off the UDP transmission data and sends it to 
AppleTalk nodes on its LocalTalk or EtherTalk interface. 
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Configuring an IPTalk interface for the gateway using the 
FastPath Manager allows nodes on the IPTalk network that is 
directly connected to the K-STAR gateway to communicate with 
nodes on the AppleTalk internet. When you configure for 
IPTalk in this way, nodes on remote IPTalk networks (lPTalk 
networks that are not directly connected to the AppleTalk 
internet) will not be able to communicate with the AppleTalk 
internet. 

1111" All nodes on one IPTalk network must be connected to the same 
Ethernet cable. In addition, because the IPTalk software uses 
the lower-order byte of the host's IP address as a virtual 
AppleTalk node address, the IP addresses of hosts on this IPTalk 
network must all have the same high-order 3 bytes. This is true 
regardless of the class of the IP network number. Note that this 
precludes using class C subnets as IPTalk networks. 

1111" Note that using the atalkatab configuration file to configure 
IPTalk networks removes this restriction, and allows IPTalk 
traffic to be routed through IP routers to remote IPTalk 
networks. Configuring an IPTalk interface in K-STAR using 
the Fastpath Manager is recommended only when no 
administrator host is present; that is, when the atalkatab file 
and atalkad daemon,are not available on the internet. 

To use the IPTalk software in K-STAR, you define an IPTalk 
interface by supplying an AppleTalk zone name and net 
number for the (logical) IPTalk network. When a Macintosh user 
selects the IPTalk network (via a zone name in the Chooser), all 
outgoing AppleTalk traffic destined for that network will be 
encapsulated in UDP. The hosts on the IPTalk network must 
understand this packet structure and be able to strip off the 
UDP transmission data to read the AppleTalk packet within; 
that is, they must be running CAP or AUFS (or compatible) 
software. When the CAP or AUFS system returns AppleTalk 
data encapsulated in UDP, the gateway strips off the UDP 
transmission data and routes it to the AppleTalk node(s) that 
originated the request. 
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Figure 3-12 shows an example internet configuration where 
some hosts on an IP network are running CAP or AUFS, but 
there is no administrator host (running atalkad) available on the 
internet. The CAP and AUFS systems accept AppleTalk packets 
encapsulated in UDP transmission data, and form a logical 
IPTalk network with other AppleTalk and EtherTalk hosts. 

LocalTalk network supporting Macintoshes 
as regular AppleTalk nodes. 

IPTaik data: 
IP Address of the FastPath box: 130.57.64.5 

IPTalk AppleTalk zone name: 
AppleTalk network number: 9~--~---------~------~~---r----------~ 

Ethernet/IP network: 130.57.64.0, 
subnet mask 255.255.255.0 (FFFFFFOO). 

Figure 3-12. UDP encapsulation: IPTalk 

This release of K-STAR uses the range of "well-known" ports 
(beginning at 200 rather than 768) that NIC assigned for use by 
the Kinetics Internet Protocol (KIP) as of April, 1988. This is 
compatible with the latest versions of CAP (CAP 5.0 or later) See 
the section on "Using the new UDP port numbers" in this 
chapter for more information. 

In configuring the gateway, you should follow the general 
procedure described in Chapter 1. After connecting the gateway 
to a Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration dialog 
box, 
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• 
• 
• 
• 

• 
• 

• 
• 
• 
• 
• 

Click the Reset button, then open the gateway again. 
Click the Pause button. 
Enter the AppleTalk configuration data; see Chapter 2. 
Select K-STAR IP from the Configuration menu and 
double-click on the K-STAR IP listing in the 
Configuration area. 
Enter the IP address of the FastPath Box. 
Enter the AppleTalk configuration data for the IPTalk 
interface. 
Click OK. 
Tum on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 
3-12. For your site, you should determine the proper network 
numbers and zone names for the gateway before you configure it. 

IP Address of the FastPath box: 
AppleTalk zone name: 
AppleTalk network number: 

130.57.64.5 
IPTalk 
99 

After selecting Reset and then Pause, enter the AppleTalk 
configuration you require, as described in Chapter 2. Then 
proceed with the IP configuration: 

1. Select K-STAR IP from the Configuration menu and double
click on K-STAR IP in the Configuration area to open the IP 
dialog box. 

2. Enter an unused IP address on the existing IP network in 
the IP Address for the FastPath Box field: 130.57.64.5, then 
press tab. 

3. Click in the AppleTalk Zone Name field and type the zone 
name: IPTalk, then press tab. 

4. Type the AppleTalk network number: 99, then press tab. 
Note that this AppleTalk network number must be unique; 
no two networks can use the same number. 
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5. Click OK to return to the main dialog box. 

6. Tum on the Remote Boot switch by clicking in the selection 
box. 

7. Select Download a File. __ from the File menu and open 
K-STAR. 

8_ Click Go to send the configuration data to the 
gateway. 

9. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
turn off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on 
the internet, launch the FastPath Manager on a Macintosh on 
either side of the gateway, and check the diagnostic messages in 
the Log window. 
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When you bring up the gateway on the internet, open the 
Chooser on a Macintosh on either side of the gateway. The 
IPTalk zone should appear: 

o 

AppleTallc Zones: 
IPTallc 

russ 
terry 
tim 

Chooser 

ApplaTalk 
3.4 

If you are using atalkad 

If there is a UNIX host on the internet that is running the 
atalkad daemon, you can use the information maintained in the 
atalkatab file to configure the gateway. Basically, the 
information for all configurations is maintained in one database 
file (the atalkatab file, currently supported on UNIX IP hosts 
only). The atalkatab file must be up-to-date and the UNIX host 
must be able to communicate with the IP address you assign to 
the gateway. See the KIP documentation from Stanford 
University for details on configuring the atalkatab file. 

1111" If the internet supports more than one administrator host, it is 
important that all administrator hosts support the same 
atalkatab file. 
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For IP communication with the host running atalkad 
(the "administrator host"), the gateway needs only 2 
addresses. No other IP data should be supplied. 

IP data: 
IP Address of FastPath Box: 130.57.64.5 
IP Address of Administrator Host: 130.57.64.10 

Figure 3-13. Using atalkad 

The administrator host maintains a 
copy of the ataJkatab file, which is 
accessed by the ataJkad daemon. 

1111" If you are configuring the gateway to access atalkad, you should 
not supply any IP configuration data other than the two IP 
addresses shown in Figure 3-13: the IP address for the gateway 
and the IP address for the administrator host. Nor should you 
supply AppleTalk configuration data for the LocalTalk interface 
or the EtherTalk Phase 1 interface. However, since AppleTalk 
Phase 2 is not yet supported in the atalkatab file, you should 
supply the full EtherTalk Phase 2 configuration in the FastPath 
Manager. In addition, if you are supplying secondary addresses 
for the gateway (as described in Figures 3-9 and 3-10, you need 
to tum on Option 9 in the FastPath Manager. All the other 
configuration information should be in the atalkatab file. 

To configure the gateway to query atalkad for its configuration 
information, after launching the FastPath Manager application 
and opening the gateway, 

• Click the Reset button, then open the gateway again. 
• Click Pause. 
• If you are using AppleTalk Phase 2, enter the Phase 2 

configuration data, as described in Chapter 2. 
• Select K-STAR IP from the Configuration menu and 
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double-click the K-STAR IP listing in the Configuration 
area. 
Enter the IP address of the FastPath Box. 
Enter the IP address for the IP host running the atalkad 
daemon in the IP Address of Administrator Host field. 
Tum on the Remote Boot switch (optional). 
Download K-STAR. 
Click the Go button. 
Save the configuration data in a file (optional). 

This example uses the internet configuration shown in Figure 3-
13. For your site, you should determine the proper IP addresses for 
the gateway before you configure it. 

IP Address of FastPath Box: 130.57.64.5 
IP Address of Administrator Host: 130.57.64.10 

After selecting Reset and then Pause, enter the EtherTalk Phase 
2 configuration you require (if any), as described in Chapter 2. 
Then proceed with the IP configuration: 

1. Select K-STAR IP from the Configuration menu and double
click K-STAR IP in the Configuration area to open the IP 
dialog box. 

2. Enter the gateway's IP address in the IP Address for the 
FastPath Box field: 130.57.64.5, then press tab. 

3. Type the IP address of the host running atalkad in the IP 
Address of Administrator Host field: 130.57.64.10, then 
press tab. 

4. Click OK to return to the main dialog box. 
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5. Turn on the Remote Boot switch by clicking in the selection 
box. 

6. Select Download a File ... from the File menu and open 
K-STAR. 

7. Click Go to send the configuration data to the gateway. 

8. Save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and check the diagnostic messages in the 
Log window. 
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Dynamic 
IP addresses 

Static 
IP addresses 

K-STAR IP management issues 

It is important to note that assigning duplicate IP addresses 
can cause confusion on the entire internet. An internet 
administrator must assign a number for the gateway and a 
consecutive range of unused numbers for use by its Macintosh 
"clients." 

Managing Macintosh clients 
When you configure K-STAR with a range of Dynamic 
Addresses and Static Addresses, the gateway can dynamically 
assign the number of IP addresses specified in the "dynamic 
address" field to Macintoshes as they boot up on the network. 
To the rest of the internet, these addresses look like addresses on 
the Ethernet. The IP addresses contained in the "static address" 
sub-range must be explicitly assigned to Macintoshes. 

The K-STAR IP software supports up to 60 IP addresses in the 
range managed by the gateway for client Macintoshes. 
Provided that you have an unused block of addresses, you can 
assign a greater number of IP addresses than you need in the 
"Number of Clients" area. This will allow you to add client 
Macintoshes without reconfiguring the gateway at a future date. 

When you install TCP lIP software on a Macintosh (for example, 
Kinetics TCPort™ HostAccess, MacTCPTM, or NCSA Telnet), 
you need to supply an IP address as part of the initial 
configuration. To allow the Macintosh to dynamically acquire 
its IP address from the gateway, select Dynamic instead of 
assigning an explicit IP address. (This is done slightly 
differently in Mac TCP and NCSA Telnet, but the functionality 
is still the same.) 

Similarly, you can assign an explicit IP address to a Macintosh 
when you are initially configuring TCP lIP software on the Mac. 
This must be an unused IP address in the static range specified 
in the gateway configuration. Unless you are using the split
addressing feature as it is described in the section "The Gateway 
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Macintoshes on 
Ethernet 

Managing a Separate Network: 'Split Addressing' with Option 
9" in this chapter, the IP address you assign to the Macintosh is 
in a range beginning at the gateway IP address + 1. 

The static IP addresses assigned to Macintoshes are managed by 
hand; that is, there is no gateway function to determine which 
nodes have been assigned an IP address and which of the static 
addresses are still free. It is recommended that you keep track 
of these addresses in your network records. 

If the gateway is administering an IP address for a Macintosh 
that is directly connected to Ethernet, the Macintosh must have 
EtherTalk selected (via the Network icon in the Macintosh 
Control Panel). If you are using TCPort, set the TCPort interface 
to AppleTalk in the Control Panel. When the TCPort interface 
is set to Ethernet, the TCPort dynamic address assignment 
must be done through a BOOTP (Boot Protocol) or RARP 
(Reverse ARP) server. 

When you use the gateway to administer IP addresses for 
Macintoshes on Ethernet, the Macintosh's performance on the 
network will be reduced, since all traffic must go through the 
FastPath. You can avoid this performance hit if there is a 
BOOTP (Boot Protocol) or RARP (Reverse ARP) server on the 
net. In this case, the interface in TCPort must be set to 
"Ethernet" using the TCPort entry in the Macintosh Control 
Panel. 

How dynamic addressing works 
When a Macintosh on LocalTalk that has been configured for 
dynamic addressing boots up on the network, it broadcasts NBP 
packets with a request for the type "IPGATEWAY." When the 
gateway receives the NBP packet, it sends back its own IP 
address in ASCII. When the client receives this response, it 
knows where the gateway is, and sends a request (an ATP 
packet) to acquire an IP address. When the gateway sends back 
an ATP packet containing an IP address within the dynamic 
range specified in K-STAR, the client uses NBP to register itself 
as that "IPADDRESS." Doing this verifies that no other node in 
its zone has the same IP address. If this process succeeds, the 
client starts using the IP address. Once the gateway has 
assigned an IP address, it periodically sends NBP packets to 
confirm that the address is still in use. 

3-38 FastPath Administrator's Guide 



The range of dynamic addresses extends from the last address 
of the static range +1 to the last address of the static range + the 
dynamic range. The dynamic addresses are assigned to 
Macintoshes beginning with the highest available address. For 
example, if the gateway IP address is 130.57.64.15, the Static 
field is 10, and the Dynamic field is 45, the first Macintosh to 
acquire its IP address dynamically would get the address 
130.57.64.70, the second would get the address 130.57.64.69, and 
so forth. If an IP address within this range becomes available 
again (that is, if the Macintosh using the address is powered 
down or otherwise not accessible at its original AppleTalk 
address for at least 5 minutes), the IP address is freed for future 
re-assignment. 

Split addressing management issues 
The split-addressing feature of K-STAR IP configuration is 
particularly useful when the number of nodes on an IP network 
or subnet is approaching the maximum limit, and you do not 
have a block of free addresses to assign to client Macintoshes. 
In this case, you should assign a separate IP network number, as 
described in "The Gateway Managing a Separate Network." If 
the client Macintosh network will communicate with any IP 
hosts who in turn communicate with systems that are not 
administered at your site, you need to obtain an official IP 
network number from SRI, as described in "If You are New to IP 
Internets." Otherwise, you can make up a dummy IP network 
number for the client Macintosh network. 

If you have a block of free addresses on the existing IP network, 
but your addressing scheme puts the gateway at an IP address 
that is not immediately contiguous to that block of free 
addresses, you can use split addressing to specify a separate 
start address for the client Macintoshes on the same IP net. In 
this case, because the gateway already has its address on this 
network, the static range of IP addresses begins at the actual 
address entered in the Local Parameters #1 field, rather than 
this address +1. 

When the IP network numbers on the Ethernet interface and the 
LocalTalk interface are different, K-STAR begins sending RIP 
packets out on the Ethernet side to inform other routers about 

K-STAR IP Configuration 3-39 



the new network. (Note that the RIP module in this 
implementation only broadcasts information about the networks 
it knows about, it does not respond to RIP requests or issue 
updates.) If the internet does not support RIP, you need to 
statically configure the routing tables with the path to the new 
network. 

If the Ethernet/IP network is subnetted, and you supply a 
second address for the gateway using a separate network 
number, the subnet mask in use on Ethernet is automatically 
applied. If the Ethernet/IP network is not subnetted, you have 
the option to supply a subnet mask in the Parameters #2 field, 
below the second address. 

Using the new UDP port numbers 
When DDP packets are encapsulated in UDP, the DDP socket 
numbers in the address are translated to UDP port numbers that 
can be understood by IP hosts. Prior to April 1988, there was no 
official range of UDP port numbers for use by KIP, so KIP (and 
previous versions of K-STAR) used a range of unreserved UDP 
port numbers ranging from 768 to 896 and from 16384 to 16512. 

This release of K-STAR uses the range of "well-known" ports 
(beginning at 200 rather than 768) that NIC assigned for use by 
the Kinetics Internet Protocol (KIP) as of April, 1988. This is 
compatible with the latest versions of CAP (CAP 5.0 or later) 
and KIP (KIP 0688 or later). To start using these UDP port 
numbers, tum on Option 11 in the Options window. To tum on 
Option 11, click the Options ... button in the main configuration 
dialog box, and click in the selection box next to number 11. 

Alternatively, if you are using atalkad on your internet, you can 
set the new UDP port number range in the FastPath by 
modifying the atalkatab file. See the KIP documentation for 
information on modifying atalkatab .. 
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c H A p T E R 4 

K-STAR DECnet Configuration 

Tms CHAPTER TELLS YOU HOW TO CONFIGURE THE GATEWAY FOR 

DECnet Level-l routing between LocalTalk and Ethernet. After 
you have configured the gateway as a DECnet router, 

Macintoshes hat are configured as DECnet nodes on Local Talk 
or Ethernet tcan communicate through the gateway with other 

DECnet nodes. The Macintoshes must be running DECnet 

software that implements DECnet encapsulated in AppleTalk 

packets. 

The Macintoshes on the gateway's LocalTalk interface must be 
statically configured with DECnet addresses, just as if they were 

DECnet nodes on the Ethernet. The DECnet network sees these 
Macintoshes as nodes in the DECnet area on Ethernet. 
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K-STAR DECnet addressing 

When you configure the gateway for DECnet routing, the 
gateway acts as a level-1 DECnet router. This means that the 
gateway routes only within its own area, it does not ''know 
about" other DECnet areas in the internet (although it will know 
about a Level-2 router, if one is present). 

When you are supplying DECnet addresses using K-STAR, the 
basic rules to remember are: 

• The gateway and all Macintosh end-nodes are in the same 
area as the DECnet area on Ethernet. The Ethernet DECnet 
nodes see the LocalTalk nodes as if they were on Ethernet. 

• The gateway and all Macintosh end-nodes need unique 
DECnet node numbers. 

• All end-nodes on Ethernet and LocalTalk need to be 
explicitly updated to know about the additional DECnet 
nodes. 

Required configuration data 

To perform DECnet Level-1 routing, the gateway requires the 
following data: 

• A DECnet area number. This should be the DECnet area 
number that is in use on Ethernet. 

• A DECnet node number. The DECnet node number can be 
any decimal number between 1 and 1,023, and must be 
unique for each node in the area. 

It is also recommended that you supply a name for the gateway 
and enter its serial number to make future administration easier. 
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An example internet 

Figure 4-1 shows an example internet configuration using 
DECnet routing on one Ethernet and one LocalTalk network. 

The gateway will be configured as a DECnet router 
in the existing DECnet area on Ethernet. 
Macintoshes on LocalTalk that are running 
DECnet/ AppleTalk software will be seen by other 
DECnet nodes as if they were connected to Ethernet. 

Figure 4-1. A DECnet network 

The gateway in this example will be configured for DECnet 
Level-1 routing. If the gateway receives a DECnet packet 
destind for another area, it will forward the packet to a Level-2 
router if one is present on the internet. When the sample 
gateway is fully configured, it will have the configuration 
shown in Figure 4-2. 
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DECnat data: 
DECnet area: 7 
DECnet node number: 10 

Figure 4-2. DECnet configuration data 

In configuring the gateway for UECnet routing, you should 
follow the general procedure described in Chapter 1; that is, 
connect one gateway to one Macintosh via LocalTalk, configure 
it as described below, turn it off, unplug it, and move it to its 
permanent location. 

Supplying the DECnet data 
After connecting the gateway to a Macintosh via LocalTalk, 
launch the FastPath Manager, and select and open the gateway. 
In the main configuration dialog box, 

• Click the Reset button, then open the gateway again. 
• Click the Pause button. 
• Supply the AppleTalk data, as described in Chapter 2. 
• Select DECnet from the Configuration menu and double-

click on the DECnet listing in the Configuration area. 
• Enter the DECnet area and node number for the gateway. 
• Turn on the Remote Boot switch (optional). 
• Download K-STAR. 
• Click the Go button. 
• Save the configuration data in a file (optional). 
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This example uses the internet configuration shown in Figure 
4-2. For your site, you should determine the proper area and 
node number for the gateway before you configure it. 

DECnet area: 
DECnet node number: 

7 
10 

After selecting Reset and Pause, supply the AppleTalk data you 
require, as described in Chapter 2. If you are configuring the 
gateway for IP, you can also supply that data, then proceed with 
the DECnet configuration: 

1. Select DECnet from the Configuration menu, then double
click on the DECnet listing in the Configuration area to 
open the DECnet dialog box. 

2. In the DECnet Area field, type 7, then press tab. 

3. Type the DECnet node number: 10, then press tab. 

r=:~~-IJ~ 1 
Blckground Tlllllr 'H 
Heno TI mer 30 -_._ .. -----_._---_ .......... _-_ ....... .. 

Cancel 

4. If you wish, you can modify the default value of 120 in the 
Background Timer field. This value determines how 
frequently (in seconds) routing packets are sent out; the 
default value should be reasonable for most sites. 

5. If you wish, you can modify the default value of 30 in the 
Hello Timer field. This value determines how frequently (in 
seconds) ''hello'' packets are sent to end nodes on the 
network, and the default value should be reasonable for 
most sites. 
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6. Click the OK button to return to the main dialog box. 

7. Select the Remote Boot switch in the Switch Area by clicking 
in the selection box . 

8. Select Download a File ... from the File menu and download 
the K-STAR gateway program. 

9. When K-STAR has been downloaded, click the Go button. 

10. Select Save Configuration File ... from the File menu and 
type a name for the configuration; for example, 

GWl.DECnet.config 

Click the Save button to save the configuration file to disk. 

At this point, Quit the FastPath Manager (using the File menu), 
tum off the FastPath, unplug it, and move it to its permanent 
location on the internet. When you bring up the gateway on the 
internet, launch the FastPath Manager on a Macintosh on either 
side of the gateway, and select and open the gateway. 

Click Log ... to access the diagnostic messages from the gateway. 
The Log window contains a static version of the most recent 
messages from the gateway that is currently open. 

Log Messages: 

• KFPS AT" 220 ET" 136 PAOlI REV 4.1 (88'IO{01> STAlE-DDIIIILDAD UllLID 10 
III STATUS-O F 
• K-STAR FCI.tI"lIth AT node 22D, ET nod. 136, ET2.D .. t 6528D, m.D 
node 1311, 8S buff ... (3D for .u..m.u, .....,1.lon I.D, Dptl .... FI_: ..-. 
• ETALK2 •• _d _ '"'"'98 I - ID, and ChOA ... t I 
• DEC ... t r .... ting on, 11\1 _S -7.ID 

(continueD Print 

The messages in this window indicate that there are no error 
conditions found in the DECnet configuration. See Appendix C 
for an explanation of the gateway's DECnet diagnostics. 
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H A p T E R 5 

Troubleshooting 

THIS CHAPTER DESCRIBES SOME COMMON PROBLEMS AND SOLUTIONS 

in gateway installation and configuration. 

In general, it is recommended that you follow the installation 

and configuration instructions described in Chapter 1; that is, 

that you bring the gateway up on an isolated LocalTalk network 

connected to a single Macintosh. Some of the solutions in this 
chapter assume that you are on an isolated network, and others 

deal with conditions that would not be visible until you bring 

the gateway up on a full internet. 

At the end of this chapter, there is a brief overview of 

troubleshooting the gateway on a working internet by checking 

network equipment and connections. 

1111" If you are operating in an AppleTalk Phase 1 environment, you 

can use the LAN Ranger to view the internet topology and test 

the gateway and other network elements. 
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Calling for help 

If your attempt to resolve the problem fails, and you purchased 
the gateway from an authorized Kinetics dealer, call your dealer 
for assistance. When you call a Kinetics dealer, be prepared to 
give a complete description of the problem, induding what 
happens, when it happens, and what you've done to diagnose 
the problem. You should also have information about your 
network equipment on hand. 

If you did not purchase the gateway from a dealer, call the 
Kinetics Technical Support Department at (415) 975-4547, or 
send an AppleLink message to AppleLink D0121. If you have 
access to the ARPAnet, you can send e-mail to 
support@kinetics.com. 

Do not return the gateway to Kinetics without first calling 
Kinetics, discussing the problem, and obtaining a Return 
Materials Authorization (RMA) number. 

FastPath installation problems 

If the gateway does not appear to be working right when you 
power it on, follow the diagram in Figure 5-1 to verify its 
condition. See "Hardware Self-Tests" in Appendix A for a 
description of the power-on hardware checks and how the LEDs 
on the FastPath front panel should look. 
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The left-most LED is the power light. 
On an isolated LocalTalk net, this 
should be the only LED ON after 
self-testing. See Appendix A for 
a full description of the 
gateway's hardware self-tests. 

Power on the 
FastPath 

See Solution #1 

o V A 
~ 000 

bj~ 

Call forRMA 
(p.5-2) 

Launch 
FastPath Manager 

.1-8 

Figure 5-1. Hardware installation check 

Solution #1: Check that the power cord is plugged in properly to the 
gateway and to the grounded, three-prong outlet, and that the 
gateway is switched on. 
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FastPath configuration problems 

This section describes problems you might see when using the 
FastPath Manager to configure the gateway. It assumes that you 
have followed the instructions in Chapter 1, and have read the 
appropriate configuration directions in Chapters 2 through 5. 

Can't locate a gateway to open 
If you launch the FastPath Manager on a Macintosh and the 
gateway does not appear in the gateway selection window, 
follow the diagram in Figure 5-2 and the solutions below to try 
to locate the gateway to open. 
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Launch 

Solution #2: 

in Gateways menu 

See Solution #3 

See Solution #4 

See Solution IS 

Figure 5-2. Can't find and open the gateway 

Check that the LocalTalk connection is secure, and make sure it 
is connected to the Macintosh printer port, not the modem port. 
If the connection appears to be correct, check that the LocalTalk 
DB9 connector is working correctly. You can check whether the 
LocalTalk cable or connector is defective by installing a different 
set of LocalTalk connectors. Swap with another device, if 
necessary, to find out whether this is the actual cause of the 
problem, then replace the faulty items. 
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Solution #3: 

Solution #4: 

Solution #5: 

Check that there are no protocol-dependent bridges between the 
Macintosh running the FastPath Manager and the gateway. If 
there are no bridges on the LocalTalk network, 

• Turn the gateway off and then on again. If this doesn't 
correct the problem, 

• Quit the FastPath Manager and reboot the Macintosh, then 
relaunch the FastPath Manager. 

If the Macintosh is on LocalTalk, make sure that AppleTalk is 
enabled in the Macintosh Chooser. If the Macintosh is on 
LocalTalk but it has an Ethernet card installed, check that the 
Built-in icon is selected in the Macintosh Control Panel. 

To check that AppleTalk is enabled, 
• Open the Chooser and select the Active button next to 

AppleTalk. If you can't enable AppleTalk, contact your 
Macintosh dealer for more information. 

To check that Built-in is selected, 
• Open the Control Panel and select the Network icon in the 

scrollable area on the left side of the window. The Control 
Panel displays at least two icons when an Ethernet card is 
installed, Built-in and EtherTalk, and possibly three icons 
(there may be two EtherTalk icons, one with double arrows). 
If the Macintosh is connected to a LocalTalk or equivalent 
network, click on the Built-in icon. 

If the Macintosh running the FastPath Manager is on Ethernet, 
make sure that AppleTalk is enabled in the Macintosh Chooser, 
and the EtherTalk icon is selected in the Control Panel (either 
the icon with single arrows for EtherTalk Phase 1, or the double
arrow icon for EtherTalk Phase 2). Solution #4 describes how to 
check these conditions. If the Macintosh is running EtherTalk 
Phase 2, note that the FastPath Manager will automatically use 
AppleTalk Phase 1 internally to find the gateway. 

If everything is in order in the Chooser and the Control Panel, 
relaunch the FastPath Manager on a Macintosh on the gateway's 
LocalTalk interface and check that neither Option 5 nor Option 
18 are turned on in the gateway's configuration. If Option 5 (for 
EtherTalk Phase 1) or Option 18 (for EtherTalk Phase 2) is turned 
on, a Macintosh on Ethernet may not be able to see the gateway. 
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Problems downloading or configuring 
When you select Download a File ... from the File menu and 
open the K-STAR module, K-STAR should begin downloading 
to the gateway. A screen like this should appear: 

Downloading the file "K-STRR Venlon 8.0· 
Deltlnatlon: Node 220 -- (NOde 220J 
Size of file Un byte.): , 19228 

Prell Ie • .' to Cancel. 

If this download screen does not appear, follow the diagram in 
Figure 5-3, and see liThe Download Sequence" in Appendix A 
for a full explanation of how the gateway accepts download 
code. Some solutions for common problems are presented 
below Figure 5-3. 

Select Download a File ••• 
from the File menu and 

open K-5TAR Version 8.0 

When scale Indicates 

Select Diagnostics 
in Windows menu 

100%, click Go butto,rt-~.~ 
In main dialog box 

See Solution #6 
See Solution #7 

Figure 5-3. Problems downloading or sending data 
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Solution #6: 

Solution #7: 

The most common difficulty in downloading K-STAR is that the 
gateway was not "paused" and more than 25 seconds elapsed 
following a Reset or initial power-on. In this situation, the 
gateway begins executing its PROM-resident routing code, and 
it cannot accept K-STAR code in that state. 

To clear the gateway, 
1. Save your configuration data in a file if yo-q have entered 

any AppleTalk Phase 2 zone data. 
2. Click Restart. 
3. Select Find All... in the Gateways menu and and open the 

gateway again. 
4. If necessary, click Pause and open the configuration file you 

created instep 1. If you do not need to open a file and you 
can start downloading K-STAR within 25 seconds of clicking 
Restart, you do not need to click Pause. 

5. Select Download a File ... in the File menu and open K-STAR 
again. 

6. When the download has completed, click Go. 

The FastPath power-on and download sequence is explained in 
detail in Appendix A. Note that, to use all of the features 
described in this guide, you must use K-STAR Version S.O or 
later. 

If the Diagnostic messages indicate that the configuration is 
wrong, the gateway will be unable to route packets successfully. 
Check the configuration data you have supplied to it. This is an 
extremely important step in any configuration, and it varies 
according to the configuration method(s) you are using. A 
checklist is shown below for each type of configuration. 

AppleTalk Phase 2 
" Check that K-STAR has been downloaded. The messages in 

the Log or Diagnostics window should include a startup 
message that begins with "KSTAR FastPath." See Appendix 
C for a full description of this message . 

./ If the gateway is acquiring seed data on one of its interfaces, 
check that it succeeded in doing so. The messages in the 
Log or Diagnostics window should include a message 
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indicating that one or more interfaces have acquired data. 
See Appendix C for more information . 

./ Check that the network numbers you have assigned are 
unique on the internet . 

./ Check that the correct zone names are being used (see the 
Macintosh Chooser) . 

./ Check that all gateways on the network agree about which 
name in the zone list is the default zone name. 

" If you are reconfiguring zone names on a Phase 2 gateway, 
make sure you bring the gateway down and leave it off the 
internet for at least a full ten minutes to allow other 
gateways to time out the old zone information. Also, make 
sure you have downloaded K-STAR again after entering 
the configuration change. 

AppleTalk transition bridge 
./ Check that K-STAR has been downloaded and that Option 

17 is enabled. The messages in the Log or Diagnostics 
window should include a startup message that begins with 
"KSTAR Fastpath" and concludes with "Option Flags: 17." 
(Other options may also be enabled.) See Appendix C for a 
full description of this message. 

" Check that the EtherTalk Phase 2 interface has a network 
range with only one element (that is, the range start and 
range end are equal). 

" Check that the network numbers you have assigned are 
unique on the internet. 

" Check that the EtherTalk Phase 2 interface is configured 
with a zone list with only one name in it. 

./ If you are reconfiguring the zone name on a transition 
bridge, make sure you bring the gateway down and leave it 
off the internet for at least a full ten minutes to allow other 
gateways to time out the old zone information. Also, make 
sure you have downloaded K-STAR again after entering 
the configuration change. 
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AppleTalk Phase 1 
./ Unless you are using the PROM-resident Phase 1 protocols, 

Check that K-STAR has been downloaded and that Options 
17 and 18 are enabled. The messages in the Log or 
Diagnostics window should include a startup message that 
begins with "KSTAR FastPath" and concludes with "Option 
Flags: 17 and 18." (Other options may also be enabled.) See 
Appendix C for a full description of this message . 

./ Check that the network numbers you have assigned are 
unique on the internet. 

./ If the gateway is acquiring seed data on one of its interfaces, 
check that it succeeded in doing so. The messages in the 
Log or Diagnostics window should include a message 
indicating that one or more interfaces have acquired data. 
See Appendix C for more information . 

./ If you are reconfiguring the zone name on a Phase 1 
gateway, make sure you bring the gateway down and leave 
it off the internet for at least a full ten minutes to allow other 
gateways to time out the old zone information. 

K-STARIP 
./ Check that K-STAR has been downloaded. The messages in 

the Log or Diagnostics window should include a startup 
message that begins with "KSTAR FastPath. " See Appendix 
C for a full description of this message. If the message "IP 
Routing: ON" appears as part of the FastPath startup 
message, K-STAR has not been downloaded and you are 
using the PROM-resident protocols. (In this case, we 
recommend that you reconfigure the gateway using K-STAR 
IP.) 

./ Check that you have supplied the proper IP address (at least 
one) for the gateway. The gateway must be configured as a 
host on the Ethernet/IP network; that is, the IP address you 
supply must be unused by any other host on that network, 
and must have the correct IP network number. 
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" If you have supplied a second IP address (using the split
addressing feature) check the following: 

1. That Option 9 is enabled. 

2. That the second IP address is unique (if it is on the 
Ethernet/IP network) and followed by the proper 
number of unused IP addresses for Macintosh clients. 

3. That the entire range of IP addresses specified for client 
Macintoshes is available. Check that none of these 
addresses are assigned to other hosts or configured as 
part of a range on another gateway. 

4. If the second address is not on the Ethernet/IP network, 
make sure that other IP hosts support RIP; otherwise 
you need to statically configure their routing tables with 
information about the new IP network supported in the 
gateway. 

" Check that all hosts on the existing IP net agree about the 
subnet mask in use. If there appears to be confusion among 
existing hosts on the network, you can explicitly supply the 
correct subnet mask in the proper field in the K-STAR IP 
dialog box. 

" If you are using IPTalk, check that the AppleTalk network 
number specified for the IPTalk interface is unique on the 
AppleTalk internet. 

" If you are using atalkad, check that the atalkatab file is 
correctly configured. See the KIP documentation for details 
on this database file. 

DECnet 
" Check that you have supplied the proper area number (this 

should be the same area number in use on Ethernet). 

" Check that the node number you have supplied is unique 
within the gateway's area. 
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Network connections 

Some problems in network operation are easy to find and fix. 
The problem might be as simple as a gateway aCcidentally 
switched off, or a cable connection worked loose. If there is a 
problem with network operation, first try to isolate the area in 
which the problem occurs. Then check the equipment and 
connections in a particular area or on the whole network. 

• Make sure the FastPath gateway is plugged in and switched 
on. 

• On each Macintosh computer in the network, make sure the 
LocalTalk connector is plugged into the printer port, not the 
modem port. 

• Make sure no cable connections are loose or unplugged. 
LocalTalk cable connections can work loose if not secured 
with cable ties. 

• Refer to the documentation for the network medium you are 
using and make sure that the cables are installed correctly. 

• Swap equipment to check for defective devices, cable, 
connections, and power sources. 
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A p p E 

Ethernet~ 

N D I x A 

FastPath Operations 

THIS APPENDIX PROVIDES A REFERENCE TO GATEWAY OPERATIONS, 

including the power-on and download sequences, hardware 
self-testing, the autoconfiguration algorithm, and FastPath 
routing and encapsulation operations. 

The FastPath gateway executes gateway code, which 
implements the protocols needed for encapsulation and routing. 
This code may be built-in to gateway PROM or downloaded 
from the FastPath Manager or a compatible mechanism. 

Intel 
t---t---i 82586 I MC68000 I 

Memory 
/ 

/ 
Used for downloaded 
gateway code (K-STAR 
or customized gateway 
code) and for buffering 
network traffic. 

LocalTalk 

V 
-

Zilog 1--+---1 
8530 
-

PROM 

" 
Contains default 
gateway code 
(AppleTalkPhase 1 
and IP "subsectioning" 
protocols). 
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• The FastPath PROM contains AppleTalk Phase 1 protocols 
and an implementation of IP routing that is backward 
compatible with FastPath Is, 2s, and 3s. 

• The downloadable K-STAR gateway code contains KIP-style 
TCP lIP IUDP, ICMP, RIP, AppleTalk Phase 1 and AppleTalk 
Phase 2, transition bridge software, NBP filters (for zone 
security), SNMP and DECnet protocols. 

The FastPath Manager is a Macintosh application that 
communicates with the gateway. It is launched on a Macintosh 
on one of the networks connected to the gateway (LocalTalk or 
Ethernet). The FastPath Manager is the mechanism for 
downloading code (K-STAR or customized code developed at 
your site) and configuration information to the gateway. It also 
continuously receives diagnostics from the FastPath and 
displays them in a Diagnostics window, and uses a Log ... button 
to retrieve a short "snapshot" log of FastPath events, which it 
displays in a Log window. 

The FastPath accepts information from the FastPath Manager in 
the form of KLAP packets (Kinetics Link Access Protocol), 
which include commands andlor data for the gateway. 

The FastPath power-on sequence 

The FastPath has battery backed-up RAM, which allows it to 
automatically restart after a power failure. As shown in Figure 
A-I, a power-on, restart (either an automatic restart after a 
power failure or an intentional one by clicking on the Restart 
button in the FastPath Manager), or a reset (selecting the Reset 
button in the FastPath Manager) all result in an "initial state" 
where the FastPath is waiting to receive a command. 
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When it receives the GO 
command, the gateway 
bypasses its 25-second timer 
and begins validating and 
then executing its routing 
code. 

When the gateway receives a 
PAUSE command, it "pauses" 
until it receives a GO or 
RESTART command. If it 
does not receive a PAUSE 
command, the gateway waits 
25 seconds and then begins 
validating and executing 
routing code. 

If the Remote Boot switch is 
turned on, and the download 
module is corrupted, the gateway 
chooses to broadcast a BOO1ME 
packet rather than executing the 
default PROM code. 

Execute 
PROM code 

Figure A-t. FastPath State Diagram 
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A gateway is in its initial state following a RESTART command, 
a RESET command (which also clears configuration data and 
downloaded routing code), or a power on. From its initial state, 
it waits for 25 seconds to receive a command from the FastPath 
Manager. The FastPath will only accept S-records during the initial 
25 seconds before it begins executing gateway routing code. 

If the gateway does not receive any communication from the 
FastPath Manager within the 25-second waiting period and it is 
not "paused," the gateway checks its memory for a valid 
download module and if it finds one, begins executing iti 
otherwise it executes the PROM-resident gateway code. 

• If the gateway receives a GO command during the initial 25 
seconds, it immediately verifies whether the download 
module is valid. If the download module is valid, it starts 
executing it. If the download module is invalid and the 
Remote Boot switch is not turned on (the default), the 
gateway starts executing PROM-resident code. Otherwise, 
the gateway performs a RESTART and is returned to the 
initial state. 

• If the gateway receives a PAUSE command during the initial 
25 seconds, it goes into a "paused" state where it 
continuously checks for commands and does not time out 
after 25 seconds. Selecting Go or Reset takes the gateway out 
of a paused state. Clicking Restart or power-cycling the box 
does not take the gateway out of a paused statei when it 
comes back up it will be in a paused state. (Note that it is an 
error to save configuration data in a file while the gateway 
is in a paused state. The paused state is saved with other 
configuration data, which can confuse the FastPath when 
the configuration file is used.) 

The download sequence 
Unless it has been paused, the FastPath will only accept 5-records 
during the 25 seconds immediately following a RESET, 
RESTART, or power on. When the 25 seconds have passed, it 
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begins executing gateway routing code, and it will not accept S
records while it is executing code. When the gateway receives a 
single S-record, it resets its 25-second timer, so the download 
sequence must begin (but it does not necessarily need to 
complete) within the initial 25 seconds. 

The recommended procedure for downloading K-STAR to the 
FastPath is as follows: 

• Put the FastPath in "initial state" by clicking the Reset or 
Restart button in the FastPath Manager. Reset clears all 
memory locations, while Restart leaves the K-STAR 
download module and configuration information intact. 
Either way, the gateway is in initial state and begins the 
sequence shown in Figure A-1. 

• If you need more than 25 seconds (for example, if you are 
entering configuration data), select Pause. 

• Download K-STAR by using Download a File ... from the 
File menu. If you have paused the gateway and entered 
configuration data, click the Go button. This sends the 
configuration data and the GO command to the FastPath, 
which tells it to immediately verify that the download 
module is valid and then start executing it. 

Hardware self-testing 
When you tum on the power to the FastPath, it conducts several 
brief tests to ensure that its CPU, LEDs, memory and specialized 
circuits are in good working order. During these tests, the three 
LEOs on the FastPath front panel light up. 
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Power LocalTalk interface Ethernet interface 

KINETICS 

F""'1'tII1t4 

Figure A-2. The FastPath LEDs 

The leftmost LED is the power light, indicating that the gateway 
is receiving power. The other two LEOs are the network traffic 
lights for the LocalTalk and Ethernet connections; in normal 
operation, these two LEOs light to indicate packets going 
through their respective connections. 

When both of the network traffic lights have been turned off 
again, the self-testing is complete and successful. If both 
network traffic lights remain on, the tests have revealed a "fatal" 
error; that is, the gateway cannot be used until the problem is 
corrected. If one traffic light remains on, the corresponding 
network interface is inoperable. In either case, if the error 
condition persists you should contact your dealer or Kinetics. 
See "Calling for Help" in the chapter on "Troubleshooting." 

The gateway hardware self-tests are as follows: 

1. Attempt to light the network traffic lights. In normal 
operation, the network traffic lights indicate incoming 
network traffic on the LocalTalk and Ethernet connections. 
The first test turns on all of these lights, thus indicating that 
the CPU, the LED control port, and the LEOs themselves are 
all functional. If this test fails, the lights do not come on. 
This is a "fatal" error; that is, the gateway cannot operate 
until this has been resolved. 

2. Turn off power LED. This LED remains off until the self
tests have completed, unless there is a fatal error. 
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3. Test CPU stack memory. This test writes to and reads from a 
small area of RAM that will be used for further testing. If 
this test fails, the remaining tests are not executed (because 
they would be meaningless). 

4. Test unprotected memory. The areas of RAM that store 
configuration data and downloaded gateway programs are 
protected from being overwritten by test data. The 
remaining RAM, which is used for packet buffers and other 
temporary storage, is unprotected. The third test writes to 
and reads from this unprotected RAM to check its integrity. 

5. The fourth test writes and reads test data on the AppleTalk 
control chip to determine if that chip and its supporting 
circuitry are functional. If the gateway passes this test, it 
turns off the middle LED. 

6. The last test partially initializes the Ethernet control chip 
and writes test data to it, to determine if that chip and its 
supporting circuitry are functional. If the gateway passes 
this test, it turns off the rightmost LED. 

7. If there was not a fatal error, tum the power LED back on, 
indicating the end of the self-test sequence. 

If either of the network traffic lights remain on, the 
corresponding network interface is inoperable. If both of the 
network interfaces are inoperable, both lights remain on as they 
would for a fatal error. 

AppleTalk auto configuration 
AppleTalk protocols always provide for dynamic access of 
minimal configuration information, and the gateway takes 
advantage of this feature when it autoconfigures. This is true 
for both AppleTalk Phase 1 and AppleTalk Phase 2. 

Because the Phase 1 protocols are resident in the Fastpath 
PROM, the FastPath can configure itself for AppleTalk Phase 1 
routing from its initial"reset" state, with no interaction from the 
Fastpath Manager at all. When you power on the Fastpath unit, 
it follows the state diagram shown in Figure A-I. Because the 
gateway is not in a paused state and there is no valid download 
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module, the gateway begins executing PROM-resident 
AppleTalk Phase 1 code. This is the default action for the 
gateway. If the FastPath is returned to a reset state (by clicking 
Reset in the FastPath Manager), it will always attempt to 
configure itself for AppleTalk Phase 1 routing. 

Because the AppleTalk Phase 2 protocols are implemented in K
STAR and must be downloaded once to the gateway, Phase 2 
autoconfiguration requires some minimal interaction with the 
Fastpath Manager before the gateway can automatically acquire 
its configuration data. Specifically, you must return the gateway 
to a reset state (click Reset), and download K-STAR. When the 
gateway finds a valid download module, it begins executing 
that code, and will autoconfigure for AppleTalk Phase 2 routing. 

The FastPath acquires the required configuration data as 
follows: 

• The gateway acquires its own Ethernet address (a unique, 6-
byte hexadecimal number) from PROM. The Ethernet 
address is also printed on a label attached to the bottom of 
the gateway chassis.) 

• The gateway listens for RTMP packets on both interfaces. If 
it finds an existing AppleTalk network number on either 
network, it uses that number. Otherwise it proceeds as 
follows: 

If the LocalTalk network does not have an AppleTalk 
network number, the gateway assumes one, derived from 
the last two bytes of the Ethernet address. If that number is 
in use by another network, the gateway increments the 
number until it finds an apparently unused network 
number. 

If the Ethernet does not have an AppleTalk network 
number, the gateway assumes a network number of 1 (a 
range of 1-1 on AppleTalk Phase 2). If that is in use by 
another network, the gateway tries 2 (or the range of 2-2), 
and continues incrementing until it finds an apparently 
unused network number. 
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• The gateway sends out enquiries on both network interfaces 
for an AppleTalk zone name. If only one of the two 
networks has a zone name, the gateway assigns the same 
name to the other network. If neither network has a zone 
name, the gateway assigns the name Default Zone to both. 

The AppleTalk node numbers for both network interfaces are 
automatically assigned by AppleTalk. In the current AppleTalk 
protocol implementation, each FastPath acquires an 8-bit node 
number for itself as follows: 

• On LocalTalk, each gateway sends out 640 enquiries for an 
AppleTalk node number. If it receives no acknowledgement 
from any other node, it assigns itself the node number. If it 
does receive an acknowledgement, it increments the 
number and tries again. 

• On Ethernet, each AppleTalk Phase 1 gateway sends out 20 
AARP probe packets; each AppleTalk Phase 2 gateway 
sends out 10 AARP probe packets. Just as on LocalTalk, it 
acquires the first unused (unacknowledged) number. 

If the newly installed gateway receives RTMP data that conflict 
with its own automatic configuration data, the gateway uses the 
RTMPdata. 

FastPath protocols and routing 

Gateway code (in PROM or K-STAR) provides routing and 
encapsulation as described in this section. 

PROM-resident AppleTalk routing 
Figure A-3 shows how the PROM-resident gateway code routes 
AppleTalk Phase 1 packets between LocalTalk and Ethernet. 
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AppleTalk packet on LocalTaIk. 

~ oS 
LocaITalk Ethernet ~, LocalTalk 
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~ AppleTaIk EtherTaIk S 
S AppieTaIk EtherTaIk AppleTaik S 
Figure A-3. PROM-resident AppleTalk Phase 1 routing 

EtherTalk is an extension to the AppleTalk protocol suite that 
encapsulates an AppleTalk packet in an Ethernet frame. 
EtherTalk applies to both Phase 1 (in PROM or K-STAR) and 
Phase 2 (in K-STAR). Figure A-4 shows an Ethernet frame with 
EtherTalk Link Access Protocol. 

} ::net I-----'==--====�} Ethernet 
1---.:--:-...... ,..---1 frame 

stin lion Add ..... 
Source Add ...... 

LAPT 

OOP Header and Data 
(2 to 600 bytes) 

ho..n""""ina-t""'io-n""Ad;':d:---1 
Sou"", Addreos 

LAPT 

DDP Header and Data 
(2 to 600 bytes) 

EtherTalk Phase 1 packet. An 
AppleTalk packet looks like this 
after leaving the FastPath destined 
for Ethernet. 

OOP Header and Data 
(2 to 600 bytes) 

EtherTalk Phase 2 packet An 
AppleTalk packet looks like this 
after leaving the FastPath destined 
for Ethernet. 

Figure A-4. EtherTalk packets: AppleTalk on Ethernet 
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The AppleTalk protocols supported by the gateway are 
described in Table A-l. 

Table A-t. AppleTalk Protocols 

Protocol 

ALAP 

AARP 

DDP 

RTMP 

Function 

(AppleTalk Link Access Protocol). Encapsulates 
data into frames and permits nodes to access 
transmission lines for sending and receiving frames. 

(AppleTalk Address Resolution Protocol). Maps 8-
bit EtherTalk addresses to Ethernet hardware 
addresses. In AppleTalk Phase 2, AARP handles 24-
bit addresses. 

(Datagram Delivery Protocol). Extends the ALAP 
function of frame delivery across AppleTalk 
networks and permits addressing of individual 
sockets on nodes. On extended networks, DDP 
provides for zone multicasting (used mostly by 
NBP) and network-specific broadcasts. 

(Routing Table Maintenance Protocol). Establishes 
and maintains routing tables. RTMP routing tables 
allow bridges and gateways to connect networks 
into an internet and route packets from one cable to 
another. 

In AppleTalk Phase 1, AppleTalk bridges and 
gateways on the network continuously send RTMP 
packets every ten seconds to a broadcast Ethernet 
address. The packets contain that gateway's ID, 
network number, a list of the networks the gateway 
knows about, and the distance of those networks 
from the gateway (their "hopcount"). In AppleTalk 
Phase 2, the gateway continuously sends RTMP 
packets every ten seconds to a multicast broadcast 
Ethernet address. The RTMP packets contain all of 
the information contained in Phase 1 packets, and 
also handle network ranges. The gateway must 
maintain a routing table on a range-by-range basis 
for extended networks, with each range associated 
with a list of zone names. 
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Protocol Function 

NBP (Name Binding Protocol). Maps names (user
designated character strings) Into appropriate 
addresses on the internet. NBP also maps names to 
services. In AppleTalk Phase 1, when users request 
AppleTalk services (such as a printer), the request is 
sent to the gateway in the form of an NBP lookup. 
The gateway looks in the NBP packet to find which 
zone the request is for. It then sends a directed 
broadcast to all networks in that zone. In AppleTalk 
Phase 2, NBP lookups outside the local net are 
changed to a new packet type called an NBP 
forward request. These are forwarded to other 
gateways that are directly connected to a cable 
associated with a zone name, and the lookup 
request is multicast to all nodes in that zone. If the 
lookup is directed to zone '.', the gateway changes 
• to the source node's zone before forwarding the 
lookup request. 

ZIP (Zone Information Protocol). In AppleTalk Phase 1, 
maps networks to zone names on the internet, and 
acquires zone information from routers and 
propagates it around the internet. When a router 
gets an RTMP message indicating the presence in 
the internet of a new network, the router sends a 
"ZIP Request" packet to the bridge that sent the 
RTMP packet. This bridge sends back a ZIP Reply 
packet, which contains the zone name for the 
network. In AppleTalk Phase 2, ZIP has been 
modified to obtain zone multicast addresses and to 
verify valid zone names for a given node. 

ATP (AppleTalk Transaction Protocol). A basic transport 
protocol that detects errors and timeouts, providing 
loss-free transaction services. The ATP mOdule 
supports only that minimal functionality required to 
support the ZIP protocol. 

Echo A support protocol that provides a way for a node 
to ''bounce'' a packet off another node. 
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K-STAR AppleTalk Phase 2 routing issues 
The FastPath maintains internal tables of zone names and 
associated network numbers. If it receives a packet destined for 
an extended network, it looks up the network number in its 
internal tables and routes the packet to the proper cable. If the 
packet is destined for node 0, it is routed only to gateways. 

When a node boots up on the network, the gateway provides it 
several pieces of information, including the gateway's address, 
the network range, the zone list, and the zone multicast address 
for that node's zone. The node AARPs for a valid network 
number and an unused node number. AppleTalk Phase 2 
reserves the node numbers $00, $FE, and $FF, thereby limiting 
the total number of nodes associated with a single network 
number to 253. (IT the gateway is not available, the node uses a 
network number from a default "startup range" of 65,280---65,534.) 

The zone multicast address is used to prevent NBP broadcasts 
from interrupting all AppleTalk nodes on the cable. When a 
router receives an NBP FwdReq (forward request) for a 
particular zone, it directs the packet to the zone multicast 
address and it is received by all nodes in that zone. The 
FastPath processes NBP packets both at the source end and 
destination end in AppleTalk Phase 2. If it receives a BrRq with 
the zone name of '*', it changes" to the source node's zone name 
and changes the packet type from BrRq to FwdReq. It then 
checks its internal routing tables and forwards the packet to all 
networks in that zone. When the packet is received by another 
gateway that is directly connected to one of the destination 
networks, that gateway changes the NBP packet type to LkUp 
and sends it as a zone-specific multicast on that cable. 

K-STAR routing and encapsulation 
Figure A-5 shows the routing and encapsulation methods 
supported in the K-STAR download code. 

FastPath Operations A-13 



K-STAR routes 
AppleTalk Phase 1 
and AppleTalkPhase 

2 packets on LocalTalk { 
and Ethernet. ~ 

K-STAR encapsulates 
TCP lIP packets in 

~~~a: :!tsr:,::es { 
LocalTalk. ~ 

When the Mac is on 
Ethernet, K-STAR will 
strip the AppleTalk { 
encapsulation off --
TCP lIP packets and 
send them to an IP 
host on Ethernet. 

K-STAR encapsulates 
AppleTalk packets in.......
UDP and routes them 
to IP hosts on 
Ethernet. The IP hosts 
must know how to 
decode the packets 
(i.e., CAP or AUFS). 

K-STAR encapsulates /' 
DECnet packets in /' . 
DDP and routes them 
on LocalTalk. The 
Macintosh must know 
how to decode the 
packets. 

~, 
LocaITalk Jl: 

I 

AppleTaik 

AppleTaik 

TCP liP within 
App1eTaik 

TCP lIP within 
AppleTaik 

AppleTaik 

AppieTaik 

App1eTaik 

DllCnet within 
AppieTaik 

DllCnet within 
AppleTaik 

I 
I 
I 
I 
I 
I 
I 

Btl".,Talk 

TCP/lP 

TCP/lP 

Ethemet 

S 
EtherTaik 

S 
TCP/IP 

AppleTalk within 
UDP 

AppleTaik within 
UDP 

AppleTaik within ~ 
UDP --

DBCnet 

DBCnet 

DBCnet 

Figure A-S. K~STAR routing 
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Note that all these configuration methods can co-exist on a 
gateway when K-STAR has been downloaded. 
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Figure A-6 shows two examples of K-STAR encapsulation 
operations: a DDP packet encapsulated in UDP, and an IP 
packet encapsulated in DDP and an Ethernet frame. These are 
representative of gateway encapsulation operations. 

When the gateway receives an 
AppleTalk packet destined for an 
IP host (a CAP or AUFS system), it 
encapsulates the packet in UDP 
and routes it to the host. The 
packet looks like this when it 
leaves the gateway destined for 
Ethernet 

When the gateway receives an 
IP packet destined for 
LocalTaJk, it strips off the 
Ethernet frame, encapsulates 
the packet in DDP, and routes it 
to the AppleTalk node (which 
also speaks TCP lIP). The 
packet looks like this when it 
leaves the gateway destined for 
LocalTalk. 

Destination Addr •• ,,
Source Address 

LAP Type 

DDP Head ... and lAta 
(2 to 600 bytes) 

Data 

DDP Header and Data 
(2 to 600 byte.) 

IP 
encapsulation 

1--=:;~i-iiF==---i I ~~~psulation 

lAta 

Figure A-6. Examples of K-STAR encapsulation 
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If a DDP datagram originates within the AppleTalk internet and 
is destined for a host within the IP internet, it is first 
encapsulated in a UDP datagram. The destination process must 
perform decapsulation. 

Similarly, if IP packets (TCP lIP or UDP lIP) arrive at the 
gateway from the AppleTalk internet encapsulated in bDP ILAP 
packets, they are decapsulated and routed to the IP internet over 
the Ethernet. If the IP packets arrive on the Ethernet interface 
destined for an Internet address that is a node within the 
AppleTalk internet, they are encapsulated into DDP I LAP and 
routed to that destination. 

The Internet Protocols supported in K-STAR IP are shown in 
TableA-2. 

Table A-2. Internet Protocols 

Protocol Function 

IP (Internet Protocol). Provides datagram service 
between hosts and handles packet routing, 
fragmentation and reassembly. 

ICMP (Internet Control Message Protocol). Allows 
gateways and hosts to send error or control 
messages to other gateways or hosts. The gateway 
can determine the best route to a destination host 
using ICMP redirects. 

ARP (Address Resolution Protocol). Maps an IP address 
to the Ethernet address for that host. 

TCP (Transmission Control Protocol). Provides reliable 
data exchange between processes on different hosts. 

UDP (User Datagram Protocol). Provides unreliable 
connectionless datagram delivery service. Allows 
applications to send datagrams with a minimal 
protocol mechanism. 
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Protocol Function 

RIP (Routing Information Protocol). The RIP module in 
this implementation only broadcasts information at 
the required frequency; it does not respond to RIP 
requests nor does it issue updates. Turning on 
Option 10 will prevent the gateway from 
broadcasting RIP packets. 

PROM-resident IP routing 
Figure A-7 shows the protocols used to route IP packets in an IP 
configuration using the /lIP SUBNET" code resident in the 
gateway's PROM. 

LocalTalk 

TCP/lPwithln 
App1eTaik 

_ TCP/IPwithin 

AppleTaik 

oS 
~, 
~: 

I 

Ethernet 

TCP/IP 

TCP/IP 

LocalTalk 

TCP lIP withln 
Apple Talk 

Figure A-7. PROM-resident IP Routing 

In this situation, the Macintosh encapsulates IP packets that 
originate on the LocalTalk side in DDP, and sends them to the 
gateway. The gateway then strips off the AppleTalk data and 
sends the packet across Ethernet. 
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If the destination node is on another LocalTalk network across 
an Ethernet backbone, the gateway on the destination LocalTalk 
network encapsulates the IP packet in DDP again for 
transmission to the IP node on LocalTalk. 

Note that the PROM-resident IP is supported only for backward 
compatibility in the FastPath 4. K-STAR IP is the recommended 
IP routing method. The PROM-resident IP configuration 
method has been renamed to /lIP Subsectioning" (previously 
called '1P Subnetting") to avoid confusion with standard IP 
subnets. 
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A p p E N D I x B 

FastPath Manager Reference 

THIS ApPENDIX PROVIDES A REFERENCE FOR TIlE FASTPATH MANAGER 

software. It is organiZed by the program's screens and dialog 

boxes as follows: 

• Gateway selection window 

• Diagnostics window 

• Main configuration dialog box 
Log Messages window (click the Log ... button) 
Options dialog box (click the Options ... button) 

• K-STAR IP dialog box (Configuration menu and area) 

More dialog box (click the More button) 

• DECnet dialog box (Configuration menu and area) 

• AppleTalk Phase 1 dialog box (Configuration menu and area) 

• IP Subsectioning dialog box (Configuration menu and area) 

The FastPath Manager menus are described at the end of this 

Appendix. 
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About the FastPath Manager 

The FastPath Manager is a Macintosh application that 
communicates with the gateway. It is the mechanism for 
downloading code (K-STAR or customized code developed at 
your site) and sending configuration information to the gateway. 

The FastPath Manager is always launched on a Macintosh on a 
LocalTalk or Ethernet network connected to the gateway. 

• When the Macintosh is connected to LocalTalk, the 
application continuously receives diagnostics from the 
gateway(s) on that interface and displays the messages in a 
Diagnostics window. 

• When the Macintosh is connected to Ethernet, the 
Diagnostics window does not display messages from the 
gateway; however, you can still see diagnostics by clicking 
the Log ... button in the FastPath Manager. 

To launch the FastPath Manager application, double-click on its 
icon. The gateway selection window appears (see the section on 
"Gateway Selection Window"). 

To download code to the gateway, select Download a File ... 
from the File menu and open K-STAR (Version 8.0 or higher). If 
you are downloading customized code developed at your site, 
open that file. 

To send configuration information to the gateway, click the Go 
button. This sends the configuration information that is 
currently in the FastPath Manager windows and tells the 
gateway to start executing the download module (or the PROM
resident code, if no download module is present). 

To close the FastPath Manager, select Quit from the File menu. 
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Gateway selection window 
When you first launch the FastPath Manager, a brief copyright 
notice displays, followed by the gateway selection window: 

Select a FastPath to Configure: 
[Node 2201 :!1 

(cancel) 

You can display the gateway selection window by selecting Find 
All ... from the Gateways menu at any time. 

The data field in this window displays a list of all the gateways 
on the local network (the network the Macintosh is connected 
to). The gateways are listed by the name you have assigned to 
the gateway (using the Name command in the Gateways menu), 
or by a default name. Before you have assigned a name to the 
FastPath, a default name appears; on the LocalTalk interface, 
this is likely to be "[Node 220]," which is a temporary name built 
by the FastPath Manager based on the AppleTalk node ID of the 
LocalTalk interface. On the Ethernet interface, the temporary 
name is built using the AppleTalk node ID of the EtherTalk 
Phase 1 interface. 

You can open one gateway from this list by selecting the name 
and clicking Open, or by double-clicking on the name. If you 
want to open more than one gateway, select Find All ... from the 
Gateways menu and repeat the process. A configuration dialog 
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On LocalTalk, these 
messages are continually 
updated; click Stop to 
keep a message on the 
screen. 

If you close this window 
by clicking in the "close 
box," it will not 
automatically reappear 
the next time you click 
Go. Instead of explicitly 
closing this window, you 
should click in the 
configuration dialog box 
to bring it to the 
foreground. 

box will be open for each of the open gateways, and will be 
listed by the gateway's name under the Windows menu. You 
can configure a specific gateway by pulling down the menu and 
selecting the desired gateway name. 

Diagnostics window 

The Diagnostics window displays briefly before the main dialog 
box comes up, and is open in the background while you are 
using the FastPath Manager. 

=0 Diagnostic Packets 

( Stal1 ) ( Stop) ( Sllll.~ ) Packets R.".luacl: 

(0) Noda 220 
524553 45 54 
(I) Noda 220 
49 411 50 53 20 41 54 23 20 32 32 3D 20 45 54 23 
20 31 35 32 20 50 52 4F 4D 20 52 45 SCi 20 34 2E 
31 20 29 38 38 2F 31 30 2F 30 37 29 20 53 54 41 
54 45 3D 42 45 20 41 20 42 52 4Q 44 47 45 20 48 
57 20 53 54 41 54 55 53 3D 38 
(2) Noda 220 
524553 45 54 
(3) Noda 220 
49 46 50 53 20 4\ 54 23 20 32 32 30 20 45 54 23 
20 31 35 32 20 50 52 4F 40 20 52 45 SCi 20 34 2E 
31 20 28 38 38 2F 31 3D 2F 30 37 29 20 53 54 41 
54 45 30 42 45 2D 41 20 42 52 4Q 44 47 45 20 48 
57 20 53 54 41 54 55 53 3D 38 

... 
Hexadecimal representation 

RESET 

KFPS RT- 220 ET-
152 PROM REV 4. 

I (88/10/07) STR 
TE=9E A BRIDGE H 
W STRTUS~8 

RESET 

KFPS AT- 220 ETa 
152 PROM REU 4. 

I (88/10/07) STR 
TE-BE A BRIDGE H 
W STATUS-a 

English representation; 
see Appendix C for an 
explanation of these 
messages. 

If the FastPath Manager is running on a Macintosh on LocalTalk, 
the Diagnostics window dynamically displays up to 32 K-bytes 
of data as it receives the data from the gateway. If there is more 
than one working gateway on the LocalTalk net, it receives 
messages from all gateways. The messages start displaying in 
this window when the FastPath Manager receives a message 
from a gateway and the window is dynamically updated as new 
messages are received. 
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See the section on the Log window for an alternative way to 
view messages, including those that were generated before you 
launched the FastPath Manager. 

The Diagnostics window automatically comes to the foreground 
upon receipt of the first diagnostic message after you click Go in 
the FastPath Manager. You can bring the Diagnostics window 
to the foreground at any time by selecting Diagnostics from the 
Windows menu. 

1111" If you close this window by clicking in the "close" box in the 
upper left corner of the main configuration dialog box, it will 
not automatically appear in the foreground after you click Go. 
In this case, you need to open the window using the Windows 
menu. 

See Appendix C for documentation on the FastPath diagnostic 
messages. 
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Main configuration dialog box 

The main configuration dialog box displays data on the gateway 
and accepts AppleTalk Phase 2 configuration data: 

o QilteWillj 1 

r- Glt • ..,I" -.-.-----..... ----------------.---.-----. r-.confilJluntfon .. -·.., 
I, Fe,tPath"" Seri.1 Number: 100766 PROM Ver,ion: 4.1 I ~I Currentl\1 Do .... nl0.d.d File: Nfl", I I Lilt Conllgurltton D.te: NfI",I',," INt ~EY£7' , 

I AT.lk Ph ... 2 
K-STAR IP 

i DECnet I 
I ATal k Phase I tol I Current Configuration file: NIl", I 

L...!~hlrnetAddrea.: OBOOBIlAOOOIB J LL Edit l .. J I I 

["- Locanalt Interfac. -----.--------~ ,....SvUches----·-.. , 
I AppleTal k Zone Neme I i 181 Huto Config I I AppleT.lk Net Number 10 Remote Bootl 
. Appl.T.I k Node Number 

r- Etherralt P •• I Z ( Log... ) 
I Ra"IJII Start 10 Range End ~ [ 0 t- ) I . ~ pIOns ... 

ET.lk Z.O Net Number 0 [ Reset ] 
I ET.lk 2.0 Node Number a [ lone List ••• ) .. -

1- Help 
______ ._._ .. __ ._ ( Restort ) 

( liD ) 

I 
11. ••••• _---_ .... "--_ ........ __ .... _---_ ...... _-. 

( Pouse ) 

The gateway's name is displayed in the bar at the top of the 
window. The Help area at the bottom of the window displays 
information about the button or area of the window you are 
currently using. 

The other areas of this window are described in the sections 
below. 
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The Gateway area of the main dialog box contains display fields 
related to the gateway itself and its configuration: 

~- ClteYI v ----.-----..... -..... --.. --.. ---... -.--.----------..... -..... ---------·-··---·-·-1 I fastPath"" Serial Number: I 00766 PROM Version: 4.1 I 
I Currentl y Do',lnloaded rne: No", i 
I last Configuration Dete: No",41_IMI RESEr ! 
I Current Configuration Fne: No", I 
• Ethernet Address: 080089AOOO 18 I l __ .. ____ .. ______ .. _____ . __________ .. ______ . ___ .. ______ ... _______ .... __ ... __ ._ ............ _j 

FastPath™ Serial Number: If you enter the gateway's serial number using the Gateway 
menu, it is displayed in this field. The gateway does not use 
this information; it is for administrative use only. 

PROM Version: This field displays the version number of the gateway's PROM, 
which it obtains from the gateway. This version number is 
important when you use different versions of K-STAR or of the 
FastPath Manager; these programs must be compatible with the 
gateway PROM. You can check the version number of the 
FastPath Manager using the Get Info command on the 
application file from the Macintosh Desktop, or use "About 
FastPath Manager" under the Apple (ti) menu if the FastPath 
Manager is running. FastPath Manager Version 5.1 or higher 
and K-STAR Version 8.0 or higher require PROM version 4.1 or 
higher. 

Currently Downloaded File:When you download K-STAR (or site-specific gateway code), 
the name of the download file is displayed here. Clicking Reset 
clears this field. 

Last Configuration Date: When you configure (or reconfigure) the gateway, this field is 
updated with the current date and time. Clicking Reset clears 
this field. 

Current Configuration File: This field shows the filename of the configuration file currently 
being used by the gateway. Clicking Reset clears this field. 

Ethernet Address: This field displays the Ethernet address that the gateway 
acquires from PROM. This field is not modifiable. 
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AppleTalk Zone Name 

The LocalTalk Interface area of the main dialog box accepts 
AppleTalk Phase 2 configuration data for the network connected 
to the gateway's LocalTalk interface: 

,-. LocalTall1: I nterface -------------.--.-----------------.-----------'! 
'I AppleTll k Zone Name I I i 

AppleTll k Net Number 0 I ! 
! AppleT81k Node Number 220 i , , 1 .. _ .... _ .. _ .. - .. _ .. __ .. _ .. _-_ .. - .. _ .. __ .. _ .. - ......... _ .. _ .. _ .... _ .. - .. _ .... - •• _ .. __ ....... ______ .. _ .. __ _ 

This field must contain either the default asterisk (*) or a zone 
name, which is a character string between 1 and 32 characters 
which may include embedded spaces. The gateway considers a 
character to be invalid in a zone name if its ASCII value is less 
than hex 20 or equal to hex 7F. This field cannot be blank; if you 
blank it out the defaults will be assumed. The asterisk causes the 
gateway to acquire a zone name from another gateway or (if the 
gateway is set up to autoconfigure) to use the name "Default 
Zone." Note that all gateways on the internet must agree about a 
particular network's zone name. 

AppleTalk Net Number This field must contain the default zero (0) or a decimal number 
within the range of 1-65,279. This field cannot be blank; if you 
blank it out the defaults will be assumed. The default 0 causes 
the gateway to use information it acquires from another 
gateway (seeding), or, if the gateway is set up to autoconfigure, 
to find an unused AppleTalk net number and assign it to the 
LocalTalk network. A decimal number entered in this field 
becomes the net number for the network connected to the 
gateway's LocalTalk interface. The AppleTalk network number 
must be unique for every network on the internet. 

AppleTalk Node Number This field displays a number that is assigned automatically by 
AppleTalk when the gateway is started on the network. It 
cannot be changed manually. 
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The EtherTalk Phase 2 area of the main dialog box accepts 
AppleTalk Phase 2 configuration data for the network 
connected to the gateway's Ethernet interface: 

~- Et be rT.1 II: P basI 2 .------------------------------------------.-, I Range Start I 0 I Range End I 0 I I 
i ETelk 2.0 Net Number 0 I 
I ETalk 2.0 Node Number 0 [ Zone List ... ] I ______________________________________________ ._. _____ ----------______ 1 

Range Start This field must contain either the default 0 or a decimal number 
between 1 and 65,279. The default 0 here and in the Range End 
field causes the gateway to acquire the network range from 
another gateway on the Ethernet interface, or, if the gateway is 
set up to autoconfigure, to find an unused AppleTalk net 
number and assign it to the EtherTalk Phase 2 network. 

Range End This field must contain either the default 0 or a decimal number 
between 1 and 65,279, which must be greater than or equal to 
the number in the Range Start field. The default 0 here and in 
the Range Start field causes the gateway to acquire the network 
range from another gateway on the Ethernet interface, or, if the 
gateway is set up to autoconfigure, to find an unused AppleTalk 
net number and assign it to the EtherTalk Phase 2 network. The 
network range must be unique in the internet: no two networks 
can use the same number, and no two network ranges can 
overlap or have any network numbers in common. All 
gateways on a network must agree on the range for the 
network. 

ETaik 2.0 Net Number This field displays the network number chosen by the gateway 
as a node on EtherTalk Phase 2. It cannot be changed manually. 

ETaik 2.0 Node Number This field displays a number that is assigned automatically by 
AppleTalk when the gateway is started on the network. It 
cannot be changed manually. 

Zone List... Click this button to open the Zone List dialog box shown on the 
next page. 
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t 

Unless you explicitly select 
another zone name and click 
the Default button, the first 
name you enter in the Zone 
Name field will be the defaul 
zone. The default zone nam 
appears next to the "Default 
Zone:" field at the top of the 
screen. All gateways on an 
Ethernet must agree about th 

e 

default zone. 

Select a configuration 
method from the menu to 
change the listing in the 
Configuration area. 

e 

Double-click on the entry 
or select it and click the 
Edit button to open a 
dialog box for the selected 
configuration type. 

Zon~ List 

Dafault Zona: 

~ 
( I)t~ toult ) 

( Rt~I)I'lce ) 

~ ( O(ilete ) 

Zone Name: 

I I I "lId I 
( OK ) ( cancel) 

Enter a zone name in the "Zone Name" entry field, and click Add 
to add it to the EtherTalk Phase 2 Zone list. The zone list should 
contain one or more zone names (a character string between 1 
and 32 characters which may include embedded spaces). The 
asterisk is not allowed as a zone name in Phase 2. The gateway 
considers a character to be invalid in a zone name if its ASCII 
value is less than hex 20 or equal to hex 7F. If you do not enter 
one or more zone names for EtherTalk Phase 2, the gateway 
acquires its zone names from another gateway on EtherTalk 
Phase 2, or, if it is set up to autoconfigure, uses the name 
"Default Zone." 

The Configuration area of the main configuration dialog box 
displays a list of configuration types that reflects the 
configurations selected in the Configuration menu. 

.lDEenet 

.lRTalk Phase 1 
IP Subsect 

roCo.fi g u ret, 00----; 

i ATalt Phase Z 21 I Ie-STAR IP I I DECnet 01 ! ATalie Phase I 
i I -----------11--[ Edit ) I 
._-_._ ••••••• _-------_. ____ .• _1 
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Auto Config 

Remote Boot 

The first four configuration types in the Configuration menu are 
implemented in the K-STAR code, and can be used together on 
the same gateway. The IP Subsectioning configuration uses 
PROM-resident code, and is provided for backward 
compatibility only. 

To add a configuration type to the Configuration area, select it 
in the Configuration menu. 

To supply configuration data, select a configuration type in the 
Configuration area and click Edit, or double-click on the listing 
for that configuration type. 

The Switches area contains two software switches: 

;--Svl tc hes·---------l 
i 181 Ruto Con rig i 
10 Remote Boot I 
"_ .. __ .. _ .. _ .. _ .. ____ .. ___ 01 

The Auto Config switch is on by default. It is automatically 
turned off when you send the gateway configuration data that 
includes a non-zero net number, zone name, or when Option 17 
is enabled, and close the configuration window. (That is, the 
gateway will only autoconfigure if the net numbers and zone 
names on all interfaces are not configured and (for K-STAR) if 
Option 17 is not enabled.) When you reset the gateway, this 
switch is on again until you send configuration data again. 
When you deselect this switch and send that information to the 
gateway, it explicitly puts the gateway into "seed" mode. 

The Remote Boot switch is off by default. If it is turned on and 
the gateway does not find a valid download module, the 
gateway sends out a "BOOTME" packet (one every 25 seconds) 
and waits for further instruction, rather than autoconfiguring 
with the default AppleTalk Phase 1 routing. This is intended for 
use with a remote boot server, but it is recommended when 
using the K-STAR download module. Even if the internet does 
not support a remote boot server, it is generally easier to detect 
an error condition if the gateway suspends operation rather 
than autoconfiguring. 
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Log ... 

( Options ... ) 

( Reset) 

( Restart) 

( Go ) 

( pause) 

To see additional 
messages (if any), use 
the scroll bars at the 
right of the window. 

To return to the main 
dialog box, click 
Continue. 

The six buttons in the lower right comer of the main 
configuration dialog boxes are as follows: 

The Log ..• button reads a buffer in the gateway's memory, opens 
the Log Messages window and displays the buffer contents 
there. The messages are limited to 586 or fewer characters, 
which are stored in the gateway's buffer until they are displayed 
or overwritten by new messages. You can thus see the most 
recent messages that were generated when the FastPath 
Manager was not running. 

Log Messages: 

- KFPS AT- no ET- 152 PROH REV 4. I (88'10'07) STRTE-aE R BRIDGE.... 10 
STRTus-B F 

(continue) Print 

See Appendix C for documentation on the FastPath diagnostics. 

The Options .•• button causes the Options dialog box to appear. 
This dialog box lets you set option flags that provide additional 
functionality to control aspects of gateway routing. All options 
are turned off by default. To tum an option on, click in the box 
next to the option flag number. An X appears in the selection 
box when the option is ON. To tum it off again, click again on 
the selection box. If the option is not defined, selecting it will 
have no effect on the gateway. 
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Option Flags 

( Cancel) rp~tiD~. n.~'. ~o ~ l~ ~~: I 
1 II 19 27 I 

I 04 12 20 28 II & II 21 29 
, 14 22 10 

I 7 1& 21 31 I • 16 204 32 J -_._--_._-
, OK ] 

I
rpt~~. :;r;;-:ar~o 00 00 00 --"---'-'--'---'j 

00 00 00 00 00 00 00 00 0 ASCII I 
00 00 00 00 00 00 00 00 
DO DO 00 00 00 00 DO 00 @) HeHodeclmol 

• .. ....... __ ._ ....... _ ... _1 r1P.---.---.-----.---

l ! ----' 

The following definitions apply to Option flags in this window. 

Not defined. 

2 (Can be used with all configuration types, including PROM
resident.) Tells the Ethernet controller to stop looking for a 
carrier sense (CRS) signal. This is primarily for use on 
broadband networks if Ethernet transmission errors are 
consistently seen. If the Ethernet transmission error is caused 
by a different condition, setting this option will not cause the 
message to stop appearing. 

3 (Seldom used; this option can only be used with the PROM
resident IP Subsectioning configuration type.) By default, the 
gateway forwards packets to an IP router when the packet is not 
destined for the Ethernet/IP network. If the Ethernet/IP 
network is subnetted, use this option to supply the Ethernet 
side's subnet mask as the first 4 bytes in the Option Parameters 
field. 

4 (K-STAR must be downloaded.) By default, the gateway uses 
standard IP broadcasting with all ones in the host portion of the 
IP address. This option tells K-STAR to calculate a 4.2 BSD
compatible IP broadcast address with all zeroes in the host 
portion. 
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5 (K-STAR must be downloaded.) Encapsulate all EtherTalk 
Phase 1 gateway traffic in UDP lIP and do not send RTMP 
packets on Ethernet. This option works only on EtherTalk Phase 
1; see Option 18 for automatic EtherTalk Phase 2 encapsulation. 
When this option is set, you must launch the FastPath Manager 
on a Macintosh on the LocalTalk interface of the gateway. If the 
Macintosh is on Ethernet, it will not be able to find the gateway. 

6 (Seldom used. This option can be used with all configuration 
types, including PROM-resident. It is used primarily for 
compatibility with early versions of K-Talk on UNIX hosts.) By 
default, the gateway uses AARP (AppleTalk Address Resolution 
Protocol) packets for AppleTalk address resolution. If this 
option is set, it continues to use AARP but also uses a variant of 
IP-style ARP packets. 

7 (K-STAR must be downloaded.) Tell the gateway to administer 
IP addresses for Macintoshes that are physically connected to 
the gateway's LocalTalk or Ethernet interface, andlor to a 
LocalTalk network accessible to the gateway across Ethernet. 
See "Distributing Macintosh Clients" in Chapter 3. All of the 
Macintoshes must be in the zone configured on the gateway's 
LocalTalk interface. Do not use this option if you have more 
than one gateway configured for K-STAR IP in this zone. 
Note also that Option 7 does not work if Option 8 is set. 

8 (K-STAR must be downloaded.) By default, the gateway 
responds to NBP proxy ARP requests for IP addresses that it 
knows about but that are not its clients. (Because of the way it 
assigns IP addresses dynamically, the gateway never responds 
to NBP proxy ARP requests for its client IP addresses.) If this 
option is set, the gateway responds to NBP ARP requests only 
for its own IP address. Do not use this option if you have more 
than one gateway configured for K-STAR IP in the AppleTalk 
zone that is configured on the gateway's LocalTalk interface. 
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9 (K-STAR must be downloaded.) IP split addressing. This option 
tells the gateway to use a separate IP address as the starting 
point for Macintosh client addresses. The address is supplied in 
the K-STAR IP "More" screen in Parameter #1 field, and may be 
on the Ethernet/IP network or on a different IP network. In the 
latter case, K-STAR broadcasts RIP packets on Ethernet with 
information about the new network. Note that the RIP module 
in this release can only broadcast information. See the "Option 
9" examples in Chapter 3. 

10 (K-STAR must be downloaded.) Prevents the gateway from 
broadcasting RIP packets under any circumstances. If Option 10 
and Option 9 are both set, you must statically configure the 
route to the new IP network on other IP hosts. 

11 (K-STAR must be downloaded.) This option tells K-STAR to use 
the new NIC range of well-known DDP ports, beginning at 200 
(instead of the previous KIP range beginning at 768). See 
"Using the New UDP Port Numbers" in Chapter 3. 

12 Not defined. 

13 (K-STAR must be downloaded.) Prevent users on the LocalTalk 
side of the gateway from seeing AppleTalk services outside their 
zone. When this option is set, the FastPath checks the 
destination zone name in NBP broadcast request packets (the 
zone selected in the Chooser, in which services may be 
registered). If it is the same zone as the source network, the 
packet is processed normallYi otherwise, it is dropped. See 
II AppleTalk Zone Security" in Chapter 2. 

14 (K-STAR must be downloaded.) Hide LaserWriters on the 
LocalTalk side of the gateway from users in other zones. When 
this option is set, the gateway examines NBP reply packets. If 
the LocalTalk zone name of the gateway is one of the zones for 
the source net, and if the LocalTalk zone of the gateway is not 
one of the zones for the destination net, the gateway filters the 
NBP packet for a tuple with the type LaserWriteri if it finds one, 
that tuple is removed from the packet. If the packet has any 
valid tuples after this processing, it is forwarded, otherwise it is 
dropped.This option is recommended only for gateways with 
low network traffic because it is expensive in processor 
resources. See II AppleTalk Zone Security" in Chapter 2. 
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15 (K-STAR must be downloaded.) Hide AppleTalk services whose 
names end in a tilde (-) on the LocalTalk side of the gateway 
from users in other zones. You need to add a tilde at the end of 
the name of AppleTalk services you wish to protect in this way. 
When this option is selected, the gateway examines NBP reply 
packets. If the LocalTalk zone name of the gateway is one of the 
zones for the source net, and if the LocalTalk zone of the 
gateway is not one of the zones for the destination net, the 
gateway filters the NBP packet for a tuple with an object name 
that ends with a tilde (-); if it finds one, that tuple is removed 
from the packet. If the packet has any valid tuples after this 
processing, it is forwarded, otherwise it is dropped.This option 
is recommended only for gateways with low network traffic 
because it is expensive in processor resources. See" AppleTalk 
Zone Security" in Chapter 2. 

16 Not defined. 

17 (K-STAR must be downloaded.) Enable AppleTalk Phase 1 
protocols in K-STAR.1f Option 17 is set and Option 18 is not set, 
the gateway is a transition bridge. If Option 17 and 18 are both 
set, K-STAR routes only AppleTalk Phase 1 packets. See 
Chapter 2 for more information. 

18 (K-STAR must be downloaded.) Tum off EtherTalk Phase 2 
protocols in K-STAR. If Option 17 and 18 are both set, K-STAR 
routes only AppleTalk Phase 1 packets. If Option 18 is set and 
Option 17 is not set, the gateway encapsulates all AppleTalk 
traffic in UDP lIP. 

19-32 Not defined. 

Option Parameters This area provides 32 bytes of parameter space. This is raw data 
space that can be divided up as required by any program that 
reads it; it is intended to provide space for parameters that may 
be required by network applications that access the gateway. 
You can supply ASCII or hexadecimal data by selecting one of 
the buttons at the right of this area (ASCII to enter ASCII 
characters or Hexadecimal for hex numbers) and then enter the 
appropriate data. Use the mouse to move the cursor to the 
specific character where you want to start typing. When you 
type, you overwrite the existing characters (initially all zeroes); 
you do not insert new characters between them. Pressing the 
Backspace or Delete key moves the cursor backward but does 
not alter any characters. 
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Reset ) 
Restart ] 

Go ) 
Pause ) 

The Reset button clears all of the gateway's memory locations, 
leaving the gateway in the initial state. After resetting, the 
gateway waits for 25 seconds before it autoconfigures using 
PROM-resident AppleTalk Phase 1 protocols. When you click 
Reset, the following screen appears: 

This will cause all programs and data In 
the gateway to be lost. Are you sure? 

[ancel I YES J 

Click Yes to reset the gateway, or Cancel if you change your 
mind. When you click Yes, the gateway sends a RESET 
message. You need to select and open the gateway again 
following a Reset. If you need more than 25 seconds between 
the time you click Reset and the time you click Go in the 
FastPath Manager, click Pause to prevent the gateway from 
executing gateway code. See Figure A-I in Appendix A for more 
information on the Reset sequence. 

The Restart button sends the gateway all configuration data 
from the current session and tells it to start executing the 
download code (or the PROM-resident code, if no download 
module is found) after 25 seconds. The following window 
appears: 

This will restart eKetutlon of the RRM 
program in 25 saconds. Rra you sura? 

[ancel I YES I 

Click Yes to restart the gateway, or Cancel if you change your 
mind. When you click Yes, the gateway sends a REBOOT 
message. Twenty-five seconds later, the gateway program is 
restarted or the PROM code is started, if a valid gateway 
program is not found. This is the equivalent of power-cycling 
the gateway. 

To get around the 25-second delay following a Restart, you can 
select and open the gateway again and click Go. See Figure A-I 
in Appendix A for more information. 
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The Go button sends the gateway all configuration data from 
the current session and tells it to start executing the download 
code (or the PROM-resident code, if no download module is 
found). Use this button after you have completed configuring 
the gateway. See Figure A-1 in Appendix A for more 
information. 

The Pause button has no effect when the gateway is executing 
routing code. It only functions during the 25-second interval 
after a Restart or Reset. If you click Pause within 25 seconds 
following a Reset or Restart command, the gateway will not 
execute gateway code until you click Go. If you click Pause after 
the 25-second interval, an error message is displayed. 

K-STAR IP dialog box 

Selecting K-STAR IP from the Configuration menu places a K
STAR IP listing in the Configuration area of the main dialog box. 
Double-click on this listing, or select it and click Edit, to access 
the K-STAR IP dialog box: 

1- IP laf.rmati.a 

I IP 
! IP 

I IP 

L.~~ 

'--'j r I •• "r .f IP Clt.nts I 

II D\lnemfc @] I 
I St.tle I"Ql 

1 ~ 1 =:u L _____ ... __ . __ .-.l 

Address of FutPeth Box 0.0.0.0 
Subnetwork Mlsk 0.0.0.0 
Bro .. t Add,. .. 0.0.0.0 
Addn .. of I>eflUlt Router 0.0.0.0 

-
r- Adm'a'elral.r 1 
i IP Addreeuf Admlnl.tr.tor Host 10.0.0.0 I 
L. __ ~=======-_~ ( More ... ) 

1
-- IPlalt latarfaCD -- ===:l 

/toppl,Telk Zone Nlme. 1"0 _II 
I /toppleT.lk Netwrk Number . Ii 
! /toppleTel k Node Number 0 _ 

Cancel 

r- Hel, I 
1_ _ ___ .__ _ __ ~ 'lI;;1 ..... O ... K ;;;;;;;;;;;J1J 
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IP Address of 
FastPath Box 

IP Subnetwork Mask 

IP Broadcast Address 

IP Address of 
Default Router 

The IP Information area accepts IP infonnation for the gateway: 

1-- I P I nfurBlatilD -------------.--------------------, I I P AcIcIn .. of F •• tPeth Box I 
I IP Subnet\o/'or/c Muk I 
! I P Broedca.t Add,.... I 
I IP AcIcIru. of Dlfllult Router I L _____________________________________________________ J 

If you are configuring the gateway for K-STAR IP, this field 
must contain the IP address for the gateway as a host on the 
existing Ethernet/IP network. If Option 9 is selected, this 
address applies to the gateway's Ethernet interface. This 
number must be unique on the IP internet. Check existing host 
tables to make sure the address you enter here is not a duplicate 
address. 

This field should contain the default zeroes (0.0.0.0) or the IP 
subnet mask in use on the Ethernet/IP network. The default 
zeroes cause K-STAR to calculate the appropriate subnet mask 
by sending ICMP packets on the network. If the gateway 
receives no response to the ICMP packets, it uses a default mask 
based on the class of the Internet network number (class A, B, or 
C) with no subnetting. If you enter a mask in this field, it must 
be the same subnet mask in use on the Ethernet interface or it is 
ignored. You can enter the mask in decimal-dot or hexadecimal 
notation. 

This field should contain the default zeroes (0.0.0.0) or the IP 
broadcast address that is in use on the Ethernet/IP network. 
The default zeroes cause K-STAR to calculate the appropriate 
broadcast address based on the IP subnet mask and the state of 
option 4. If option 4 is ON, the host portion of the broadcast 
address will contain all zeroes; if it it not selected (default) the 
host portion of the broadcast address will contain all ones. If 
you enter a value in this field, option 4 is ignored. Note that the 
FastPath Manager does not check the validity of the value you 
enter. 

If there is a default IP router system on the internet (for 
example, a UNIX system that specifies efficient routes to other 
networks and subnets), this field should contain its IP address. 
This will cause packets to automatically be sent to that host. The 
default zeroes cause K-STAR to use RIP packets and ICMP 
redirects to determine the best way to route IP packets to remote 
networks. 
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IP Address of 
Administrator Host 

AppleTalk Zone Name 

The Administrator area is only for use where the atalkad 
daemon is supported on the internet and the atalkatab file is 
complete and up to date . 

• -- Admi Ai st rata r -------.. --------------------.---.. -------------------i I IPAdclrlSlofAdmlniltrltorHlSt 10.0.0.0 I I 
10 •• _ .. _ ......... ___ .... _ .. _ .. _ .. _ ....... __ .. _ .... __ .. _ .... _ .. _ .. _ .... _ .. _ .. __ .. __ .. _ .. _ .. __ .. _ ....... _ .......... _ 

If the internet supports a host computer that is running the 
atalkad daemon, and you want K-STAR to query that daemon 
for this configuration data, enter the IP address of that host here. 
If you are configuring the gateway to access atalkad, you should 
not supply any IP configuration data other than the IP address 
for the gateway and the IP address for the administrator host. 
Nor should you supply AppleTalk configuration data for the 
LocalTalk interface or the EtherTalk Phase 1 interface. However, 
since AppleTalk Phase 2 is not yet supported in the atalkatab 
file, you should supply the full EtherTalk Phase 2 configuration 
in the FastPath Manager. In addition, if you are supplying 
secondary addresses for the gateway (as described in Figures 3-9 
and 3-10, you need to turn on Option 9 in the FastPath Manager. 
All the other configuration information should be in the 
atalkatab file. 

The IPTalk Interface area accepts IPTalk information. The 
IPTaik software in K-STAR encapsulates outgoing AppleTalk 
packets in UDP for transmission to CAP or AUFS hosts. When 
it receives encapsulated packets back from these hosts, it strips 
off the UDP transmission data and sends it to AppleTalk nodes 
on its LocalTalk or EtherTalk interface. 

,-- I PTotic laterfoce -----.. ------------------------------------------, 
I I I AppleTolk Zone Nome 1* I! 
i AppleTolk Netvork Number 0 I i 
! AppleTllk Node Number 0 i ....... _ .... _ .. _ .. _ .... _ .. _ .. ____ .. _ .. _ .. _ .... _ .. _____ .. _ .. __ .. ___ .. _ .. _ .. _ .... _ .. _ .. _ .... _ .. _ .. _ .... 1 

If you are configuring an IPTaik interface, this field should 
contain a valid AppleTalk zone name. When a Macintosh user 
selects the zone name you enter here, all AppleTalk traffic 
destined for that zone will be encapsulated in UDP. 
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Apple Talk Net Number If you are configuring an IPTalk interface, this field 
shouldcontain a decimal number within the range of 1-65,279. 
This number is not associated with a cable, as in the AppleTalk 
configurations, but it still must be unique on the AppleTalk 
internet. This number will be used in the destination address 
for CAP or AUFS hosts on Ethernet. 

AppleTalk Node Number This field displays a number that is calculated from the lowest 
byte of the gateway's IP address. It cannot be changed 
manually. 

Dynamic 

1111" All nodes on one IPTaik network must be connected to the same 
Ethernet cable. In addition, because the IPTalk software uses 
the lower-order byte of the host's IP address as a virtual 
AppleTalk node address, the IP addresses of hosts on this IPTaik 
network must all have the same high-order 3 bytes. This is true 
regardless of the class of the IP network number; note that this 
precludes using class C subnets as IPTaik networks. 

1111" Note that using the atalkatab configuration file to configure 
IPTalk networks removes this restriction, and allows IPTalk 
traffic to be routed through IP routers to remote IPTaik 
networks. Configuring an IPTaik interface in K-STAR using the 
FastPath Manager is recommended only when no administrator 
host is present; that is, when the atalkatab file and atalkad 
daemon are not available on the internet. 

In the Number of IP Clients area, you specify the number of 
client Macintoshes for which K-STAR will administer IP addresses. 
The total number of clients must be less than or equal to 60. 

;-- .... ber If IP Cltents ._--, 
I i 

I DII III mic ~ I 
I • 
j Static [] i 
i I L __ .. _ ....... _ .. __ .. ___ .. _ .... _ .. _ .. _ .... _ ........ J 

This field should contain the number of client Macintoshes that 
will dynamically acquire their IP addresses from the gateway 
when they boot up on the IP network. (For example, if you 
enter the number 10, up to 10 Macintoshes can acquire an IP 
address dynamically when they boot up.) If this field contains 
the default zero, no IP addresses will be assigned dynamically. 
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Static 

IP Address of 
Name Server 

This field should contain the number of client Macintoshes that 
will be statically assigned an IP address. This number added to 
the number in the Dynamic field must be less than or equal to 
60. If you exceed this limit, FastPath Manager displays an error 
message in the Help area. 

If both the Dynamic and Static fields contain the default zeroes, 
the gateway will not route IP packets to any Macintoshes. 

Note that the entire range of static and dynamic addresses 
must not duplicate other IP addresses on the Ethernet. See 
Chapter 3 for information on using the split addressing 
feature (Option 9) to change the starting point for the range of 
IP addresses administered for Macintoshes. 

K-STAR IP "More" dialog box 

Click More in the K-STAR IP dialog box to open the K-STAR IP 
"More" dialog box, which lets you specify additional IP 
information: 

r~n~ II P Addr ... of Name Serv.r I'i.i.i.i I II 
IP AcldrNlOffil, Servlr .0.0.0.0 . 

_____ [llneel 

-I La.:.1 P.,.. .... t.rl .------, 
Perimeter -, 0.0.0.0 I n OK B 
Perimeter -Z 0.0.0.0 I ~ .. __ 'iIiiiiIII~ 

II Perimeter -3 10.0.0.0 I 
. Parlmetlr -4 . 0.0.0.0 I 
r He1, ---------------.---.---, 

I 

This field should contain the IP address of a name server; that is, 
a computer on the IP network running an IP program that 
translates host names into addresses. 
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IP Address of File Server This field should contain the IP address of a file server; that is, a 
computer on the IP network on running a program that makes 
local files (or devices) available to other computers on the 
internet. 

Parameter #1 - #4 These fields are used by the gateway in conjunction with option 
flags. Option 9 uses Local Parameter #1 for the split addressing 
IP address and (optionally) Local Parameter #2 field for the split 
addressing subnet mask. 

Area 

Node Number 

Background Timer 

DECnet dialog box 

Selecting DECnet from the Configuration menu places a DECnet 
listing in the Configuration area of the main dialog box. 
Double-click on this listing, or select it and click Edit, to access 
the DECnet dialog box: 

I-DEc ..... f• 
Ani 
Node Number 
Background Timer 
Hlllo Timer 

r: Hel, 
I DECnet eII'IOli box. Ute thl ..... 1 ndo .... to .peclfV the 
I futPeth·. DEC net detl. 

L 
I [r-C-II-nc:-e-....... 

I I tll!!!!!!!!~O~K!!!!!!!!') 
If you are configuring the gateway for DECnet routing, this field 
should contain the DECnet area number for the gateway. This 
must be the area number in use on Ethernet. 

This field should contain the DECnet node number for the 
FastPath. This is a unique node number within the area. 

The number in this field determines how frequently routing 
packets are sent out. It has a default of 120 seconds, which 
should be reasonable for most sites. You can change this if 
necessary by typing in the new value (a decimal number 
representing the number of seconds between routing packets). 
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Hello Timer The number in this field determines determines how frequently 
"hello" packets are sent to end nodes on the network. It has a 
default of 30 seconds, which you can change if necessary. 

Appletalk Phase 1 dialog box 

Selecting ATaik Phase 1 from the Configuration menu places an 
ATaik Phase llisting in the Configuration area of the main 
dialog box. Double-click on this listing, or select it and click 
Edit, to access the AppleTalk Phase 1 dialog box. This dialog 
box is designed accept data for the Ethernet interface of the 
gateway onlYi the AppleTalk Phase 1 data for the LocalTalk 
interface should be supplied in the main dialog box. 

r Et"rT.1t P .... 1 ------.-----

'l' Applerel k Zone Nlme II 
Applerll k Net Number 
Appltrll k Node Number 

.-------------------------~ I'-Hel, ----, 

I JI 
1... __ . ______ 00_ 

Concel 

t OK D 

AppleTalk Zone Name This field must contain either the default asterisk (*) or a zone 
name, which is a character string between land 32 characters 
which may include embedded spaces. The gateway considers a 
character to be invalid in a zone name if its ASCII value is less 
than hex 20 or equal to hex 7F. The asterisk causes the gateway 
to acquire a zone name from another gateway or (if no other 
gateway has a zone name assigned and the gateway is set up to 
autoconfigure) to use the name "Default Zone." All gateways on 
the internet must agree about a particular network's zone name. 

AppleTalk Net Number This field must contain the default zero (0) or a decimal number 
within the range of l~,279. The default 0 causes the gateway 
to get this information from another gateway (seed itself) or, if 
the gateway is set up to autoconfigure, to find an unused 
AppleTalk net number and assign it to the Ethernet interface. A 
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decimal number entered in this field becomes the net number 
for the network connected to the gateway's Ethernet interface. 
The AppleTalk network number must be unique for every 
network on the internet, and all gateways on a network must 
agree on the net number for the network. 

AppleTalk Node Number This field displays a number that is assigned automatically by 
AppleTalk when the gateway is started on the network. It 
cannot be changed manually. 

IP Subsectioning dialog box 
The gateway's PROM-resident IP implementation was 
previously referred to as the "IP Subnetting" configuration type. 
In this version of the FastPath Manager, it is called as "IP 
Subsectioning" to avoid confusion with standard IP subnetting. 
Note, however, that the PROM-resident code itself has not 
changed. 

This configuration type is provided for backward compatibility 
only; please refer to your existing documentation for more 
information or see Chapter 3 on configuring K-STAR IP. 

Selecting IP Subsectioning from the Configuration menu places 
a IP Subsectioning listing in the Configuration area of the main 
dialog box. Double-click on this listing, or select it and click 
Edit, to access the IP Subsectioning dialog box, which accepts 
configuration data for the PROM-resident IP code. 

riP s .... t I.'. 
liP Subnet Mak 
I Ethernet IP Addr_ I Loc:aITalk IP Add,... 

Default IP Router Addn .. 

-"jiiiiiiil r CI ••• ~ I"""" II Elher: I 
1-°_.°_.0._° __ --1 I I Loc:.l: I 
~-----II~ I I I~o . 
0.0.0.0 

r Help 'I l Cancel I Mli niP Subnet dialog box. Use thll Yi ndw to . 
II specifU the Fa,tPath', IP IdcIr ... dati for both I 
netvorkl to Which It 1. connected. 

'-----__ .. ____ • _________ ,...1 ( OK I 
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IP Subnet Mask 

Ethernet IP Address 

LocalTalk IP Address 

Default IP Router 
Address 

Ether/Local 

This field should contain a subnet mask in decimal-dot or 
hexadecimal format. This mask is used to define the LocalTalk 
net as a further subsection of the IP network, where the subnet 
number must be equal to the AppleTalk Network Number for 
the LocalTalk interface, and must be different from the 
EthemetlIP subnet number. 

The Ethernet IP Address field should contain the IP address for 
the gateway on Ethernet/IP network. This must be an unused 
IP address for that network. 

This field should contain the IP address for the gateway on its 
LocalTalk interface. The LocalTalk network will be seen as a 
logical sub-sectioning of the IP subnet, where the AppleTalk 
network number for the LocalTalk side must be equal to the 
subnet number in the IP Address. 

This field should contain the IP address for default IP router 
system (for example, a UNIX system that specifies efficient 
routes to other networks and subnets). This will cause packets 
to automatically be sent to that host. 

These fields automatically display the class of the network 
defined on the Ethernet and LocalTalk interfaces of the gateway 
(that is, whether the IP network number is class A, B, or C), 
based on the IP addresses you have entered. 

FastPath Manager menus 

The FastPath Manager provides the following menus: 

• File Edit Gateways Configuration Windows 

The Apple (ti) menu is the standard menu for accessing Desk 
Accessories, the Chooser, Control Panel, and so forth. 

The Edit menu is not currently supported in the FastPath 
Manager; that is, you cannot cut and paste between fields. 
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The File menu 

Download a File ... 

Open Configuration File XO 
51111e Conflgurlltlon File X5 

Pllljt.> Sehlll ••• 
Print Configuration XP 

Q~t XQ 

Download a File. . . This entry is used for downloading a gateway program (such as 
K-STAR). It brings up a dialog box showing the contents of the 
current directory. To download K-STAR, select it and click on 
the Open button. Note that the gateway will not accept 
download information while it is executing code. You must 
click Restart or Reset before downloading a file. 

Open Configuration File This entry brings up a dialog box where you can select the 
configuration file you want to open. To open a configuration 
file, select it and click on the Open button. The file's 
configuration data will appear in the fields of the FastPath 
Manager's dialog boxes. 

Save Configuration File This entry brings up a dialog box where you assign a name to 
the configuration file before saving it to disk. Type a name for 
the configuration file and click Save to save the configuration to 
disk. This is recommended when you have configured a 
gateway. 

Page Setup... Currently not implemented. 

Print Configuration This entry sends a formatted page of the current configuration to a 
printer (including configuration data contained in windows other 
than the current window). A printer must be accessible to this 
Macintosh. 

Quit Exit the FastPath Manager application. 
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Find All 

Name ... 

Serial Number ... 

The Gateways menu 

Find 811 :lea 

Nome... 8CN 
Serlol Number ••• 

Queries the network for all gateways on that net, opens the 
gateway selection window, and displays the names of all 
responding gateways in the data field. 

Brings up a dialog box where you can enter a name of no more 
than 20 characters for the gateway that is currently open. The 
gateway name you enter will appear in the header of the main 
configuration dialog box, in the Windows menu, and in the 
Gateway Selection window. Because it appears in the 
Windows menu, Macintosh metacharacters can not be used in 
gateway names. 

The name you assign to a gateway is used by the gateway as the 
"name" field when it responds to DECnet or SNMP NBP lookups. 

This entry brings up a dialog box where you can enter the serial 
number for the gateway that is currently open. After you enter 
the serial number, it will appear in the Gateway Area of the 
main dialog box. This information is not used by the gateway ir 
any way, but it is useful for reference when you are using dealer 
support. 
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ATaik Phase 2 

K-STAR IP 

DECnet 

ATaik Phase 1 

IP Subsectioning 

The Configuration menu 

.lHI~ 

RTaik Phase 2 
Ie-STRR IP 
DEenet 
RTaik Phase 1 
IP Subsectlonlng 

This is the default K-STAR configuration type for the gateway in 
that, when the main configuration dialog box comes up, it 
accepts AppleTalk Phase 2 configuration data. Selecting ATaik 
Phase 2 enters a listing in the Configuration area, but clicking on 
this listing does not open a new dialog box. 

Select this configuration type to enter a listing for K-STAR IP in 
the Configuration area of the main dialog box. Double-clicking 
on this listing opens the K-STAR IP dialog box. 

Select this configuration type to enter a listing for DECnet in the 
Configuration area of the main dialog box. Double-clicking on 
this listing opens the DECnet dialog box. 

Select this configuration type to enter a listing for Atalk Phase 1 
in the Configuration area of the main dialog box. Double
clicking on this listing opens the EtherTalk Phase 1 dialog box. 
The AppleTalk data for the Local Talk interface must be entered 
in the main configuration dialog box. If you intend to 
download K-STAR (for example, to implement the zone security 
features or to configure another type of K-STAR routing in 
conjunction with AppleTalk Phase 1), you need to tum on 
Option 17 to use AppleTalk Phase 1. If you do not download K
STAR, the AppleTalk Phase 1 protocols in PROM will execute 
with the configuration data you supply. 

The gateway's PROM-resident IP implementation was 
previously referred to as the HIP Subnetting" configuration type. 
In this version of the FastPath Manager, it is called as HIP 
Subsectioning" to avoid confusion with standard IP subnetting. 
Note, however, that the PROM-resident code itself has not 
changed. This configuration type is provided for backward 
compatibility only; please refer to your existing documentation 
for more information or see Chapter 3 on configuring K-STAR 
IP. 

FastPath Manager Reference B-29 



The Windows menu 

The contents of the Windows menu changes when you open a 
gateway. The sample menu above shows one gateway open 
(gateway 1). The Diagnostics window is always one of the 
entries in this menu. 

When you select a name from the this menu, the appropriate 
window opens. 

Note: If you are viewing the Diagnostics window and wish to 
return to the dialog box that is open for a gateway, be sure to 
select the gateway's entry in this menu rather than close the 
Diagnostics window using the "close box" in the upper left 
corner of the window. If you close the Diagnostics window, it 
will not automatically re-open when you click Go in the main 
configuration dialog box. In this case, selecting Diagnostics 
from this menu will open the window again. 
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A p p E N D I x c 

FastPath Diagnostic Messages 

THIS ApPENDIX LISTS THE DIAGNOSTIC MESSAGES GENERATED BY 

the FastPath gateway. Most of these messages can be generated 

when the gateway is running K-STAR Version 8.0, although 
some are generated from PROM (these are marked in the text). 

These messages appear in the far right column of the 

Diagnostics window of the FastPath Manager when the 

Macintosh is connected to the gateway's LocalTalk interface. 

These messages are also stored in a buffer in the gateway that 

can be accessed by clicking the Log ... button in the FastPath 

Manager (on LocalTalk or Ethernet). The Log ... button allows 
you to view 586 or fewer characters, which are stored in the 

gateway's buffer until they are overwritten by new messages. 

You can use the Log ... button to see messages that were 

generated before you launched the FastPath Manager. 
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Conventions and organization 
The diagnostic messages in this section are listed according to 
the software module that produces them. In these messages, the 
following conventions are used: 

N 
X 
string 
interface 

is a decimal number 
is a hexadecimal number 
is a character string 
is a character string indicating one of the gateway's 
interfaces, which may be one of the following: 

If the gateway is running K-STAR, interface can be one of the 
following: 

LTALK 
ETALKl 
ETALK2 
IPTALK 

the LocalTalk interface 
the EtherTalk Phase 1 interface 
the EtherTalk Phase 2 interface 
the IPTaik interface 

If the gateway is running PROM-resident code, interface can be 
one of the following: 

ATALK 
ETALK 

the LocalTalk interface 
the EtherTalk Phase 1 interface 

Table C-llists the gateway's diagnostic messages alphabetically, 
and references the page on which the message is documented in 
this Appendix. 
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Table C-l. Alphabetic Listing of Diagnostic Messages 

ALL NODE NUMBERS IN USE ON ETHERNET FOR NET N, STILL TRYING I See page C-13 
Atalkad: RESTART I See page C-23 
Auto-configured interface net number N (OxX) ISeepageC-12 
Auto-configured ETALK2 range N(OxX) - N(OxX) ISeepageC-12 

bad DECnet checksum I See page C-25 
Bad RTMP format, port interface ISeepageC-16 

Conflicting information: local default zone=string; string reported on 

ETALK2 I See page C-19 

DECnet routing on, my addre s s = N. N I See page C-23 
decnet - no route to addr X I See page C-25 
decnet - no valid route. I See page C-25 
decnet - too many hops I See page C-24 
decnet - wrong area I See page C-24 
decnet data () - wrong version I See page C-25 
DUP IP ADDRESS string, sent from: X. X. X. X. X. X I See page C-22 
DUPLICATE HARDWARE ADDRESS: X.X.X.X.X.X ISeepageC-22 

ETALK2 seeded as range N-N, and chose net N I See page C-16 
Ethernet Phase 1 net number is in the startup range. Ignoring 
configuration. I See page C-14 
Ethernet Phase 2 range is in the startup range. Ignoring 
configuration I See page C-lS 
Ethernet Phase 2 range start is greater than range end. Setting range to 
N-N I See page C-lS 
Ethernet transmission error: X I See page C-IO 

FastPath AT node N, ET node N, N bytes memory, version string, string IP 

routing string, options=OxX I See page C-7 

got routing pkt from unknown router at addr X I See page C-25 
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Table C-l. Alphabetic Listing of Diagnostic Messages (continued) 

interface seeded as net N 'See page C-17 
i82586 NOT RESPONDING 'See page C-ll 
i 82 586 TRANSMI TTER HUNG 'See page C-ll 
IP setup error X 'See page C-26 

K-STAR FastPath AT node N, ET node N, ET2.0 net N, ET2.0 node N, N 

buffers (N for ethernet), revision string, Option Flags: string. 'See page C-9 
K-STAR atalkatab configuration complete' See page C-23 
KFPS ATt NETt N PROM REV string (string) STATE=string HW STATUS=X 'SeepageC-6 

LocalTalk net number is in the startup range. Ignoring configuration. 

'See page C-14 
Loop found. Restarting auto-config for interface 'See page C-12 

Mismatched net numbers: local=N; N reported on interface 'See page C-17 
Mismatched range numbers: local=N-N; N reported on ETALK2 'SeepageC-18 

Net N went down 'See page C-18 

Option 17 is on, but the range is too wide. Setting range to N-N 'See 
pageC-15 
Option 17 is on, but there is more than one zone name. Using only the 
default zone name. ISeepage C-15 

REBOOT I See page C-8 
REQUIRES PROM VERSION 4.1 OR GREATER!! 'See page C-IO 

RESET 'See page C-8 
Range N-N went down I See page C-18 
Restarting auto-config for interface I See page C-13 

unknown decnet pkt from interface I See page C-24 
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Table C-l. Alphabetic Listing of Diagnostic Messages (continued) 

Warning: net N for interface interface is in the startup range. I See page C-23 
Warning: option 17 is not on but there is a Phase 1 router present on 
port LTALK I See page C-16 
Warning: option 17 is on and there is more than one zone name 
for net N I See page C-20 
Warning: there is more than one zone name for net N but there are 

AppleTalk Phase 1 routers present I See page C-20 
Warning: unable to register multicast address X X X X X X ISeepageC-24 
WARNING: interface has not acquired a net number I See page C-18 
WARNING: invalid character in zone name converted to clulracter I See page C-21 
WARNING: received zip reply with invalid character in zone name ISeepage 
C-21 
WARNING: zip bringup found invalid character in zone name I See page C-21 
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KFPS 

An N 

ETt N 

PROM REV string 

(string) 

STATE=string 

Gateway startup 
The gateway generates the messages in this section as it is 
starting up; for example, following a reset or power cycle, or 
after you download K-STAR and click Go when you are 
configuring the gateway. 

PROM startup 
The PROM startup messages are the first diagnostics sent by the 
gateway when it is powered on and begins operations. 

KFPS ATt NETt N PROM REV string (string) STATE=string 
HW STATUS=X 

This is the initial gateway startup message from PROM: 

KFPS designates the Kinetics FastPath Standalone gateway. 

The AppleTalk node number of the gateway's LocalTalk 
interface. 

The AppleTalk Phase 1 node number of the gateway's Ethernet 
interface. 

The revision number of the gateway's PROM (string should be 
4.1 or higher to run K-STAR Version 8.0). 

The date the PROM was created. 

The state of the gateway, where string is one of the following: 

BE A BRIDGE The gateway will begin working as an 
AppleTalk Phase 1 router running PROM
resident code after the 25-second delay, if 
no other code is downloaded. 
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HW STATUS=X 

BOOTME The Remote Boot software switch has been 
set in the FastPath Manager and the 
gateway does not find a valid download 
module. The gateway will wait for you to 
download a valid gateway program. 

DOWNLOAD VALID The gateway will begin executing the 
downloaded gateway program after 25 
seconds. 

PAUSE The gateway is "paused." It will remain in 
this state until you click Reset (to 
reconfigure the gateway) or Go (to use the 
current configuration) in the FastPath 
Manager main dialog box. 

The status of the gateway, where X is the applicable status code 
described below. If more than one condition occurs, the status 
codes are logically ORed together. 

0001 
0002 
0004 
0008 
0010 
0020 

AppleTalk controller chip is bad. 
Ethernet controller chip is bad. 
Voltage level of the built-in battery is low. 
Expansion RAM is installed. 
Ethernet transceiver fuse is blown. 
Latest memory test failed. 

If the HW STATUS=O, then the FastPath 4 hardware is normal. 

FastPath AT node N, ET node N, N bytes memory, 

version string, string IP routing string, options=OxX 

This is the startup message that the gateway sends when the 
gateway PROM code begins execution. If K-STAR has not been 
downloaded, this message should follow the message that begins 
KFPS An ... , described above. 
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AT node N 

ET node N 

N bytes memory 

version string 

string IP routing 

string 

opt ion s=string 

The AppleTalk node number of the gateway's LocalTalk port. 

The EtherTalk Phase 1 node number of the gateway's Ethernet 
port. 

The total amount of memory, in bytes, available for packet 
buffers in the gateway. 

The version number of the PROM. 

The type of PROM-resident IP routing you have configured (as 
described in Appendix E); either SUBNET or FIXED. 

An indication whether you have configured IP subsectioning 
using the PROM-resident IP code; either ON or OFF. 

The current value of the options variable, in hexadecimal 
notation. Most of the time, this is 0 (zero). 

REBOOT 

This message appears after you click on the Restart button in the 
main configuration window. After a 25-second delay, gateway 
operation restarts with the current configuration data. 

RESET 

This message appears after you click on the Reset button in the 
main configuration window. This clears all the memory 
locations in the gateway, including the downloaded gateway 
program (if any). After a 25-second delay, gateway operation 
restarts. 

C-8 FastPath Administrator's Guide 



K-STAR startup 
The K-STAR startup messages appear when the gateway begins 
executing the downloaded K-STAR software. They follow the 
startup messages stored in gateway PROM. 

K-STAR FastPath AT node N, ET node N, ET2.O net N, 
ET2.O node N, N buffers (N for ethernet), revision 
string, Option Flags: string. 

This is the startup'message that the gateway sends when it 
begins executing K-STAR. It usually follows the message that 
begins KFPS ATL., described above. 

K-STAR FastPath The gateway is running K-STAR (it is a "K-STAR gateway"). 

AT node N, The AppleTalk node number of the LocalTalk interface 

ET node N, The EtherTalk Phase 1 node number of the Ethernet interface. 

ET2 .0 net N The EtherTalk Phase 2 network number chosen from a specified 
range for this gateway. If this is a non-seed gateway, the 
network number will be in the startup range. When the 
gateway acquires a network number that is valid for the cable, it 
will send another diagnostic. 

ET2 .0 node N The EtherTalk Phase 2 node number of the Ethernet interface. 

N buffers The number of buffers in the gateway. 

(N for ethernet) The number of buffers that are dedicated to the Ethernet chip. 

revision string The version number of the K-STAR module. This should be 
"8.0" for K-STAR Version 8.0. 

Option Flags : string The option flags that have been turned on in the Options dialog 
box. If no options are turned on, string is "none." 
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REQUIRES PROM VERSION 4.1 OR GREATER!! 

If you download K-STAR Version 8.0 to an earlier revision of the 
gateway hardware (that is, a FastPath 1, 2, or 3) with PROMs 
earlier than version 4.1, you will see this message. These 
hardware units cannot support this release of K-STAR. 

Ethernet initialization 
These messages indicate a problem with the Ethernet interface. 

Ethernet transmission error:X 

This message means that an attempt to transmit on Ethernet was 
aborted. X is a hexadecimal code taken from the Intel 82586 
Ethernet controller. The hexadecimal codes can be any of the 
following: 

8020 

8060 

8400 

8420 

8460 

This indicates excess collisions on Ethernet, and 
probably a very high traffic rate, perhaps a 
network test in progress. If this message 
appears frequently, it can indicate a problem 
with the transceiver or transceiver cabling. This 
code also indicates that the transceiver in use 
does not have the "heartbeat" test. 

The same as above (status 8020), if the 
transceiver in use has the "heartbeat" test. 

This probably indicates that the transceiver 
cable is disconnected or loose. 

This probably indicates that the Ethernet cable 
is not terminated or not connected to the 
transceiver. This code also indicates that the 
transceiver in use does not have the "heartbeat" test. 

The same as above (status 8420), if the 
transceiver in use has the ''heartbeat'' test. 
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If you are connecting to a broadband network and you 
consistently see an Ethernet transmission error message, try 
selecting Option flag 2. See Appendix B for a description of 
setting Options. If you see an Ethernet transmission error 
message while configuring a gateway with a LocalTalk 
connection only (and the network selection switch is pushed 
toward the transceiver connection), you can ignore it until the 
gateway has been connected to Ethernet. 

i82586 NOT RESPONDING 

This indicates that the gateway code cannot communicate with 
the Ethernet controller chip. 

Check the slide switch on the back panel to make sure that it is 
set to the connector that is actually attached to an Ethernet 
cable. Also, check that the Ethernet cable is properly terminated. 
If this error recurs despite a correct switch setting and proper 
network termination, contact your dealer as described in the 
chapter on "Troubleshooting." 

i82586 TRANSMITTER HUNG 

This message appears when the gateway's Ethernet controller 
chip cannot transmit. Check the slide switch on the back panel 
to make sure it is set to the connector that is actually attached to 
an Ethernet cable. Also, check that the Ethernet cable is properly 
terminated. If this error recurs despite a correct switch setting 
and proper network termination, contact your dealer as 
described in the chapter on ''Troubleshooting.'' 

AppleTalk 
These messages are related to the AppleTalk protocols. They 
can appear when you are configuring the gateway, or if a 
problem develops after the gateway is up and running on the 
AppleTalk internet. You can see the messages relating to 
AppleTalk Phase 2 or Option 17 only when the gateway is 
running K-STAR. 
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Autoconfiguration 
The autoconfiguration messages are related to both the PROM
resident AppleTalk protocols, and the K-STAR AppleTalk 
protocols if you have downloaded K-STAR and clicked Go. 
They occur only when the gateway is autoconfiguring. 

Auto-configured interface net number N (OxX) 

This message appears when AppleTalk autoconfiguration has 
successfully assigned a network number for a non-extended 
interface. 

interface 

N 

If the gateway is autoconfiguring using PROM
resident code, interface could be ATALK or 
ETALK, if it is autoconfiguring using K-STAR 
AppleTalk Phase 2 code, interface is LTALK. 

The network number in decimal (oxX is the 
same number in hex notation). 

Auto-configured ETALK2 range N (OxX) - N (OxX) 

This message appears when K-STAR AppleTalk Phase 2 
autoconfiguration has successfully assigned a network range to 
the Ethernet interface. 

N - N The network range in decimal (oxX is the same 
range in hex notation). 

Loop found. Restarting auto-con fig for interface 

This message can appear when the gateway is autoconfiguring 
and finds a loop in the network design. Another bridge or 
gateway on the same network has reported a network number 
that conflicts with a network number that the gateway was 
trying to assign. This indicates that your hardware configuration 
includes a loop, allowing the gateway to reach a network 
through both its LocalTalk and its Ethernet interfaces. Such a 
loop is permissible with manual configuration, but not with the 
autoconfiguration feature. 
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interface If the gateway is autoconfiguring using PROM
resident code, interface could be ATALK or 
ETALK, if it is autoconfiguring using K-STAR 
AppleTalk Phase 2 code, interface is either 
LTALK orETALK2. 

If this message appears while the gateway is autoconfiguring, 
configure the gateway manually (see Chapter 2 for details on 
AppleTalk Phase 2 configuration). 

Restarting auto-config for interface 

The automatic configuration software has found a conflict with 
a network number that it assigned to an interface. The software 
begins the autoconfiguration process again for this interface. 

interface If the gateway is autoconfiguring using PROM
resident code ,interface could be ATALK or 
ETALK, if it is autoconfiguring using K-STAR 
AppleTalk Phase 2 code, interface is either 
LTALK or ETALK2. 

Node-finding 
These messages are related to both the PROM-resident 
AppleTalk protocols, and the K-STAR AppleTalk protocols if 
you have downloaded K-STAR and clicked Go. They appear 
when the gateway is acquiring its node number and beginning 
to communicate on the AppleTalk internet. 

ALL NODE NUMBERS IN USE ON ETHERNET FOR NET ~, STILL 

TRYING 

AppleTalk automatically assigns node numbers to devices on 
the network. This message indicates that the gateway has been 
unable to acquire a valid AppleTalk node number on its 
Ethernet interface. 

~ A valid network number for the cable, or a 
network number in the startup range. 

The maximum number of nodes for EtherTalk Phase 1 is 254. 
The gateway first tries to acquire a node number in the server 
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range (128-254); if this fails because these node numbers were 
already assigned, the gateway tries to acquire a node number in 
the non-server range. If both fail, you will see this message. 

The maximum number of nodes for EtherTalk Phase 2 depends 
on the network range. If Ethernet is configured for AppleTalk 
Phase 2, the gateway will try to acquire a valid node number 
(first in the server range, then in the non-server range) on a 
given net before moving on the the next net if no nodes are 
available. It will cycle through all of the valid network numbers 
for the cable until it finds an unused node number to acquire. 

If you see this message in the Diagnostics window of the 
FastPath Manager, 

• Check whether the network is near the maximum number of 
nodes. 

• If the network is not near the limit, then one or more nodes 
might be responding incorrectly to the gateway's address 
inquiry packets. Attach an Ethernet monitor, such as the 
Excelan LANalyzer system, to inspect the response packets. 

LocalTalk net number is in the startup range. 
Ignoring configuration. 

The network numbers 65,280-65,534 are reserved for the 
AppleTalk Phase 2 startup range, and cannot be assigned to a 
network. If you see this message, you need to reconfigure the 
LocalTalk network number. If you do not reconfigure the 
network number, the gateway will act as a non-seed router on 
this interface. 

Ethernet Phase 1 net number is in the startup range. 
Ignoring configuration. 

The network numbers 65,280-65,534 are reserved for the 
AppleTalk Phase 2 startup range, and cannot be assigned to a 
network. If you see this message, you need to reconfigure the 
EtherTalk Phase 1 network number. If you do not reconfigure 
the network number, the gateway will act as a non-seed router 
on this interface. 
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Ethernet Phase 2 range is in the startup range. 
Ignoring configuration. 

The network numbers 65,280-65,534 are reserved. for the 
AppleTalk Phase 2 startup range, and cannot be assigned. to a 
network. If you see this message, you need to reconfigure the 
EtherTalk Phase 2 network range. If you do not reconfigure the 
network number, the gateway will act as a non-seed. router on 
this interface. 

Ethernet Phase 2 range start is greater than range 

end. Setting range to N - N 

The EtherTalk Phase 2 network range must be a contiguous 
range of decimal numbers; for example, I-tO. If you 
accidentally enter a larger number in the "range start" field than 
the number you enter in the "range end" field, you will see 
this message. K-STAR will automatically set the range to the 
"start range" number in both fields. You should return to the 
main configuration dialog box and reconfigure the network 
range correctly. 

Option 17 is on, but the range is too wide. Setting 

range to N - N 

When Option 17 is on, the gateway is running the transition 
bridge software. This requires that the network range be 
limited. to only one element. If you entered. a wider network 
range, K-STAR will automatically set the range to the "range 
start" number in both fields. If you did not intend to run the 
transition bridge software, open the FastPath Manager and tum 
off Option 17. 

Option 17 is on, but there is more than one zone 

name. Using only the default zone name. 

When Option 17 is ON, the gateway is running the transition 
bridge software. This requires that the zone list be limited. to 
only one element. If you entered a list of more than one zone 
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name, K-STAR will automatically use only the name you 
selected as the default zone name. If you did not intend to run 
the transition bridge software, open the FastPath Manager and 
tum off Option 17. 

RTMP 
These messages are related to the Routing Table Maintenance 
Protocol supported by both the PROM-resident AppleTalk 
protocols and the K-STAR AppleTalk protocols. They appear 
when the gateway has acquired its addresses, or when it has 
encountered a conflict in AppleTalk addressing. 

Bad RTMP format, port interface 

This message indicates that at least one gateway or host on the 
internet is running bridge software that predates Apple's 
introduction of EtherTalk. In this case, you should update the 
software on the offending host. 

interface If the gateway is using PROM-resident code, 
interface could be ATALK or ETALK, if it is using 
K-STAR AppleTalk code, interface is either 
LTALK or ETALKl. 

Warning: option 17 is not on but there is a Phase 1 

router present on port LTALK 

This message indicates that there is at least one Phase 1 router 
on the LocalTalk interface. In this case, you need to use the 
transition bridge software. See Chapter 2 for instructions on 
configuring a transition bridge. 

ETALK2 seeded as range N-N, and chose net N 

This message indicates that the gateway has acquired its 
extended network address from a previously configured 
gateway on Ethernet. 
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range N-N The network range seeded on the EtherTalk 
Phase 2 interface. 

chose net N The network number chosen for the gateway. 
N will be one of the networks in the network 
range. 

interface seeded as net N 

This message indicates that the gateway has acquired its non
extended network number from a previously configured 
gateway on the specified interface. 

interface The interface, either LTALK or ETALKl. 

N The network number acquired by the gateway. 

Mismatched net numbers: local=N; N reported on 

interface 

This message indicates a configuration error, in that all bridges 
and gateways on the internet must agree about the network 
number for a given network. It means the gateway received a 
routing packet from a bridge or gateway that disagrees about 
the network number on the indicated interface. 

local=N The AppleTalk network number of interface. 

N reported The conflicting network number reported by 
another gateway or bridge on interface. 

interface If the gateway is using PROM-resident code, 
interface could be ATALK or ETALK, if it is using 
K-STAR AppleTalk code, interface is either 
LTALK or ETALKl. 
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Mismatched range numbers: local=N -N; N reported on 
ETALK2 

This message indicates a configuration error, in that all bridges 
and gateways on the internet must agree about the network 
range for a given network. It means the gateway received a 
routing packet from a bridge or gateway on Ethernet that 
reports a network number that is not in the valid range for that 
cable. 

local=N-N The network range of the Ethernet interface. 

N reported The network number reported by another 
gateway or bridge that is not in the valid range 
for this cable. 

WARNING: interface has not acquired a net number 

This message can occur when you are manually configuring the 
gateway using the "seeding" feature. This message means that 
the gateway was unable to find a configured gateway to acquire 
the necessary configuration data. 

interface If the gateway is using PROM-resident code, 
interface could be ATALK or ETALK, if it is using 
K-STAR AppleTalk code, interface is either 
LTALK or ETALK2. 

If you see this message, you can explicitly supply the required 
data instead of using seeding. (See Chapter 2 for information on 
AppleTalk Phase 2 and Phase 1 configuration.) 

Range N - N went down 

or 

Net N went down 

N-N 
N 

An AppleTalk Phase 2 network range. 
An AppleTalk network number. 
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This message can appear when the gateway has not received 
any recent routing table update information for the indicated 
network. This implies an absence of communication between 
the remote network and the local network and it can indicate a 
broken or disconnected cable. 

Check the bridge or gateway connected to the specified network 
to see if it is turned off, reconfigured, disconnected from the 
internet, or down due to a hardware fault. If none of these is the 
fault, check the local gateway to see if it is disconnected from 
the network or is no longer receiving packets due to a cabling or 
transceiver problem. 

This message can also occur when there is consistently heavy 
traffic on the Ethernet and the gateway is unable to collect 
RTMP packets because of limited buffer space. 

ZIP 
These messages are related to the Zone Information Protocol, 
which is implemented in both the PROM-resident AppleTalk 
protocols and the K-STAR AppleTalk protocols. They can be 
generated by the gateway when it receives zone information 
from other gateways or bridges on the internet. 

Conflicting information: local default zone = shlng; 
string reported on ETALK2 

string The conflicting zone name (a character string). 

The gateway has detected inconsistent zone names on the 
internet. This can also mean that the gateways on Ethernet 
disagree about the default zone (the same zone was not selected 
as the default zone in each gateway on Ethernet). Check the 
zone names in the gateways on Ethernet. When you find the 
inconsistency, change it to match the zone information in all the 
other gateways on Ethernet. 

When you change zone information in an AppleTalk Phase 2 
gateway configuration, you need to download K-STAR to that 
gateway again. In addition, you should leave the gateway off 
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the internet (i.e., in a paused state) for at least a full 10 minutes 
(or more, if the internet is very large), to give ZIP time to stop 
propagating the old zone information. 

Warning: option 17 is on and there is more than one 

zone name for net ~ 

When Option 17 is on, the gateway is running the transition 
bridge software. This software requires that the AppleTalk 
Phase 2 network must observe the constraints of a non-extended 
network; that is, the network range and zone list must each 
contain only one element. 

To solve this problem, return to the main configuration dialog 
box and reconfigure the EtherTalk Phase 2 interface with only 
one zone name. When you change zone information in an 
AppleTalk Phase 2 gateway configuration, you need to 
download K-STAR to that gateway again. In addition, you 
should leave the gateway off the internet (i.e., in a paused state) 
for at least a full 10 minutes (or more, if the internet is very 
large), to give ZIP time to stop propagating the old zone 
information. 

Warning: there is more than one zone name for net ~ 

but there are AppleTalk Phase 1 routers present 

The gateway is configured with more than one zone name, but it 
is not configured correctly for the transition bridge software 
(Option 17). If there is an AppleTalk Phase 1 router on the 
LocalTalk network, the EtherTalk Phase 2 configuration must 
observe the constraints of a non-extended network; that is, the 
network range and zone list must each contain only one 
element, and Option 17 must be enabled. 

To solve this problem, reconfigure the gateway with only one 
zone name, and (if necessary) tum on Option 17, as described in 
Chapter 2. When you change zone information in an AppleTalk 
Phase 2 gateway configuration, you need to download K-STAR 
to that gateway again. In addition, you should leave the 
gateway off the internet (i.e., in a paused state) for at least a full 
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to minutes (or more, if the internet is very large), to give ZIP 
time to stop propagating the old zone information. 

WARNING: received zip reply with invalid character 

in zone name 

Another bridge or gateway has sent a ZIP packet with an illegal 
character in the zone name. The gateway considers a character 
invalid in a zone name if its ASOI value is less than hex 20 or 
equal to hex 7F. In this case, you should locate the offending 
gateway and fix the zone names in use on its networks. In 
addition, you should leave the gateway off the internet (i.e., in a 
paused state) for at least a £UlltO minutes (or more, if the 
internet is very large), to give ZIP time to stop propagating the 
old zone information. 

WARNING: invalid character in zone name converted to 

character 

character A legal printing character (~ex 20, :t:7F). 

The gateway considers a character invalid in a zone name if its 
ASCII value is less than hex 20 or equal to hex 7F. K-STAR has 
detected an illegal character in a zone name and converted it to 
a legal character. 

WARNING: zip bringup found invalid character in zone 

name 

A node has disabled a zone and, in re-enabling it, has sent a ZIP 
packet with an illegal zone name. The gateway considers a 
character invalid in a zone name if its ASCII value is less than 
hex 20 or equal to hex 7F. In this case, you should locate the 
offending gateway and fix the zone names in use on its 
networks. In addition, you should leave the gateway off the 
internet (i.e., in a paused state) for at least a £UlltO minutes (or 
more, if the internet is very large), to give ZIP time to stop 
propagating the old zone information. 
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IP 

The gateway can generate these messages when it is running K
STAR and is configured for K-STAR IP routing. 

Address resolution: ARP 
The Address Resolution Protocol resolves IP addresses into 
hardware addresses on the IP internet. These messages occur 
when the gateway encounters duplicate IP or hardware address. 

DUP IP ADDRESS string, sent from: X.X.X.X.X.X 

This message means that the gateway has come up on the IP 
internet and the address resolution module has detected its IP 
address attributed to another node. 

string 

X.X.X.X.X.X 

The duplicated IP address (in decimal dot 
notation). 

The 6-byte Ethernet address (in hex) of 
the node that sent the packet containing 
the duplicated address. 

DUPLICATE HARDWARE ADDRESS: X.X.X.X.X.X 

This message means that the gateway has come up on Ethernet 
and ARP has detected its Ethernet address attributed to another 
node. 

X.X.X.X.X.X The 6-byte duplicated Ethernet address 
(in hex). 

The gateway restarts continually until the misconfigured 
address is corrected. In earlier models of the gateway (and 
earlier versions of the FastPath Manager), you could modify the 
last three bytes of the Ethernet Address field. If the internet 
contains such a gateway (or other hardware with modifiable 
Ethernet addresses), modify the Ethernet address field that is 
duplicated. Note that the FastPath 4 gateway obtains its 
Ethernet address from PROM, and it is not modifiable. 
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Atalkad 

Atalkad: RESTART 

When the gateway uses an administrator host to acquire its 
configuration data, it will display this message when it has been 
restarted by the remote daemon. 

K-STAR atalkatab configuration complete 

When the gateway is accessing an administrator host to acquire 
its configuration data, it will display this message when it has 
successfully acquired its configuration data. 

Warning: net N for interface interface is in the 

startup range. 

This message is displayed when the gateway receives a net 
number from atalkad which is in the startup range (65,280-
65,534). The gateway will use this information to configure 
itself, but the routing will not work properly. You should 
choose new net numbers from the range 1-65,279, change the 
atalkatab file, and issue an atalkad restart command. 

DECnet 

These messages can be generated when you have configured the 
gateway for K-STAR DECnet routing in a working DECnet area. 

DECnet routing on, my address = N.N 

This is the startup message you will see when you have 
configured the gateway for DECnet routing. 

N.N The gateway's DECnet address (its area number 
and node number). 
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Warning: unable to register multicast address X X X 
XXX 

The gateway is unable to register a multicast address for its own 
Ethernet chip. 

X. X. X. X. X. X The 6-byte Ethernet address (in hex). 

unknown decnet pkt from interface 

The gateway has received what it thinks is a DECnet packet, but 
it does not understand the DECnet header in the packet. 

interface The interface, either LTALK or ETALKl. 

If the packet is from Ethernet, the first 34 bytes of the packet will 
be dumped out in hexadecimal notation. 

decnet - too many hops 

The gateway has received a packet that has exceeded the 
maximum number of hops allowed on Ethernet, and has 
dropped the packet. There is probably a faulty router 
somewhere on the DECnet internet. 

decnet - wrong area 

The gateway is attempting to route a DECnet packet that is 
destined for an area other than the gateway's area, and it does 
not find a Level-2 DECnet "area" router to which it can send the 
packet. Depending on information in the packet, it will either 
return the packet or drop it. 
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decnet - no route to addr X 

The gateway is attempting to route a DECnet packet to the 
specified address and it cannot locate the node. Dependingon 
infonnation in the packet, it will either return the packet or drop it 

X The 16-bit hexadecimal area, node number in 
hexadecimal. 

decnet - no valid route. 

The gateway is attempting to route a DECnet packet to a 
DECnet address that has timed out, and there are no other 
available routers. The target node will be invisible until the 
gateway receives a routing packet pointing to the target node. 

got routing pkt from unknown router at addr X 

The gateway has received a packet from a DECnet router before 
hearing its "Hello" packet. You can usually ignore this message. 
If it keeps occurring, you should investigate the router at 
addressX. 

X The 16-bit hexadecimal area, node number in 
hexadecimal. 

decnet data() - wrong version 

A version of DECnet that is not recognized by the gateway is 
running on the Ethernet. 

bad DECnet checksum 

A routing packet with a bad checksum was received. This 
message can indicate that an incompatible version of DECnet is 
being used on the network. 
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IP Sub sectioning 
This message appears only if the gateway is configured for the 
IP Subsectioning method using the gateway's PROM-resident IP 
code. It will not appear if K-STAR has been downloaded. 

IP setup error X 

There is an error in the IP routing configuration, so the gateway 
has disabled IP routing. X is a hexadecimal number indicating 
one or more specific errors. This number is the ORed product of 
the applicable error codes described below: 

0002 The shift and mask parameters put the subnet 
field out of the host portion for a class A 
network. 

0004 The shift and mask parameters put the subnet 
field out of the host portion for a class B 
network. 

0008 The shift and mask parameters put the subnet 
field out of the host portion for a class C 
network. 

0010 You have chosen an illegal IP network number. 
The first byte of the address cannot be zero or 
255. 

0020 You have chosen an IP broadcast address for 
either the LocalTalk or the Ethernet side of the 
gateway. The host portion of the address cannot 
be all zeros or all ones. 

0040 The IP subnet address does not agree with 
network number of the LocalTalk side. 

0080 The IP subnet mask is too large. It cannot be 
more than 16 bits long. 

0100 You have defined an illegal subnet. The subnet 
mask cannot extend its zeros into the network 
portion of the IP address. 

C-26 FastPath Administrator's Guide 



A p p E N D I x D 

Kinetics FastPath Management 
Information Base for SNMP 

Tms VERSION OF K-STAR INCLUDES THE SIMPLE NETWORK 

Management Protocol (SNMP) and a Kinetics FastPath 

Management Information Base (MIB). The Kinetics FastPath 

MIB is a virtual information store providing access to managed 

objects. It consists of defined (declared) variables stored in the 

gateway. The values of these variables can then be accessed 

using network management tools to obtain network statistics. 

It should be noted that, at this release, Kinetics does not support 
network management tools for accessing the data stored in the 

Kinetics FastPath MIB. However, the MIB provides a 

standardized mechanism for accessing network management 

data in the gateway, which will be supported in the future by 

Kinetics network management products. 

The Kinetics FastPath MIB is defined in this Appendix, along 

with relevant structural definitions and object descriptions from 

the RFCs listed opposite. 
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Related RFCs 

The following references are companion RFCs (Requests for 
Comment) that describe SNMP and the MIB structures. These 
RFCs are recommended reading for thorough understanding of 
the MIB and how it can be used with network management 
tools. 

• Rose, M., McCloghrie, K., Structure and Identification of 
Management Information for TCP/IP-based Internets, RFC 1065, 
August 1988. This RFC provides the common definitions 
for the structure and identification of management 
information for TCP lIP-based internets. 

• McCloghrie,K., Rose, M., Management Information Base for 
Network Management of TCP/IP-based Internets, RFC 1066, 
August 1988. This RFC provides the initial version of the 
Management Information Base (MIB) for use with network 
management protocols in TCP lIP-based internets in the 
short-term. 

• Case, J., Fedor, M., Schoffstall, M., Davin, J., A Simple 
Network Management Protocol, RFC 1067, August 1988. This 
RFC defines a simple protocol by which management 
information for a network element may be inspected or 
altered by logically remote users. 

These RFCs are available from the DDN Network Information 
Center (NIC), SRI International, 333 Ravenswood Avenue, Room 
EJ291, Menlo Park, CA 94025 for $5.00 each ($10.00 for RFCs 
longer than 100 pages). The NIC telephone number is (415) 859-
3695. These RFCs are also available via e-mail or ftp if you have 
access to the DDN networks. The UNIX e-mail address is 
operators@sri-nic.arpa. 
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Managed objects 
An object type is a definition (declarative in nature) of a kind of 
managed object; for example, a "routing table entry" object 
type. A collection of object types is defined in the first internet 
MIB (RFC 1066), and additional object types are defined in the 
Kinetics FastPath MIB, as described in the section on 
"Definitions" below. 

The means of referencing actual values bound to these object 
types, or object instances (for example an actual routing table 
entry, bound to the routing table entry object type) is not 
defined in the MIB; this is handled by SNMP. 

Objects defined in the MIB are referenced in two ways: 

• A unique, mnemonic, printable string describing the 
object's type (called the OBJECT DESCRIPTOR) intended to 
be a clear label for people reading the MIB and writing user 
interfaces that will access instances of that object. 

• A unique sequence of integers (called the OBJECT 
IDENTIFIER). The object identifier specifies the object's 
location in the global tree structure shown in Figure 0-1 
below. 
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Directory (1) 

CCITI 

Root 

,J (1) 

I 
Org (3) 

I 
DoD (6) 

I 
Internet (1) 

I 
Mrmt (2) 

Mib (1) 

I 
I 

Joint ISO-CCITI 

I 
Experimental (3) Private (4) 

I 
Enterprise (1) 

I 
Excelan (23) 

System (1) Interfaces (2) At (3) IP (4) ICMP (5) TCP (6) EGP (7) I 
MIBDoc (2) 

I 
FastPath (11) 

I 
SCC(1) ALAP(2) Ethernet (3) AARP(4) Alif(S) DDP(6) RTMP(7) KIP(S) ZIP(9) NBP(10) Echo (11) buffar(12) 

Figure 0-1. Global object identifier tree 

The "Internet" subtree of object identifiers starts with the prefix: 

1.3.6.1. 

and initially contains four nodes: Directory (1), Mgmt (2), 
Experimenta1(3), and Private(4). The "path" to one of these 
nodes, for example, the Private node, can be represented as 
integers or strings. For example, 

1.3.6.1.4 
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INTEGER 

OCTET STRING 

is the equivalent of 

ISO.Org.OoO.Intemet.Private 

or any combination of the two, for example, 

1.3.DoO.lnternet.4 

The Private(4) subtree is used to identify objects defined 
unilaterally. Initially, this subtree has at least one child, 
Enterprises (1). Below the Enterprises subtree is the Kinetics 
MIB (Kinetics(23». An object identifier prefix for an object type 
defind in the Kinetics FastPath MIB is: 

1.3.6.1.4.1.23.2.11 

Object type syntax 
The syntax for an object type defines the abstract data structure 
(using a restricted set of ASN.1 constructs) that corresponds to 
that object type. 

Only the following ASN.1 primitive types (sometimes referred 
to as non-aggregate types) are permitted: 

ASN.1 integer. 

An indefinite-length string of 8-bit bytes (octets). 

OBJECT IDENTIFIER An identifier for a particular object, encoded as a unique 
sequence of integers. 

NULL A valueless placeholder. 

Enumerated INTEGERs If an enumerated INTEGER is listed as an object type, then a 
named- number having the value 0 shall not be present in the 
list of enumerations. Use of this value is prohibited. 

NetworkAddress This represents an address from one of possibly several protocol 
families. 
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IpAddress 

Counter 

Gauge 

TimeTIcks 

Opaque 

This application-wide type represents a 32-bit internet address. 
It is represented as an OCTET STRING of length 4, in network 
byte-order. 

This application-wide type represents a non-negative integer 
which monotonically increases until it reaches a maximum 
value, when it wraps around and starts increasing again from 
zero. RFC 1065 specifies a maximum value of 21\32-1 
(4294967295 decimal) for counters. 

This application-wide type represents a non-negative integer, 
which may increase or decrease, but which latches at a 
maximum value. This memo specifies a maximum value of 
21\32-1 (4294967295 decimal) for gauges. 

This application-wide type represents a non-negative integer 
which counts the time in hundredths of a second since some 
epoch. When object types are defined in the MIB which use this 
ASN.1 type, the description of the object type identifies the 
reference epoch. 

This application-wide type supports the capability to pass 
arbitrary ASN.1 syntax. A value is encoded using the ASN.1 
basic rules into a string of octets. This, in turn, is encoded as an 
OCTET STRING, in effect "double-wrapping" the original 
ASN.1 value. (Note that this Kinetics implementation only 
accepts and recognizes opaquely-encoded data; it does not 
unwrap the data and then interpret its contents. This is in 
accordance with the standard definition. Further note that by 
use of the ASN.1 EXTERNAL type, encodings other than ASN.1 
may be used in opaquely-encoded data.) 
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Kinetics FastPath MIB definitions 

Managed objects are accessed via a virtual information store, 
termed the Management Information Base or MIB. Objects in 
the MIB are defined using Abstract Syntax Notation One 
(ASN.l) [9]. This section defines a list of managed objects for 
the Kinetics FastPath gateway. 

Objects 
The mechanisms used for describing these objects are specified 
in RFC 1065, which defines a Structure for Management 
Information (SMI) for use by the managed objects contained in 
the MIB. In particular each object defined has a name, a syntax, 
and an encoding. The name is an object identifier, an 
administratively assigned name, which specifies an object type. 
The object type together with an object instance serves to 
uniquely identify a specific instantiation of the object. For 
human convenience, we often use a textual string, termed the 
OBJECT DESCRIPTOR, to also refer to the object type. 

The syntax of an object type defines the abstract data structure 
corresponding to that object type. The ASN.1language is used 
for this purpose. However, the SMI purposely restricts the 
ASN.1 constructs which may be used. These restrictions are 
explicitly made for simplicity. 

The encoding of an object type is simply how that object type is 
represented using the object type's syntax. Implicitly tied to the 
notion of an object type's syntax and encoding is how the object 
type is represented when being transmitted on the network. 
This section specifies the use of the basic encoding rules of 
ASN.1. 

Object Groups 
Since this list of managed objects contains only the essential 
elements, there is no need to allow individual objects to be 
optional. Rather, the objects are arranged into the following 
groups: 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

SCC 
ALAP 
Ethernet 
AARP 
Atif 
DDP 
RTMP 
KIP 
ZIP 
NBP 
Echo 
buffer 

There are two reasons for defining these groups: one, to provide 
a means of assigning object identifiers; two, to provide a method 
for implementations of managed agents to know which objects 
they must implement. This method is as follows: if the 
semantics of a group is applicable to an implementation, then it 
must implement all objects in that group. For example, an 
implementation must implement the KIP group if and only if it 
implements the KIP protocol. 

Format of Definitions 
The next section contains the specification of all object types 
contained in the MIB. Following the conventions of the RFC 
1065, the object types are defined using the following fields: 

A textual name, termed the OBJECT DESCRIP1OR, for the 
object type, along with its corresponding OBJECT IDENTIFIER. 

The abstract syntax for the object type, presented using ASN.1. 
This must resolve to an instance of the ASN.1 type ObjectSyntax 
defined in RFC 1065. 

A textual description of the semantics of the object type. 
Implementations should ensure that their interpretation of the 
object type fulfills this definition since this MIB is intended for 
use in multi- vendor environments. As such it is vital that object 
types have consistent meaning across all machines. 

One of read-only, read-write, write-only, or not-accessible. 

One of mandatory, optional, or obsolete. 
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Object Definitions 
FASTPATH-MIB {private (4) enterprises (1) excelan(23) mibDoc(2) fastpath(11)} 

DEFINITIONS ::= BEGIN 

IMPORTS 

OBJECT-TYPE, NetworkAddress, IpAddress, 

Counter, Gauge, TimeTicks 

FROM RFC1065-SMI; 

excelan OBJECT IDENTIFIER : := enterprises 23 } 

mibDoc OBJECT IDENTIFIER : :- exeelan 2 } 

fastpath OBJECT IDENTIFIER : := mibDoe 11 } 

sec OBJECT IDENTIFIER : := fastpath 1 

alap OBJECT IDENTIFIER : := fastpath 2 

ethernet OBJECT IDENTIFIER : := fastpath 3 

aarp OBJECT IDENTIFIER : := fastpath 4 

atif OBJECT IDENTIFIER : := fastpath 5 

ddp OBJECT IDENTIFIER ::= fastpath 6 

rtmp OBJECT IDENTIFIER : :=z fastpath 7 

kip OBJECT IDENTIFIER : := fastpath 8 

zip OBJECT IDENTIFIER : := fastpath 9 } 

nbp OBJECT IDENTIFIER : := fastpath 10 } 

echo OBJECT IDENTIFIER " "= fastpath 11 

buffer OBJECT IDENTIFIER : := fastpath 12 

END 
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- ':rhea see Group 

OBJEC':r: 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC':r: 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC':r: 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC'r: 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC'r: 

Syntax: 

Definition: 

scclnterruptCount { scc 1 } 

Counter 

The total number of receive interrupts on this 

interface. 

read-only 

mandatory 

sccAbortCount { scc 2 } 

Counter 

The total number of abort interrupts on this 

interface. 

read-only 

mandatory 

sccSpuriousCount { scc 3 } 

Counter 

The total number of spurious interrupts on this 

interface. 

read-only 

mandatory 

sccCRCCount 

Counter 

scc 4 } 

The total number of CRC errors on this interface. 

read-only 

mandatory 

sccOverrunCount { scc 5 } 

Counter 

The total number of receive overrun errors on this 

interface. 

Access: read-only 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 
Status: 

- The ALAP Group 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

sccUnderrunCount{ scc 6 

Counter 

The total number of receive underrun errors on this 

interface. 
read-only 

mandatory 

alapReceiveCount { alap 1 } 

Counter 

The total number of good packets received on this 

LocalTalk interface. 
read-only 

mandatory 

alapTransmitCount 
Counter 

alap 2 } 

The total number of packets transmitted on this 

LocalTalk interface. 

read-only 

mandatory 

alapNoHandlerCount { alap 3 
Counter 

The total number of packets received on this 

LocalTalk interface for which there was no protocol 

handler. 
read-only 

mandatory 

alapLengthErrorCount { alap 4 } 
Counter 

The total number of packets received on this 

LocalTalk interface whose actual length did not match 

the length in its header. 
read-only 

mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

alapBadCount { alap 5 } 

Counter 

The total number of bad packets received on this 

LocalTalk interface. 

read-only 

mandatory 

alapCollisionCount { alap 6 } 

Counter 

The total number of collisions assumed on this 

LocalTalk interface. 

read-only 

mandatory 

alapDeferCount { alap 7 } 

Counter 

The total number of times this LocalTalk interface 

deferred to other packets. 

read-only 

mandatory 

alapNoDataCount { alap 8 } 

Counter 

The total number of times this LocalTalk interface 

received an RTS packet and expected a data packet, 

but did not receive any data packet. 

read-only 

mandatory 

alapRandomCTS { alap 9 } 

Counter 

The total number of times this LocalTalk interface 

received a CTS packet that was not solicited by an 

RTS packet. 

Access: read-only 

Status: mandatory 
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- The Ethernet Group 

OBJ:&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJ:&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJ:&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJ:&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJ:&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

etherCRCErrors { ethernet 1 } 

Counter 

The total number of CRC errors on this ethernet 

interface. 

read-only 

mandatory 

etherAlignErrors { ethernet 2 } 

Counter 

The total number of alignment errors on this ethernet 

interface. 

read-only 

mandatory 

etherResourceErrors { ethernet 3 } 

Counter 

The total number of errors due to lack of resources 

on this ethernet interface. 

read-only 

mandatory 

etherOverrunErrors { ethernet 4 } 

Counter 

The total number of overrun errors on this ethernet 

interface. 

read-only 

mandatory 

etherlnPackets { ethernet 5 } 

Counter 

The total number of input packets on this ethernet 

interface. 

read-only 

mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

etherOutPackets { ethernet 6 } 

Counter 

The total number of output packets on this ethernet 

interface. 

read-only 

mandatory 

etherBadTransmits { ethernet 7 } 

Counter 

The total number of transmission errors on this 

ethernet interface. 

read-only 

mandatory 

etherOversizeFrames { ethernet 8 } 

Counter 

The total number of oversize frame errors on this 

ethernet interface. 

read-only 

mandatory 

etherSpurRUReadys { ethernet 9 } 

Counter 

The total number of spurious RU Ready interrupts on 

this ethernet interface. 

read-only 

mandatory 

etherSpurCUActives { ethernet 10 } 

Counter 

The total number of spurious CU Active interrupts on 

this ethernet interface. 

Access: read-only 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

etherSpurUnknown { ethernet 11 } 

Counter 

The total number of unknown spurious interrupts on 

this ethernet interface. 

read-only 

mandatory 

etherBcastDrops { ethernet 12 

Counter 

The total number of broadcast packets dropped to free 

resources on this ethernet interface. 

read-only 

mandatory 

etherReceiverRestarts { ethernet 13 } 

Counter 

The total number of receiver restarts on this 

ethernet interface. 

read-only 

mandatory 

etherReinterrupts { ethernet 14 } 

Counter 

The total number of reinterrupts on this ethernet 

interface. 

read-only 

mandatory 

etherBufferReroutes { ethernet 15 } 

Counter 

The total number of buffers taken off of queues to 

service incoming packets on this ethernet interface. 

read-only 

mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

etherBufferDrops { ethernet 16 } 

Counter 

The total number of buffers dropped on this ethernet 

interface. 

read-only 

mandatory 

etherCollisions { ethernet 17 } 

Counter 

The total number of collisions encountered on this 

ethernet interface. 

read-only 

mandatory 

etherDefers { ethernet 18 } 

Counter 

The total number of deferrals encountered on this 

ethernet interface. 

read-only 

mandatory 

etherDMAUnderruns { ethernet 19 } 

Counter 

The total number of DMA Underruns on this ethernet 

interface. 

read-only 

mandatory 

etherMaxCollisions { ethernet 20 } 

Counter 

The total number of packets dropped on this ethernet 

interface because they encountered more than 16 

collisions. 

Access: read-only 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

- The AARP Group 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

etherNoCarriers { ethernet 21 } 

Counter 

The total number of no carrier errors experienced on 

this ethernet interface. 

read-only 

mandatory 

etherNoCTS { ethernet 22 } 

Counter 

The total number of no CTS errors experienced on this 

ethernet interface. 

read-only 

mandatory 

etherNoSQEs { ethernet 23 } 

Counter 

The total number of no SQE errors experienced on this 

ethernet interface. 

read-only 

mandatory 

aarpTable { aarp 1 } 

SEQUENCE OF aarpEntry 

The AppleTalk Address Resolution Table contains an 

equivalence of AppleTalk Network Addresses to the 

link layer "physical" address. 

read-write 

mandatory 
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0B.n:C'1': 

Syntax: 

Definition: 

Access: 
Status: 

OBJEC'1': 

Syntax: 
Definition: 

Access: 
Status: 

OBJEC'1': 

Syntax: 

Definition: 
Access: 

Status: 

OBJEC'1': 

Syntax: 
Definition: 

Access: 
Status: 

aarpEntry { aarpTable 1 } 
aarpEntry ::- SEQUENCE { 

aarpIfIndex 
aarpPhysAddress 
aarpNetAddress 

INTEGER, 
OCTET STRING, 
OCTET STRING 

Each entry contains one AppleTalk Network Address to 
"physical" address equivalence. 
read-write 
mandatory 

aarpIflndex { aarpEntry 1 } 
INTEGER 
The interface on which this entry's equivalence is 
effective. The interface identified by a particular 
value of this index is the same interface as 
identified by the same value of if Index. 
read-only 

mandatory 

aarpPhysAddress { aarpEntry 2 
OCTET STRING 

The media-dependent "physical address." 
read-only 
mandatory 

aarpNetAddress { aarpEntry 3 } 
OCTET STRING 
The AppleTalk Network Address corresponding to the 
media-dependent "physical address." 

read-only 
mandatory 
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- The Atif Group 

OBJECT: 

Syntax: 
Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 
Definition: 

Access: 

Status: 

atifTable { atif 1 } 
SEQUENCE OF atifEntry 

The description of one of the logical interfaces on 
this entity. 

read-write 
mandatory 

atifEntry { atifTable 1 } 

at if Entry :: - SEQUENCE 

atifIndex 

atifDescr 

atifType 

atifNetStart 

atifNetEnd 

atifNetAddress 
atifStatus 

atifNetConfig 

atifZoneConfig 
atifZone 

atifIfIndex 

INTEGER, 

OCTET STRING, 

INTEGER, 

OCTET STRING, 

OCTET STRING, 

OCTET STRING 
INTEGER, 

INTEGER, 

INTEGER, 

OCTET STRING, 

INTEGER 

The description of one of the logical appletalk 

interfaces on this entity. 

read-write 

mandatory 

atifIndex { atifEntry 1 

INTEGER 

A unique value for each logical AppleTalk interface. 

Its value is between 1 and the total number of 
logical AppleTalk interfaces. 

read-only 

mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

atifDescr { atifEntry 2 } 

OCTET STRING 

A text string containing information about the 

interface. This string is intended for presentation 

to a human; it must not contain anything but 

printable ASCII characters. 

read-only 

mandatory 

atifType { atifEntry 3 } 

INTEGER { 

other(l), 

localtalk(2), 

ethertalkl (3) , 

ethertalk2(4), 

tokentalk(5), 

iptalk (6) 

- none of the following 

The type of interface, distinguished by the protocol 

immediately "below" DDP in the protocol stack. 

read-only 

mandatory 

atifNetStart { atifEntry 4 } 

OCTET STRING 

The first Appletalk network address in the range 

configured for this interface, or the single network 

number configured for this interface. 

read-write 

mandatory 

atifNetEnd { atifEntry 5 } 

OCTET STRING 

The last Appletalk network address in the range 

configured for this interface, or zero if a single 

network number is configured. 

Access: read-write 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

atifNetAddress { atifEntry 6 } 

OCTET STRING 

The Appletalk network address configured for this 

interface. 

read-write 

mandatory 

atifStatus { atifEntry 7 } 

INTEGER ( 

operational(1), 

unconfigured(2), 

off(3) 

The configuration status of this interface. 

read-only 

mandatory 

atifNetConfig { atifEntry 8 } 

INTEGER ( 

configured(1), 

garnered(2), 

guessed (3) 

unconfigured(4) 

The configuration status of the DDP network number(s) 

for this interface. 

read-only 

mandatory 

atifZoneConfig { atifEntry 9 } 

INTEGER ( 

configured (1), 

garnered(2), 

guessed(3) 

unconfigured(4) 

The configuration status of AppleTalk zone name(s) 

for this interface. 

read-only 

mandatory 
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Definition: 

Access: 

Status: 

OBJ.&:CT: 

Syntax: 

Definition: 
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Status: 

- The DDP Group 

OSJ.&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OSJ.&:CT: 

Syntax: 

Definition: 

Access: 
Status: 

OBJ.&:CT: 

Syntax: 

Definition: 

Access: 

Status: 

atifZone { atifEntry 10 } 

OCTET STRING 
The zone name configured for this logical interface. 

In ~hiise 2 networks, this is the "default" zone for 
this interface. 

read-write 

mandatory 

atifIfIndex { atifEntry 11 } 

INTEGER 

The physical interface associated with this logical 
interface. A particular value of this index 
identifies the same interface as is identified by the 

same value of if Index. 
read-write 

mandatory 

ddpOutRequests { ddp 1 } 
Counter 

The total number of DDP data grams which were supplied 
to DDP in requests for transmission. 

read-only 

mandatory 

ddpOutShort { ddp 2 

Counter 
The total number of short DDP datagrams which were 

transmitted from this entity. 
read-only 

mandatory 

ddpOutLong{ ddp 3 } 

Counter 

The total number of long DDP datagrams which were 

transmitted from this entity. 

read-only 

mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

ddpReceived { ddp 4 

Counter 

The total number of input data grams received by DDP. 

read-only 

mandatory 

ddpToForward { ddp 5 } 

Counter 

The number of input datagrams for which this entity 

was not their final DDP destination, as a result of 

which an attempt was made to find a route to forward 

them to that final destination. 

read-only 

mandatory 

ddpForwards 

Counter 

ddp 6 } 

The number of input datagrams for which this entity 

was not their final DDP destination, as a result of 

which they were forwarded to their final destination. 

read-only 

mandatory 

ddpForMe { ddp 7 

Counter 

The total number of input DDP data grams for which 

this entity was their final DDP destination. 

read-only 

mandatory 

ddpNoProtocolHandler 

Counter 

ddp 8 } 

The total number of DDP datagrams addressed to this 

entity that were addressed to an upper layer protocol 

for which no protocol handler existed. 

read-only 

mandatory 
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OBJECT: 

Syntax: 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 
Status: 

OBJECT: 

Syntax: 

Definition: 

ddpOutNoRoutes { ddp 9 } 
Counter 

The total number of DDP datagrams dropped because a 

route could not be found to their final destination. 
read-only 
mandatory 

ddpTooShortDrops { ddp 10 

Counter 
The total number of input DDP data grams dropped 
because the received data length was less than the 

data length in the DDP header. 
read-only 

mandatory 

ddpTooLongDrops { ddp 11 } 

Counter 

The total number of input DDP data grams dropped 
because they exceeded the maximum DDP datagram size 

or because their header size was greater than their 
length. 
read-only 

mandatory 

ddpBroadcastDrops { ddp 12 } 

Counter 

The total number of input DDP datagrams dropped 

because this entity was not their final destination 

and they were addressed to the link level broadcast. 

read-only 
mandatory 

ddpShortDDPDrops { ddp 13 } 

Counter 
The total number of input DDP datagrams dropped 

because this entity was not their final destination 

and their type was short DDP. 

Access: read-only 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

ddpHopCountDrops { ddp 14 

Counter 

The total number of input DDP datagrams dropped 

because this entity was not their final destination 

and their hop count would exceed 16. 

read-only 

mandatory 

rtmpTable { rtmp 1 } 

SEQUENCE OF rtmpEntry 

This entity's RTMP table. 

read-write 

mandatory 

rtmpEntry { rtmpTable 1 } 

rtmpEntry :: = SEQUENCE 

rtmpRangeStart OCTET 

rtmpRangeEnd OCTET 

rtmpNextHop OCTET 

STRING, 

STRING, 

STRING, 

rtmpInterface INTEGER, 

rtmpHops INTEGER, 

rtmpState INTEGER 

The route entry to a particular range of networks. 

read-write 

mandatory 

rtmpRangeStart { rtmpEntry 1 } 

OCTET STRING 

The first DDP network address in the range of 

networks that this routing entry pertains to, or the 

single network number that this routing entry 

pertains to. This is a two octet DDP network 

address. 

read-write 

mandatory 
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OBJEC'l': 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC'l': 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC'l': 

Syntax: 

Definition: 

Access: 

Status: 

OBJEC'l': 

Syntax: 

Definition: 

rtmpRangeEnd { rtmpEntry 2 } 

OCTET STRING 

The last DDP network address in the range of networks 

that this routing entry pertains to, or zero if this 

routing entry pertains to a single network number. 

This is a two octet DDP network address. 

read-write 

mandatory 

rtmpNextHop { rtmpEntry 3 

OCTET STRING 

The next hop in the route to this entry's destination 

network. 

read-write 

mandatory 

rtmplnterface { rtmpEntry 4 } 

INTEGER 

The index of the logical appletalk interface over 

which this route points. 

read-write 

mandatory 

rtmpHops { rtmpEntry 5 } 

INTEGER 

The number of hops required to reach the destination 

network that this entry pertains to. 

read-write 

mandatory 

rtmpState { rtmpEntry 6 } 

INTEGER { 

good(l) , 

suspect(2), 

bad(3), 

The status of the information contained in this route 

entry. 

Access: read-write 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

kipTable { kip 1 } 

SEQUENCE OF kipEntry 

The table of routing information for KIP networks. 

read-write 

mandatory 

kipEntry { kipTable 1 } 

kipEntry :: = 

kipNet 

kipNextHop 

kipHopCount 

kipBCastAddr 

kipCore 

kipKfps 

SEQUENCE { 

OCTET STRING, 

IPADDRESS, 

INTEGER, 

IPADDRESS, 

INTEGER, 

INTEGER 

An entry in the routing table for KIP networks. 

read-write 

mandatory 

kipNet { kipEntry 1 } 

OCTET STRING 

The appletalk network address for this routing entry. 

read-write 

mandatory 

kipNextHop { kipEntry 2 } 

IPADDRESS 

The IP address of the next hop for this routing 

entry. 

read-write 

mandatory 
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OBJECT: 

Syntax: 
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OBJECT: 

Syntax: 

Definition: 
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Status: 

- '!'he ZIP Group 

OBJECT: 

Syntax: 

Definition: 

kipHopCount { kipEntry 3 } 

INTEGER 

The distance in hops to the destination of this 

route. 

read-write 

mandatory 

kipBCastAddr { kipEntry 4 } 

IPADDRESS 

The form of the IP address used to broadcast on this 

network. 

read-write 

mandatory 

kipCore { kipEntry 5 } 

INTEGER { 

core(l), 

notcore (2) 

The status of this network as a Core network. 

read-write 

mandatory 

kipKfps { kipEntry 6 } 

INTEGER { 

kfps(l), 

notkfps(2) 

The type of the device that this network resides on. 

read-write 

mandatory 

zipTable { zip 1 } 

SEQUENCE OF zipEntry 

The table of zone information for reachable AppleTalk 

networks. 

Access: read-write 

Status: mandatory 
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Syntax: 

Definition: 
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Status: 

OB.:JI:CT: 

Syntax: 

Definition: 

Access: 

Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

zipEntry { zipTable 1 } 

zipEntry ::= 

zipZoneName 

zipZonelndex 

zipNetStart 

zipNetEnd 

SEQUENCE { 

OCTET STRING, 

INTEGER, 

OCTET STRING, 

OCTET STRING 

An entry of zone information for a particular zone 

and network combination. 

read-write 

mandatory 

zipZoneName 

OCTET STRING 

zipEntry 1 } 

The ASCII zone name of this entry. 

read-write 

mandatory 

zipZonelndex { zipEntry 2 

INTEGER 

An integer that is unique to the zipZoneName that is 

present in this entry. For any given zone name, 

every zipEntry that has that zone name will have the 

same zipZonelndex (in a given FastPath, as long as it 

has not been rebooted). 

read-only 

mandatory 

zipZoneNetStart { zipEntry 3 } 

OCTET STRING 

The network that starts the range for this entry, or 

the single network number for this entry. 

read-write 

mandatory 
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OB.:JECT: 

Syntax: 

Definition: 
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Status: 

OB.:JECT: 

Syntax: 

Definition: 

Access: 

Status: 

OB.:JECT: 

Syntax: 

Definition: 

zipZoneNetEnd { zipEntry 4 

OCTET STRING 

The network that ends the range for this entry, or 

zero if this entry refers to a single network number. 

read-write 

mandatory 

nbpTable { nbp 1 } 

SEQUENCE OF nbpEntry 

The table of NBP services registered on this entity. 

read-write 

mandatory 

nbpEntry {nbpTable 1 

nbpEntry :: = SEQUENCE 

nbpIndex 

nbpObject 

nbpType 

nbpZone 

INTEGER, 

OCTET STRING, 

OCTET STRING, 

OCTET STRING 

The description of an NBP service registered on this 

entity. 

read-write 

mandatory 

nbpIndex { nbpEntry 1 

INTEGER 

The index of this NBP entry. This value ranges from 

1 to the number of NBP entries registered on this 

entity. 

Access: read-only 

Status: mandatory 
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OBJECT: 

Syntax: 

Definition: 
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Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 
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nbpObject { nbpEntry 2 

OCTET STRING 

The name of the service described by this entity. 

read-write 

mandatory 

nbpType { nbpEntry 3 } 

OCTET STRING 

The type of the service described by this entity. 

read-write 

mandatory 

nbpZone { nbpEntry 4 

OCTET STRING 

The zone the service described by this entity is 

registered in. 

read-write 

mandatory 

echoRequests { echo 1 } 

Counter 

The number of echo requests received. 

read-only 

mandatory 

echoReplies { echo 2 } 

Counter 

The number of echo replies sent. 

read-only 

mandatory 
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Syntax: 

Definition: 
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Status: 

OBJECT: 

Syntax: 

Definition: 

Access: 

Status: 

'bufferSize { buffer 1 } 

INTEGER 

The size of a buffer including the header. 

read-only 

mandatory 

bufferAvail { buffer 2 } 

INTEGER 

The total number of buffers initialized. 

read-only 

mandatory 

bufferDrops { buffer 3 } 

Counter 

The total number of requests for a buffer that were 

denied. 

read-only 

mandatory 

bufferTypeTable { buffer 4 } 

SEQUENCE OF bufferTypeEntry 

The information about each buffer type. 

read-only 

mandatory 

bufferTypeEntry { bufferTypeTable 1 

bufferTypeEntry ::= SEQUENCE { 

bufferTypeIndex 

bufferType 

bufferTypeDescr 

bufferTypeCount 

INTEGER, 

INTEGER, 

OCTET STRING, 

INTEGER 

The information about a buffer of this type. 

read-only 

mandatory 
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Syntax: 
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bufferTypelndex { bufferTypeEntry 1 } 

INTEGER 

The internal index of this type of buffer. This 

value ranges from 1 to the total number of buffer 

types defined on this entity. 

read-only 

mandatory 

bufferType { bufferTypeEntry 2 } 

INTEGER { 

other(l), 

free(2), 

localtalk(3), 

ethernet (4) , 

arp(5), 

data (6), 

erbf(7), 

general data 

ethernet receive 

etbf(8), 

malloc(9), 

tkbf(lO), 

token (11) 

ethernet transmit complete 

token ring receive packet 

token ring packet 

The type of this type of buffer. 

read-only 

mandatory 

bufferTypeDescr { bufferTypeEntry 3 } 

OCTET STRING 

A printable ASCII text description of this type of 

buffer. 

read-only 

mandatory 

bufferTypeCount { bufferTypeEntry 4 } 

INTEGER 

The number of buffers of this type currently 

allocated. 

read-only 

mandatory 
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A P P E N D I x E 

PROM-Resident Configuration: 
AppleTalk Phase 1 

THIS APPENDIX DESCRIBES HOW TO CONFIGURE THE GATEWAY USING 

the AppleTalk Phase 1 protocols stored in the gateway's PROM. 

PROM-resident AppleTalk Phase 1 performs standard Phase 1 

routing just as K-STAR AppleTalk Phase 1 does, and the two 
Phase 1 implementations are fully compatible on an internet. 

Because it is contained in PROM, it is the default routing code 
used by the gateway if K-STAR has not been downloaded. 

The gateway's PROM-resident IP implementation, previously 

referred to as the flIP Subnetting" configuration type, is 

supported in the FastPath 4 gateway for backward compatibility 

only, and is not described in this guide. In this version of the 
FastPath Manager, it is called flIP Subsectioning" to avoid 

confusion with standard IP subnetting. Note, however, that the 

PROM-resident code itself has not changed. Gateways 
configured with PROM-resident IP Subsectioning can operate 

on internets that also support K-STAR IP gateways, and K-STAR 

IP is the recommended method of IP configuration. If you are 

using the PROM-resident IP protocols, please refer to your 

existing documentation. 
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PROM-resident AppleTalk Phase 1 
When the gateway is connected to LocalTalk and Ethernet and 
powered on, it follows the state diagram shown in Figure A-I in 
Appendix A. After the initial 25-second waiting period, if the 
gateway does not find a valid gateway program, it begins 
execution of the PROM-resident AppleTalk Phase I protocols. 

In this state, it identifies itself to the network, obtains a zone 
name from other gateways on one or both interfaces (or uses the 
zone name ''Default Zone" for both interfaces), and begins 
routing AppleTalk Phase I network traffic. 

If you do not need to supply any specific Phase 1 configuration 
data (such as network numbers or zone names that are 
meaningful for your site), you can follow the hardware 
installation procedure described in Chapter I and allow the 
gateway to autoconfigure. Simply connect the gateway to 
LocalTalk and Ethernet and power it on. The gateway will 
begin executing PROM-resident AppleTalk Phase I code 
without any interaction from the FastPath Manager. 

Supplying configuration data 
If you do need to supply specific configuration data, you can 
follow the rules and examples in this Appendix to configure the 
gateway's PROM-resident code for AppleTalk Phase I routing. 
Just as in the K-STAR AppleTalk configurations, the gateway 
can acquire seed data if it finds another AppleTalk Phase 1 
gateway (K-STAR or PROM-resident) on one or both of its 
interfaces. 

1111. Remember that you never download K-STAR when using the 
PROM-resident configurations. 
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Addressing rules 
The AppleTalk addressing rules for PROM-resident AppleTalk 
Phase 1 are the same as for K-STAR AppleTalk Phase 1. 

• An AppleTalk zone name can be 1 to 32 characters, 
including embedded spaces. All gateways on the internet 
must agree about the zone name assigned to a particular 
network. Each interface can be assigned only one zone 
name. 

• An AppleTalk network number can be any decimal number 
between 1 and 65,279. An AppleTalk network number must 
be unique to a cable (you can not repeat the number on 
more than one network), and all gateways must agree about 
what number is assigned to a particular cable. 

• AppleTalk node numbers cannot be assigned explicitly; 
AppleTalk automatically assigns a node number when a 
device boots up. 

Required configuration data 
If you are supplying configuration data for the PROM-resident 
protocols, you should supply all of the following: 

• One AppleTalk zone name for the gateway's LocalTalk 
interface. 

• One AppleTalk network number for the gateway's 
LocalTalk interface. 

• One AppleTalk zone name for the gateway's EtherTalk 
Phase 1 interface. (IEtherTalk" is AppleTalk on Ethernet.) 

• One AppleTalk network number for the gateway's 
EtherTalk Phase 1 interface. 
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PROM-resident Phase 1 configuration 
To supply a full Phase 1 configuration explicitly (that is, without 
using seed data from another gateway), first follow the ~neral 
procedure outlined in Chapter 1. After connecting the gateway 
to a Macintosh via LocalTalk, launch the FastPath Manager, and 
select and open the gateway. In the main configuration dialog 
box, 

• 
• 
• 

• 

• 

• 
• 

Click the Reset button, then open the gateway again. 
Click the Pause button. 
Enter the AppleTalk configuration data for the gateway's 
LocalTalk interface. 
Select ATalk Phase 1 from the Configuration menu and 
double-click on the ATalk Phase 1 listing in the 
Configuration area. 
Enter the AppleTalk configuration data for the gateway's 
EtherTalk Phase 1 interface. 
Click the Go button. 
Save the configuration data in a file (optional). 

1111" Note that you do not download K-STAR when using the PROM
resident protocols. 

A (g ~ LocalTalk data: 
~ ___ Zone name: karen 
r===-]J ~ ~ Network number: 30 

EtherTalk Phas81 data: 
Zone name: terry 
Network number: 10 

Figure E-l. A Phase 1 configuration 
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This example uses the data shown in Figure E-1: 

LocalTalk Interface Zone Name: karen 
LocalTalk Interface Net Number: 30 
EtherTalk Phase 1 Zone Name: terry 
EtherTalk Phase 1 Net Number: 10 

After selecting Reset and then Pause, 

1. Type karen in the AppleTalk Zone name field for the 
LocalTalk side, then press tab. 

2. Type the net number for the LocalTalk side: 30, then press 
tab. 

3. Select ATaik Phase 1 from the Configuration menu and 
double-click the ATaik Phase 1 listing in the Configuration 
area. This opens the EtherTalk Phase 1 dialog box. 

4. Type terry in the AppleTalk Zone name field in the 
EtherTalk Phase 1 dialog box, then press tab. 

5. Type the net number for the EtherTalk Phase 1 interface: 10, 
then press tab. 

6. Click OK to return to the main configuration dialog box. 

7. Click the Go button. The Go button sends the gateway all 
information that is currently in the FastPath Manager and 
tells the gateway to start executing code. Because you have 
not downloaded K-STAR, the gateway will start executing 
PROM code. 

8. If you wish, select Save Configuration File ... from the File 
menu and type a name for the configuration, then click the 
Save button to save the configuration file to disk. 

At this point, tum off the gateway, unplug it, and move it to its 
permanent location on the internet. 
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Using seed 
data 

When you add a second gateway to the Ethernet in this example 
it can acquire seed data on its Ethernet interface. Note that 
AppleTalk Phase 1 seeding works consistently whether one or 
both gateways are running K-STAR or PROM-resident 
AppleTalk Phase 1 code. 

After connecting the gateway to a Macintosh via LocalTalk, 
launch the FastPath Manager, and select and open the gateway. 
In the main configuration window, 

• Click the Reset button, then open the gateway again. 
• Click the Pause button. 
• Enter the AppleTalk zone name and network number 

required for the LocalTalk side of the gateway. 
• Click the Go button. 
• Save the configuration data in a file (optional). 

This example assumes that gateway 2 is on the same Ethernet 
network as gateway 1, as shown in Figure E-2. Seeded data is 
shown in italic type. 

-Gatewayl 

LocarTalk data: 
Zone name: karen 
Network number: 30 
EtherTalk Phase 1 data: 
Zone name: terry 
Network number: 10 

Galeway2: 

LocarTalk data: 
Zone name: russ 
Network number: 40 
EtherTalk PhalUl 1 data: 
Zone name: terry 
NelWork number: 10 

Figure E·2. Seeding on the Ethernet interface 
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This example uses the data shown in Figure E-2: 

LocalTalk Side Zone Name: russ 
LocalTalk Side Network Number: 40 
Ethernet configuration: seeded from gateway 1 

Because you only need to enter two data in this example, it may 
not be necessary to click Pause in the FastPath Manager; 
however, if you think it will take longer than 25 seconds from 
the initial Reset, click Pause anyway. 

After selecting Reset (and Pause, if required), 

1. Click in the AppleTalk Zone name field for the LocalTalk 
side and type russ, then press tab. 

2. Type the net number for the LocalTalk side: 40, then press tab. 

3. Click the Go button. After you select Go, the Diagnostics 
window displays in the foreground. 

4. If you wish, select Save Configuration File ... from the File 
menu and type a name for the configuration, then click the 
Save button to save the configuration file to disk. 

At this point, turn off the gateway, unplug it, and move it to its 
permanent location on the internet. 
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A p p E N D I x F 

Network Hardware Issues 

IF YOU ARE CONFIGURING A LARGE INTERNETWORK, YOU NEED TO 

consider the physical limitations of each network based on 

electrical parameters, the total length of the cable, the number of 
devices connected to it, and the use of interconnection devices. 

This Appendix discusses the physical restrictions imposed on 

network design by the medium you use to implement it. 
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Transmision Medium 

LocalTalk 
PhoneNET 
Fiber Optic System 

Network size restrictions 

AppleTalk networks are often implemented using LocalTalk 
cable (shielded, twisted pair wire manufactured by Apple 
Computer, Inc.), PhoneNET (unshielded, twisted pair wire 
manufactured by Farallon Computing, Inc.), or Fiber Optic 
System (fiber optic cable manufactured by DuPont). Each of 
these media has an upper limit on the length of cable and 
number of nodes that can be supported, as shown in Table F-l. 

Table F-l. AppleTalk Network Size Restrictions 

Maximum Number of Nodes Maximum Network Length" 

32 
32 
approx.100 

984 ft (300 meters) 
2952 ft (900 meters) 
4,900 ft (1500 meters) 

*The maximum network length is the length of cable between repeaters or bridges, or per branch 
of a PhoneNET star configuration. 

Transmision Medium 

Thin Ethernet 
Thick Etherent 

An Ethernet network can be implemented using thick Ethernet, 
thin Ethernet, or a combination of the two. Table F-2 shows size 
restrictions for a network using only thick or only thin Ethernet 
cable. 

Table F-2. Ethernet Network Size Restrictions 

Maximum Number of Nodes 

SeebeloWOO" 
See below*'" 

Maximum Network Length" 

984 ft (300 meters) 
1640 ft (500 meters) 

*The maximum network length is the length of cable between repeaters or bridges. 

"*Thin Ethernet requires 3 feet (0.9 meters) of cable between adjacent nodes, thick Ethernet requires 
7.5 feet (2.3 meters) between adjacent nodes. These restrictions, and the possible use of combined 
networks, interconnection devices, and so forth, determine the maximum number of nodes. In 
general, you can connect as many as 100 devices in a single thick- or thin-Ethernet network. 
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Thin Ethernet Cable 

(Feet) 

0 
82 
164 
246 
328 
410 
492 
574 
607 

When you combine thick and thin Ethernet cable, you can 
calculate the maximum total network length in the combined 
network using the formula 

where 

E = 500 - (2.70 x T) 

T = the total length of thin-Ethernet cable, in meters 
E = the total length of thick-Ethernet cable, in meters 

Table F-3 shows several combinations of thin-Ethernet and 
thick-Ethernet network lengths that meet the combined 
maximum cable lengths. 

Table F-3. Combined Ethernet Network Size Restrictions 

(combined with) Thick Ethernet Cable 

(Meters) (Feet) (Meters) 
0 1640 500 
25 1418 432 
50 1197 365 
75 975 297 
100 754 230 
125 532 162 
150 310 95 
175 89 27 
185 0" 0" 

.. Note that a network becomes a combined network when any node is connected through an 
external transceiver, even if no thick Ethernet cable is used. If any external transceivers are 
attached to a thin-Ethernet network, the network's maximum length becomes 185 meters (607 
feet). 
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"'-

Ethernet topology 

Ethernet does not support branching or looping; it requires a 
single line topology with both ends of the cable terminated. 
Where required by local electrical codes, the cable should be 
grounded at one point only, usually at a terminator. 

Whether the Ethernet cable is grounded or not does not affect 
signal transmission. 

7.5 feet 7.5 feet 

Thick Ethernet 

Figure F-l. Grounded and terminated Ethernet cable 

Combining networks 
You can change Ethernet topology and increase its effective size 
using network interconnection devices. The FastPath 4 gateway 
changes the topology of the network by adding LocalTalk or 
equivalent cables, each supporting up to 32 nodes. Other bridge 
and routing systems are also commonly used to increase the 
effective size of the Ethernet. 

In addition to these, repeaters and connectors can be used to 
extend the physical Ethernet as described in the next section. 
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Grounded 
network 
terminator 

Thick Ethernet, 
using transceivers 

Thin Ethernet, 
using T-connectors 

Repeaters and connectors 
Repeaters are used to amplify or regenerate electrical signals on 
the cable, while connectors are used to connect one type of cable 
to another. Both of these can be used to alter the topology of a 
network or increase its effective size. 

BNC-to-N-series 
connector ----

3 feet 

Figure F-2. Using a connector to combine Ethernet cables 

You can combine thin-Ethernet and thick-Ethernet networks end 
to end, using only a "BNC female to N-series female" connector, 
as shown in Figure F-2. This is useful if you are combining the 
networks at the end of each cable. You can simply remove a 
terminator on each cable, and plug the cables into the BNC-to
N-series connector <thin Ethernet in the BNC side and thick 
Ethernet in the N-series side). 

In this case, the combined lengths of cable shown in Table F-3 
apply. 

This combined network can now be further combined with 
other networks. 
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If you need to combine the networks in the middle of a cable, (as 
shown in Figure F-3), you will need a repeater and two 
transceivers. If two networks are joined through a repeater, each 
should independently have the required grounding. 

Figure F-3. Using a repeater to combine Ethernet cables 

To connect two networks using a repeater, remove the 
terminator from thin Ethernet and connect a transceiver in its 
place, attaching the terminator to the transceiver when you have 
finished. Both networks need to be terminated and grounded as 
they were before you combined them. 

You can place the additional transceiver on thick Ethernet just as 
if you were adding a new computer to the network, and then 
connect both the new transceivers to the repeater. 

Note that the repeater electrically isolates the two segments of 
the overall network. One segment is all thin Ethernet and the 
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other is all thick Ethernet. Thus, the maximum cable lengths 
listed in Table F-2 apply to each segment. 

Adding a node to Ethernet 
Within the size and spacing restrictions described above, you 
can connect a gateway anywhere on the Ethernet. Before you 
add any device to an existing network, make sure no one is 
using the network. When you disconnect any terminator or 
network cable, the entire network stops working. You can, 
however, remove a T-connector or transceiver cable from a 
computer's controller board without disrupting the rest of the 
network. 

If you are adding a gateway at the end of an Ethernet cable, 

• Remove the terminator from the end of the cable. (This will 
cause disruption of network traffic and should be done at a 
non-critical time for users.) 

• Connect a new length of network cable to the terminator's 
former position and to the transceiver or T -connector that 
will connect to the gateway. 

• Attach the terminator to the other end of the gateway's 
transceiver or T-connector. 

If you are adding a gateway on the middle of an Ethernet cable, 

• Disconnect the cable from one end of an existing computer's 
transceiver or T -connector. (This will cause disruption of 
network traffic and should be done at a non-critical time for 
users.) 

• Connect that cable to the transceiver or T-connector that 
will connect to the gateway. 

• Connect a new cable between those two transceivers or T
connectors. 

Make sure you do not introduce any branches or loops in the 
network. 
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A p p E N D I x G 

Technical Specifications 

. THI S APPENDIX PROVIDES THE TECHNICAL SPECIFICATIONS FOR THE 

FastPath 4 gateway. 
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CPU 

Internal components 

The FastPath 4 hardware (Model Number KFPS-4) contains the 
following components: 

CPU 
Ethernet controller 
Serial corom. controller 
RAM 
EPROM 

EPROM 
64K·bytes 

.... "' 16 

Motorola 68000 (8 MHz) 
Intel 82586 
Zilog 8530 sec 
256Kbytes 
64Kbytes 

AppleTalkILocalTalk 

Serial Communication 
ControUer 8530 

.... 8 
System Data Bus 

MC68000 +8 18 116 

Control ami SRAM 
Timer 

Status Port 256K-bytes 

f16 

Ethernet r--
Controller 82586 

I 
Transceiver 

Thin Elherlld I Thick Elheniel 

Ethernet 
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Power and environmental requirements 

The FastPath 4 has the following power and environmental 
characteristics: 

AC Input voltage: 
AC Input frequency: 
AC Surge current: 

AC Input power: 

Battery: 

Fuse: 

Internal fuses: 

90 to 135 VAC or 180 to 270 VAC 
47 to 63 Hz 
O.SA rms (max.) @ 110 VAC 
O.5A rms (max.) @ 220 VAC 
20 watts 

Built-in battery protects 256 K-bytes 
of built-in RAM from data loss 
during power outage, but does not 
protect optional expansion RAM. 
The battery is intended to last for 
the life of the product. 

5x20 mm, 250V, lA slow-blow fuse; 
held by a plastic clip between the 
power switch and power cord on 
back panel. 

Internal AC power, DC power, and 
Ethernet transceiver fuses. 

Operational Temperature: +10 to +40 degrees Celsius 

Relative Humidity: Less than 90% non-condensing 
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External components 

The back panel of the case includes a power switch (rocker 
switch marked with the internationally recognized designations 
of 1 for ON and 0 for OFF), a slide switch, connectors for 
LocalTalk, standard Ethernet, and thin Ethernet, a fuse clip, and 
a power cord connector. 

~ EthemeII802.3 

@ -mIiIl- r:Jr:~:::;:.:;n 

LocalTalk connector 
The 9-pin D-connector is for connection to a 9-socket female D 
subminiature, sometimes called "DB-9" (same as Macintosh 
512K) for LocalTalk (shielded twisted-pair wire), PhoneNET 
(unshielded twisted-pair wire), DuPont FiberOptic, or other 
compatible cabling system running at 230.4 k-bits/ second. 

This type of connector is required for the FastPath. (It is also 
used to connect to LaserWriter or LaserWriter Plus printers, and 
to Macintosh 128K or 512K computers~) 
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Pin Use 

1 Ground 
2 +5 volts 
3 Ground 
4 Transmit data + 
5 Transmit data -
6 +12 volts 
7 Handshake/ external clock 
8 Receive data + 
9 Receive data-

Ethernet connectors 
The FastPath 4 complies with Ethernet standards (versions 1.0 
and 2.0), including ANSI/IEEE Standard 802.3-1985 (ISO/DIS 
8802/3) and subsequent revisions. 

The circular BNC connector is for connection to aT-connector 
on a cable that conforms to IEEE 802.3 10BASE2 with a data rate 
of 10 megabits/ second. 

Tap impedance 

Shield 
Isolation 

Less than 8pF and greater than 
lOOK Ohms 
1M Ohm 
Greater than 250v rms 

The AUI IS-pin D-connector is for connection to an external 
Type A transceiver that uses a Canon OBIS with slide lock 
which connects to standard Ethernet cable that conforms to 
IEEE 802.3 10BASE5. The following table shows the assignment 
of circuits to connector pins in the AUI connector. 

Technical Specifications G-5 



Pin 

3 
10 
11 
5 
12 
4 
7 
15 
8 
2 
9 
1 
6 
13 
14 
Shell 

8765432 
•••••••• • • • • • • • 15 14 13 12 11 10 9 

Circuit Use 

DO-A Data Out circuit A 
DO-B Data Out circuit B 
oo-S Data Out circuit Shield 
DI-A Data In circuit A 
DI-B Data In circuit B 
DI-S Data In circuit Shield 
CO-A Control Out circuit A (not used) 
CO-B Control Out circuit B (not used) 
CO-S Control Out circuit Shield 
CI-A Control In circuit A 
CI-B Control In circuit B 
CI-S Control In circuit Shield 
VC Voltage Common 
VP Voltage Plus 
VS Voltage Shield 
PC Protective Ground (Conductive Shell) 
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G L o s 

address 

ALAP 

AppleTalk 

atalkad 

atalkatab 

AUI 

backbone 

BNC connector 

bridge 

s A R y 

A unique destination for a message sent across a network. 

(AppleTalk Link Access Protocol) The underlying protocol for 
packet transmission between nodes on a single AppleTalk 
network. ALAP describes the Link Access layer details of 
AppleTalk on LocalTalk, and corresponds to the Data Link layer 
of the ISO reference model. 

The term AppleTalk is used to describe a suite of protocols, 
defined in Inside AppleTalk. EtherTalk (AppleTalk on Ethernet) 
is part of the AppleTalk protocol suite and describes the Link 
Access layer details of AppleTalk on Ethernet. 

A daemon that lets a UNIX host serve as a network 
administrator. 

A database file containing configuration data for the gateway, 
accessed by the atalkad daemon. 

(Attachment Unit Interface) The type of connector used with 
thick Ethernet cable, defined in the 802.3 Ethernet standard. The 
FastPath back panel includes an AU! interface. See transceiver 
cable. 

Ethernet cable used to bridge two or more LocalTalk networks. 

The type of connector used with thin Ethernet cable, defined in 
the 802.3 Ethernet standard. The FastPath back panel includes a 
BNC connector. 

A device used to connect two or more networks at the Data Link 
layer of the ISO reference model. When you install a FastPath box 
on Ethernet and Local Talk, the FastPath functions as a bridge in 
that it can forward AppleTalk packets in an Ethernet frame 
(EtherTalk packets) and vice versa (it can strip off an Ethernet frame 
and forward the AppleTalk packet onto LocaITalk). This involves 
both the physical and data link layers. Bridges are also used to 
connect networks that use the same medium and protocol. See 
gateway, router, repeater, and ISO model. 
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Chooser 

connection box 

datagram 

DDP 

daemon 

Echo Protocol 

Ethernet 

EtherPort 

EtherTalk 

FastPath Manager 

fiber optics 

Glossary-2 

The Macintosh desk accessory that allows a user to select and 
use devices in any zone of an AppleTalk network or AppleTalk 
services available on an Ethernet network. 

The small box that is part of a LocalTalk or PhoneNET 
connection. The box has two connector sockets for the 
appropriate type of network cable, as well as a connection for 
the Macintosh port. 

The unit of transmission in the IP protocol. See also packet. 

(Datagram Delivery Protocol.) The protocol that provides 
delivery of ALAP packets over an internet. DDP corresponds to 
the Network layer of the ISO reference model. 

A background process that is continually running on a UNIX
based host computer. Daemons process requests for specific 
services. 

(EP) The protocol that lets any node send a test packet to any 
other node on the internet and receive an echoed copy of that 
packet. 

A set of standards defining a type of local area network 
characterized by a very fast data transmission rate, 10 megabits 
per second. An Ethernet network can include any of several 
kinds of physical transmission media, as discussed in "Ethernet 
Connection" in Appendix D. See also thin Ethernet. 

An internal Ethernet controller board that allows Macintosh 
computers to connect directly to Ethernet. The EtherPort option 
card sets are Kinetics products. 

AppleTalk protocol for communication over Ethernet or thin 
Ethernet cable. AppleTalk devices can be connected to Ethernet 
cable directly, through an EtherSC connection box or EtherPort 
option cards, or indirectly through a gateway. 

A Macintosh application program that loads a gateway program 
and configuration information into a FastPath gateway. 

A data transmission medium consisting of glass fibers encased 
in a protective sheath, that can carry enormous quantities of 



gateway 

gateway code 

header 

hop 

host 

internet 

ICMP 

data. Fiber-optic cable is not subject to eavesdropping, 
electromagnetic interference, or radioactivity. 

A device used to connect two or more networks at the upper 
protocol layers of the ISO reference model. The networks can 
use different protocols and different physical media. The 
FastPath operates as a gateway in that it can receive one type of 
packet (for example, an AppleTalk packet), and encapsulate it in 
another type of packet (for example, UDP), for transmission 
across the LocalTalk or Ethernet medium. This involves the 
higher levels of the ISO model. See also bridge, repeater, and 
router. 

A program that resides in a FastPath gateway to convert packets 
between AppleTalk and other protocols. 

Information at the beginning of a data packet, indicating the 
addressee node and assisting in the message routing. 

A measure of distance between networks within an internet. 
One hop consists of passage through one bridge between 
networks. For example, consider two LocalTalk networks, each 
with a bridge to the same Ethernet network. A node on one 
LocalTalk network is two hops away from a node on the other 
LocalTalk network, because a packet must travel through two 
bridges (LocalTalk network 1 to Ethernet, Ethernet to LocalTalk 
network 2) to get from one node to the other. 

A device that provides services to other devices on a network or 
an internet. With the appropriate software, a host can operate as 
an AppleTalk node. 

A network created by linking two or more smaller networks of 
the same or different types. An internet can be as small as two 
LocalTalk networks or it can comprise a combination of several 
LocalTalk and Ethernet networks joined by gateways, bridges, 
repeaters or routers. 

(Internet Control Message Protocol) The part of IP that governs 
control and error messages. Gateways and other network nodes 
send ICMP messages for two purposes: to test communication 
with another node and, if a packet has an error, to report the 
error to the packet's originator. 
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IP (Internet Protocol) A transmission protocol used on Ethernet 
networks, in conjunction with TCP. IP corresponds to the 
Network layer of the ISO reference model. 

ISO model A seven-layer logical structure of protocols, as defined by the 
Open Systems Interconnection (OSI) model created by the 
International Standards Organization (ISO). Each layer of the 
model defines a different level of communication. Figure G-l 
shows the relationship between the ISO model and FastPath 
functionality. 

The FastPath can operate as a 
bridge, using the Physical and 
Data Link layers of the ISO 
model. See the definition for 
"bridge" above. 

The FastPath can operate as a 
router, using the Physical, Data 
Link, and Network layers of the 
ISO model. See the definition for 
"router" below. 

The FastPath can operate as a 
gateway, using all of the layers 
defined in the ISO model. See the 
definition of "gateway" above. 

Application 
Presentation 

Session 

Transport 
Network 

Data Link I 
Physical I 

! 

Application 

Presentation 

Session 

Transport 
Network 
Data Link 

Physical 

t 

Application 
Presentation 

Session 

Transport 
Network 

Data LiiiK 

Physical 

t 

Application 
Presentation 

Session 

Transport 
Network 

Data Link I Data Link 

Physical I Physical 

! 1 

Application 
Presentation 

Session 

Transport 
Network Network 

Data Link Data Link 

Physical Physical 

1 1 

Application Application 

Presentation Presentation 

Session Session 

Transport Transport 
Network Network 

Data Link Data Link 

Physical Physical 

1 1 
Figure G-l. Bridges, gateways and routers in the ISO model 
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K-STAR 

K-Talk 

LAP 

LocalTalk 

mask 

MAU 

node 

OSI model 

packet 

PhoneNET 

The FastPath gateway program, which contains modules 
implementing AppleTalk Phase 1 and Phase 2 protocols, 
"transition bridge" software, TCP lIP protocols derived from the 
Kinetics Internet Protocol (KIP) software implemented at 
Stanford University (which provides a flexible IP addressing 
scheme for AppleTalk devices), DECnet, and SNMP protocols. 

An independent implementaton of AppleTalk protocols for use 
with the UNIX operating system. 

A link-access protocol. See also ALAP. 

A brand of AppleTalk hardware that uses shielded, twisted-pair 
cable to interconnect Macintosh computers and other AppleTalk 
devices. LocalTalk kits are manufactured by Apple Computer. 
Generally, where this manual refers to a LocalTalk connection, 
you can use any system of cable and connectors that supports 
AppleTalk protocols at 230.4 kbits/second to interconnect 
Macintosh computers and other AppleTalk devices. 

See subnet mask. 

(Medium Attachment Unit) See transceiver. 

On a network, a point where a device is connected; often used 
to refer to the device itself. Some examples of AppleTalk nodes 
are Macintosh or Apple II computers, LaserWriter or 
Imagewriter printers, and FastPath gateways. 

See ISO model. 

A collection of information sent over a network, comprising a 
core of data surrounded by the encapsulating information 
required by the applicable protocols. A packet is the unit of 
transmission on a physical network; a datagram is the unit of 
transmission in the IP protocol. 

A brand of AppleTalk hardware that uses unshielded, twisted
pair cable (ordinary telephone wire) to interconnect Macintosh 
computers and other AppleTalk devices. PhoneNET kits are 
manufactured by Farallon Computing. 
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printer port 

protocol 

protocol suite 

repeater 

RIP 

router 

routing table 

RTMP 

Glossary-6 

The port on the back of the Macintosh to which LocalTalk or 
equivalent connectors are attached. 

A set of rules for communicating data within a network or 
internet. The protocol specifies the format, timing, and sequence 
in which information is transmitted. Common protocols include 
ALAP, RTMP, TCP and IP. 

A group of related protocols, designed to work with each other. 
Common protocol suites include AppleTalk and TCP lIP. 

A device used to connect two or more networks at the Physical 
layer of the ISO reference model. The networks connected to a 
repeater must use the same physical medium (Ethernet cable, 
for example). The repeater is insensitive to the protocols used on 
that medium. The principal use of a repeater is to amplify or 
regenerate signals, to alter the topology or extend the effective 
length of a network. See also bridge, gateway, and router. 

(Routing Information Protocol) A protocol that lets an IP bridge 
or gateway dynamically discover routes to the various IP 
networks within an internet. 

A device used to connect two or more networks at the Network 
layer of the ISO reference model. The FastPath functions as a 
router by routing packets between networks, operating at the 
data link and network layers. Normally, the networks 
connected to a router must use the same protocol and physical 
medium. The router must understand the protocol, because it 
uses information within each packet to determine how to route 
that packet. See also bridge, gateway, and repeater. 

A collection of routes to the various networks within an internet. 
Each entry in a gateway's routing table comprises a network's 
identifying number and the distance (hops) between that 
network and the gateway. AppleTalk and IP routers periodically 
send RTMP and RIP packets, respectively, to update routing 
tables. 

(Routing Table Maintenance Protocol) The protocol that lets an 
AppleTalk bridge or gateway dynamically discover routes to the 
various AppleTalk networks within an internet. RTMP 
corresponds to the Transport layer of the ISO model. 



subnet 

subnetmask 

TCP 

TCP/IP 

T-connector 

terminator 

thick Ethernet 

thin Ethernet 

trailer 

A subset of an IP network's address space. Subnet addressing is 
discussed in Chapter 3 and Appendix E. 

A 32-bit binary number that defines which bits of an IP address 
are to be used as a subnet address. In the mask, each l-bit 
corresponds to a subnet-address bit and each O-bit corresponds 
to a host-number bit. 

(Transmission Control Protocol) A transmission protocol used 
on Ethernet networks, in conjunction with W. TCP corresponds 
to the Transport layer of the ISO reference model. 

A protocol family based on TCP and W. It also includes UDP 
(User Datagram Protocol), Telnet protocol, and FTP (File 
Transfer Protocol). TCP lIP was developed by the U.S. Defense 
Department to connect widely differing computers while 
providing data correction, security, and protection against line 
failures. 

A "T" -shaped connector used with thin-Ethernet cable. 

A device, consisting primarily of a SO-ohm resistor, that must be 
attached to each end of an Ethernet cable. An Ethernet network 
does not function properly if one or both of its terminators are 
absent. 

Sometimes called "standard" Ethernet: a type of cable that 
conforms to IEEE 802.3 standards and uses the AUI interface. 
Thick Ethernet is often installed in the ceiling with drop cables 
for each device. It requires an external transceiver and 
transceiver cable to connect a device. It connects to a device 
using a trapezoidal D-connector. 

A variety of Ethernet that conforms to IEEE 802.3 standards and 
uses a round BNC connector that connects to a device via a T
connector. Thin-Ethernet transceivers are usually internal to the 
device, and it is physically thinner than thick Ethernet cable, 
with a shorter maximum length. 

Information at the end of a data packet indicating the 
conclusion of the packet. 
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transceiver 

transceiver cable 

UDP 

zone 

ZIP 
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A small box, attached to network cable and connected to a 
computer or other device, that provides the drive, reception, and 
collision detection between physical network media, especially 
on Ethernet networks. A transceiver is sometimes called a 
medium attachment unit (MAU). 

A cable connecting an Ethernet device to a transceiver, which in 
tum is attached to the Ethernet cable. A transceiver cable is 
sometimes called an attachment unit interface (AUI). 

(User Datagram Protocol) The part of IP that lets an application 
program, on one node of the internet, send a packet (datagram) 
to another node. A UDP packet includes a protocol port 
number, so it can be addressed to a specific application process 
on the receiving node. 

A grouping of one or more AppleTalk networks, based on usage 
patterns rather than physical connections. 

(Zone Information Protocol) The protocol that governs the 
mapping of AppleTalk networks to zone names throughout an 
internet. 
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Lookups, NBP (see: NBP) 

M 

Macintosh: 
Chooser; 

AppleTalk enabled .................... I-6, 5-6 
network services visible ... 2-47 to 2-54 
zones visible ...................................... 2-4 

Control Panel; 
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routers, default (see: IP) 
routing: 

and encapsulation in K-STAR ............ A-14 
AppleTalk packets to IP hosts (see: IPTalk) 
AppleTalk packets on Ethernet A-10, A-14 
OECnet packets to AppleTalk nodesA-14 
IP packets to AppleTalk nodes .......... A-14 
multiple protocols in K-SfAR ........... A-14 
packet frequency in OECnet ................. 4-5 
to remote AppleTalk nets 

through an IP router (see: atalkad) 

s 
sample configurations (see: examples) 
saving configuration data ................ 1-12, B-27 
security featuresin K-STAR .......... 2-47 to 2-54 
seeding AppleTalk data ............................... 2-2 
self-tests at startup ........................... A-5 to A-7 
sending configuration data 

to the gateway .................... 1-12, A-4, B-18 
server range of nodes; AppleTalk ............ A-13 



services listed in the Chooser .................... 2-47 
SNMP ............................................... D-l to D-5 
software switches: 

Auto Config ........................... l-11, 8-11 
Remote Boot .......................... 1-11, 8-11 

specifications, technical... ................ G-2 to G-6 
split addressing, IP ......................... 3-14 to 3-24 
standard IP broadcast address .................... 3-6 
standards compliance .................................. G-5 
startup range (see: AppleTalk Phase 2) 
starting up the gateway,: 

autoconfiguration ...................... A-7 to A-9 
configuration overview ............ 1-6 to 1-12 
initial sequences .................................... A-3 

static IP addresses on client Macs ............. 3-38 
status, hardware ........................................... C-7 
subnet mask (see: IP) 
sub sectioning, IP (previously 

called IP Subnetting) ........ E-l, 8-25 to 8-26 
suspending operation if memory becomes 

corrupted (see: Remote Boot) 

T 

T-connector ............................................ 1-5, G-5 
TCP lIP (see: IP) 
testing a configuration ............................... 1-17 
transition bridge software (see: AppleTalk) 
troubleshooting: 

autoconfiguration (see: AppleTalk) 
configuration data .................... 5-8 to 5-11 

(see also: configuration data, examples) 
downloading K-STAR ......................... 5-7 to 5-8 
installation, hardware ................ .5-2 to 5-3 
opening the gateway ................... 5-4 to 5-6 

u 
UDP 

encapsulation for CAP or AUFS 
(see: IPTalk) 

port numbers ........................................ 3-40 
(see also: IP) 

UNIX: 
daemon (see: atallead) 
host routing tables ................................ 3-20 

updating a network to Phase 2 ................ 2-45 

w 
wide area AppleTalk routing through IP 
routers (see: atalkad) 

z 
ZIP (Zone Information Protocol) ............ A-12, 

C-19 to C-21 
changing zone names .......................... 2-46 
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Limited Warranty for Kinetics Hardware Products 

What is Covered by This Warranty. 
KINETICS, a division of Excelan, Inc., warrants, to the original purchaser only, that the hardware 
product that is the subject of this sale (a) conforms to KINETICS published specifications, and (b) 
is free from defects in material or workmanship under normal use and service. The duration of 
this warranty is one year from date of first retail purchase. If purchaser discovers within this 
period a failure of the hardware product to conform to specifications, or a defect in material or 
workmanship which impairs normal use and service, purchaser must promptly notify KINETICS 
in writing and obtain a Return Material Authorization (RMA) and an RMA number from 
KINETICS prior to sending the defective hardware product to KINETICS at purchaser's expense. 
In no event shall such notification be received by KINETICS later than thirty (30) days from the 
expiration date of the warranty. Within a reasonable time after such notification, KINETICS will 
correct any failure of the hardware product to conform to specifications or any defect in material 
or workmanship which impairs normal use and service, with either new or used replacement 
parts. Such repair, including both parts and labor, is at KINETICS's expense. All warranty service 
will be performed at service centers designated by KINETICS. If KINETICS is unable to repair the 
hardware product KINETICS will provide, at its option, one of the following: (a) a replacement 
hardware product, or (b) full refund of the purchase price. These remedies are the purchaser's 
exclusive remedies for breach of warranty. 

Replaced hardware products or parts thereof become the property of KINETICS. 

What is Not Covered by This Warranty. 
KINETICS does not warrant (a) defects caused by failure to provide a suitable installation 
environment for the hardware product, (b) damage caused by use of the hardware product for 
purposes other than those for which it was designed, (c) damage caused by disasters such as fire, 
flood, wind, and lightning, (d) damage caused by unauthorized attachments or modification, (f) 
damage during shipment, or (e) any abuse or misuse by the purchaser. 

Warranty of Title, Patents, and Copyrights. 
In addition to the warranties set forth in the previous paragraphs, KINETICS warrants that it has 
good title to the hardware product free of any encumbrance, and that the hardware product shall 
be delivered free from the rightful claim of any third person for infringement of a United States 
patent or a United States copyright. KINETICS will defend the purchaser against any claim of 
infringement and will pay resulting costs, damages, and attorney fees finally awarded, provided 
that (a) the purchaser promptly notifies KINETICS in writing of any claim, and (b) KINETICS has 
sole control of the defense and all related settlement negotiations. KINETICS will not be liable for 
any compromise made without KINETICS's consent. If a claim arises, the purchaser will allow 
KINETICS, at KINETICS's option and expense, to procure the right for the purchaser to continue 
using the hardware product, to replace or modify it so that it becomes non-infringing, or to grant 
the purchaser a refund of the purchase price in exchange for return of the infringing hardware 
product. 



Disclaimer of Warranty. 
THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE OR THOSE WHICH MAY 
ARISE FROM COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE. 

Limitation of Remedies. 
In no case shall KINETICS be liable for any special, incidental, or consequential damages based 
upon breach of warranty, breach of contract, negligence, strict tort, or any other legal theory. Such 
damages include, but are not limited to, loss of profits, loss of savings or revenue, loss of use of the 
hardware or any associated equipment, cost of capital, cost of any substitute hardware, software, 
media or equipment, facilities or services, downtime, the claims of third parties including 
customers, and injury to property. This limitation does not apply to damages caused by breach of 
the warranty of title and against infringement under paragraph (3), nor to claims for personal 
injury. Some states do not allow limits on warranties, or on remedies for breach in certain 
transactions. In such states, the limits in this paragraph and in paragraph (4) may not apply. 

Excl usions. 
This contract shall not cover the making of any repairs, the performance of any labor or the 
furnishing of any materials for the repair or replacement of the hardware product or any part 
thereof where such repair or replacement is caused by the negligence or want of care of the 
purchaser in maintaining the hardware product or any wrongful use thereof. 

Time Limit in Bringing Suit. 
Any action for breach of warranty must be commenced within 15 months following date of first 
retail purchase. 

No Other Warranties. 
No employee of KINETICS or any other party is authorized to make any warranty in addition to 
those made herein. 

Allocation of Risks. 
This warranty allocates between KINETICS and the purchaser the risks of product failure. This 
allocation is recognized by both parties and is reflected in the price of the hardware product. 
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